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Preface

■ Contacting IBM Unica technical support
N40001

Contacting IBM Unica technical support
If you encounter a problem that you cannot resolve by consulting the documentation,
your company’s designated support contact can log a call with IBM Unica technical
support. Use the information in this section to ensure that your problem is resolved
efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM Unica
administrator for information.

Information you should gather
Before you contact IBM Unica technical support, you should gather the following
information:

• A brief description of the nature of your issue.

• Detailed error messages you see when the issue occurs.

• Detailed steps to reproduce the issue.

• Related log files, session files, configuration files, and data files.

• Information about your product and system environment, which you can obtain as
described in "System Information" below.

System information
When you call IBM Unica technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM Unica
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM Unica application by viewing
the version.txt file located under each application’s installation directory.
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Contact information for IBM Unica technical
support
For ways to contact IBM Unica technical support, see the IBM Unica Product Technical
Support website: (http://www.unica.com/about/product-technical-support.htm).
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1 Introduction

■ What does Marketing Operations do?
■ Why use Unica Marketing Operations?
■ Who uses IBM Unica Marketing Operations?
■ Integration with IBM Unica Campaign
■ Using Unica Marketing Operations
■ Business processes
■ To sign in to IBM Unica Marketing Operations
■ About customizing Marketing Operations

N50001

What does Marketing Operations do?
IBM Unica Marketing Operations provides a complete enterprise planning, collaboration,
and workflow solution developed just for the needs of marketers. You can use IBM
Unica Marketing Operations to get a comprehensive and holistic view of all marketing
projects across your company. You can then focus on improving each dimension of
marketing planning. Everyone on the marketing team - chief marketing officers,
marketing managers, event planners, creative directors, marketing controllers - realizes
immediate benefits in efficiency and performance.

IBM Unica Marketing Operations is the marketing resource management (MRM)
solution that allows you to plan, budget, and monitor every type of marketing program in
your company.

Use IBM Unica Marketing Operations to perform the following tasks.

• Get real-time visibility into every marketing program.

• Manage all marketing activities, including advertising, brand management, direct
and interactive marketing, promotions, events, collateral, research, public relations.

• Enforce marketing "best practices."

• Increase productivity and optimization of resources, including people and budgets,
through automated workflow, collaboration, and unique optimization capabilities.

• Promote effective management of marketing content and projects created by
dynamic marketing organizations.

• Manage the workflow and projects across the entire marketing operation, for all
types of media, events, campaigns, and brand loyalty efforts, from mailers to ad
campaigns, from catalogs to seminars.

N60001
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Why use Unica Marketing Operations?
By using IBM Unica Marketing Operations, marketers can increase the return and lower
the risk of all their resource investments by optimizing decisions, collaborating across
programs, operating more efficiently, and gaining greater visibility into what they are
doing, what they are spending money on, and what the results are.

Marketing Operations allows you to do the following.

• Manage and coordinate all your marketing activities in one solution. Because
all relevant marketing information is in one place, there are fewer misaligned
investments. Centralization leads to tighter controls over which marketing programs
are launched. As a result, greater operational efficiencies are gained, allowing
marketers to get to market rapidly and spend more time on strategy.

• Improve decision making, minimize risk. The marketing measurement provided
by using IBM Unica Marketing Operations enables marketers to focus on the most
profitable opportunities. Additionally, marketers make better tactical decisions,
because the marketing mix is more easily optimized and competing messages can
be eliminated.

• Ensure strategic goals and marketing activities are aligned. Strategic goals,
marketing plans, and budgets are centralized to promote clarity of agreed upon
objectives and tactics to achieve business goals. The result is improved alignment of
marketing plans and activity.

• Achieve faster, lower cost execution of all marketing activities. Rather than
reconciling individual project plans, chasing down approvals, and manually tracking
creative changes, project plans and assets are centralized, and approvals are clear
and automated. Waste is eliminated, because better execution results in less
duplication of effort, fewer rush fees and penalties, and allocation of resources to
the right programs.

• Ensure compliance. By relying on the centralized repository and advanced
reporting capabilities in IBM Unica Marketing Operations, marketers reduce time and
money spent satisfying demands from regulatory agencies, corporate auditors, and
management oversight.

• Open, flexible architecture. IBM Unica Marketing Operations is based on an open
architecture that makes it easy for IT to implement and allows you to leverage your
existing infrastructure and data. Marketing Operations utilizes a 3-tier J2EE
architecture, which separates the client, web server, application server, and backend
data sources.

Related Topics
• To set your basic options

N70001

Who uses IBM Unica Marketing Operations?
Your marketing department and any outside interested parties can benefit from using
IBM Unica Marketing Operations. People who benefit include the following.
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Integration with IBM Unica Campaign

• Executives who want to create strategic plans and manage their set of core
marketing metrics.

• Executives outside the group who need visibility into the group’s activities.

• Senior managers who contribute projects, allocate resources, and perform high-level
monitoring.

• Managers for lines of business, channels, or geographies who need to define and
track projects, automate the approval process, and track costs.

• Brand managers and advertising executives who want visibility into the entire
corporate communications plan.

• Database marketers who create activities and tasks, track “To Do” lists, and send,
receive, and monitor notifications.

• Constituents who carry out the plan.

• External vendors who may have a role in the marketing plan.
N80002

Integration with IBM Unica Campaign
Marketing Operations optionally integrates with IBM Unica Campaign, which, in turn,
can integrate with several other products. When Marketing Operations and Campaign
are integrated, you can use the marketing resource management features in Marketing
Operations to create, plan, and approve campaigns.

For information about working with an integrated system, see the IBM Unica Marketing
Operations and IBM Unica Campaign Integration Guide.

N90001

Using Unica Marketing Operations
Before you start using IBM Unica Marketing Operations, your administrator must install
Marketing Operations and set it up. If you are having problems, contact your
administrator.

The following steps outline some of the major tasks users perform in IBM Unica
Marketing Operations.

1. Create plans that contain programs.

2. Create programs that contain projects.

3. Create more projects, request a project, accept a request, start a project, or view
projects.

4. Work in projects by navigating through them, completing the setup of workflows,
viewing and modifying tasks, and printing, copying, and deleting the projects.

5. Work with assets, including adding, editing, and changing the status of assets, as
well as adding folders.
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6. Work with approvals, including adding an approval process; submitting it for review;
canceling the review; modifying, printing, and deleting it; putting the approval on
hold; responding to it; and marking up approval items with comments.

7. Create invoices that keep track of expenses related to programs and projects.

8. Search for projects and approvals using both the standard and advanced search
capabilities, and save advanced searches for future use.

9. Collaborate with other users using the alerts window and the message board.

Related Topics
• To sign in to IBM Unica Marketing Operations

• Plans

• About programs

• Projects

• Assets and asset libraries

• Approvals

• About invoices

• Alerts

• Message board

NA0001

Business processes
A business process is the representation, in IBM Unica Marketing Operations, of a
collection of related, structured activities—a chain of events—that produce one of the
following.

• marketing activities targeted at a particular set of prospects and/or customers

• reusable marketing components that support these marketing activities.

IBM Unica Marketing Operations provides the following types of business processes.

• Plans

• Programs

• Projects

• Subprojects

• Project requests

• Approvals

Related Topics
• Plans

• Programs

• Projects

• Project requests

• Approvals
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Relationship of planning objects
This section details how planning objects (plans, programs, and projects) relate to one
another. Plans contain one or more programs, and programs contain one or more
projects.

Projects can contain subprojects. A budget for a plan consists of individual line items for
projects and programs that roll up into the budget for the plan.

On the summary page of projects and programs, there is a field, Parent Items and
Code, that contains a view of the ancestors for the object. For example, the summary
page of a subproject shows the current object (a subproject), its parent project, and all
of its ancestors back to its root plan. The ID codes for these objects are displayed, as
well as direct links to each of the ancestor objects.

NE0001

Plans
A plan is intended to capture the objectives of a given business unit/area, for a given
period of time, typically measured yearly or quarterly. Additionally, a plan serves as a
container and "rollup" point for the various programs and projects that you define in
order to meet your marketing goals.

Information from "child" programs and child projects of the programs roll up to the plan,
tracking linked information. For example, for a plan that has a child program, you can
make metrics or budget information related to the program roll up—or move upwards
from the program—to the plan, so that you can study and keep track of this information
from the perspective of the plan.
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Related Topics
• Summary information for plans

• Plan views

• Fiscal year for plans

N170001

Programs
A program represents a marketing activity and it is typically comprised of multiple
related marketing deliverables or initiatives. A program can contain or group multiple
projects. The program itself has information that is central or common to the
development and execution of these marketing deliverables. For example, a direct
marketing program could contain multiple projects each representing a distinct
marketing promotion or campaign. Also, a product launch program could contain
projects pertaining to various types of collateral development, analyst briefings, and
tradeshow attendance.

N100001

Projects
A project represents all the information related to developing and executing one or
more related marketing deliverables or initiatives. This information can include a
checklist or schedule of tasks that people working on the project must perform in order
to prepare and produce the deliverables for the project.

For example, you might use a project called Monthly Tradeshow to collect all the
information needed for the one tradeshow each month that your organization attends.
This information could include who attends the show, what equipment you need in the
booth, copies of demos of the product that you intend to present, collateral you want to
hand out to customers, costs of promotional materials, and any additional information
that pertains to the tradeshow.

Projects can have subprojects. A subproject has all the same characteristics as a
project. A subproject is linked to a parent project; any project linked in this manner is
referred to as a subproject.

Related Topics
• Creating projects and requests

• Team projects and requests

• Team projects lifecycle

• Reconciliation

• Request statuses

• Project views

N230001
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Project structure
A project contains a workflow, budget information, metrics, digital assets, approvals, and
both standard and custom information. Of course, not every project needs all of this
information; most of it is optional and can be filled in only when needed.

Note that approvals can also exist independently from projects. That is, an approval
does not need to be associated with a particular project.

N180001

Project requests
A project request is similar to a work order, or creative brief. It represents a request for
someone else to do work according to the requester's specifications.

There may be times when users within an organization or outside vendors would like to
request a project. For example, as an outside vendor, you may submit a project request
to the marketing services organization requesting some collateral. The marketing
services representative accepts the request and creates a project, organizing and
assigning resources to the project in order to manage the creation of the collateral.

If you request a project, you are a requestor. You then submit the request to a recipient
for approval. Once the recipient accepts the request, the recipient owns the project and
is called the owner.

A project request does not contain a workflow. Once the request is approved and
transitions to a project, it contains the appropriate workflow.

N120001

Approvals
An approval allows you to streamline and track the process of having your work
reviewed and approved. This allows many users to review work in parallel or in an order
that represents your business processes. Reviewers (or approvers) can electronically
mark up content submitted for review. IBM Unica Marketing Operations then records
approvals and denials for audit purposes. You can tie approvals to a project or they can
exist independently from any project.

Related Topics
• About approvals

• Approval dates

• Due dates for approvals

• Approval views

N280001

Collaboration tools
Use the following IBM Unica Marketing Operations functionalities to communicate
information to other users.

• Teams
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• Alerts

• Attachments

• Message boards

• Metrics

• Workflows

• Functional roles

• Security policies

Related Topics
• Teams

• Alerts

• Attachments

• Message Boards

• Metrics

• Workflows

• Functional roles

• Security policies

N290001

Teams
A team is a group of people who work together to complete tasks across a number of
different business processes. Someone in charge of a business process can assign
tasks to a team, rather than an individual, when necessary.

Team leaders can then manage their resources across initiatives. Team leaders can
decide to explicitly assign work to team members or allow team members to assign
work to themselves. In all cases, the team leader can monitor the queue of work
assigned to their team and track the progress and performance of individual team
members.

N2A0001

Alerts
Alerts are notifications of important events or actions you need to take regarding a
program, project, a project request, asset, account, approval, or invoice. An alert could
remind you that a project is running behind schedule or over budget, or that there is an
item that needs your approval.

You receive alerts directly through IBM Unica Marketing Operations and through email.
When you receive an alert through Marketing Operations, you go to the Alerts page to
view it. When you receive an alert through e-mail, it goes directly to the inbox of your e-
mail application.

There are two types of alerts in IBM Unica Marketing Operations.

• alerts that Marketing Operations sends based on events, such as the start of a
project, or
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• alarms that an administrator sets up to send at regular intervals, such as once a
day.

N2B0001

Attachments
Team members can attach relevant documents to the main IBM Unica Marketing
Operations objects. An attachment is a URL, digital asset, or a file that you add to a
Marketing Operations object. You can add attachments to plans, programs, projects,
invoices, approvals, and accounts.

Attachments can be organized by category. For example, your project might contain the
following attachment categories.

• Reference Materials

• Vendor Forms

• Offer Creatives

• Deliverables

The attachment categories are set up in the template used to create the particular
object.

N2C0001

Message Boards
A message board is a place to post and read messages pertaining to a particular
object. Plans, programs, projects, requests, accounts, approvals, and invoices can each
have their own message board.

Useful for less formal collaboration, message boards allow team members to log
comments and keep track of responses.

N2D0001

Metrics
Metrics are used for management reports and analysis. You view them on the Tracking
tab for plans, programs and projects.

Use IBM Unica Marketing Operations metrics for the following calculations.

• Automatically calculate internal measures (such as budgets and resource
consumption).

• Automatically tabulate program results, such as the following.

• measure consistently across activities.

• aggregate results across programs.

• Automatically link key metrics (such as number of contacts and responses) from
campaigns back to project metrics.

• Build a marketing memory.

The metrics that are available in a plan, program, or project depend on the template you
used to create it.
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N2E0001

Workflows
A workflow allows you to view and edit the group of tasks and milestones that drives
the project. It allows you to efficiently meet and manage project goals. Tasks,
dependencies, and durations are populated for a workflow based on the template used
to create it. You can view workflow information as either a spreadsheet, timeline, or
process flowchart. You can use workflows to forecast and plan your activities. Once
work has begun, workflows make it easy to monitor progress and identify bottlenecks.

N2F0001

Functional roles
When setting up a project, one part of that process is assigning individuals to tasks
based on the individuals’ functional role or job role, such as writer, graphic artist, or
project manager. IBM Unica Marketing Operations uses the concept of roles as a bridge
between people and tasks. Roles are useful for the following reasons.

• People come and go: assigning a role to a task makes it easier to control people
leaving and returning a project.

• Resources are not always available: you can assign a role to a task before any
people are available to fill the role or perform the task.

• Roles are predictable: you can create project templates with standard roles and fill
people into the roles independently for each project you create from the project
template.

N300001

Security policies
A security policy is a set of rules that govern any objects (such as projects or programs)
that are associated with the policy. These rules indicate which types of users will be
able to view, modify, delete or perform any of the other relevant functions for these
objects.

In order to express these rules, security policies contain tje following.

• user roles to identify the types of users, and

• function grants or blocks to identify what each type of user can or cannot do.

Multiple Security Policies are allowed, and one example security policy, Global, is
provided with IBM Unica Marketing Operations.

The global policy is a special policy that is always considered in the governance of all
objects in the system (rather than all users). Companies with simple security models
need only utilize the global policy to express their rules.

Companies that require different groups to be kept in discrete groups from one another
will utilize custom security policies to do so, and use the global policy only for system-
wide administrative or executive access rules.

The term global is not intended to indicate that every user has full (global) access to
everything, but rather that the security policy is, by default, globally-associated with
every user.
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Details of security policies are discussed in the IBM Unica Marketing Operations
Administrator’s Guide.

N310001

Strategic planning and financial management
IBM Unica Marketing Operations includes strategic planning and financial management
functionality that allows you to do the following.

• Develop top-down budgets for marketing plans and the programs they contain.

• Track actual expenses incurred, with respect to budget.

• Facilitate spend tracking and reporting in Accounting (GL) terms.

In IBM Unica Marketing Operations, you use the following to perform Strategic Planning
and Financial Management tasks.

• Accounts

• Budgets

• Cost Categories

• Invoices

Related Topics
• Accounts

• Budgets

• Cost categories

• Invoices

N320001

Accounts
A top-level account represents a specific corporate general ledger account established
by a finance department for the purpose of tracking and controlling expenditures and
cash flows for a certain area of the business. This account tracks budget needs and
expenditures at weekly and monthly levels and then aggregates them to quarterly and
yearly levels.

Accounts may have subaccounts. Depending on the account structure at your company,
the subaccounts also may represent specific general ledger accounts, or they may have
been created to represent a greater level of granularity that marketing wants to track,
even if the general ledger structure doesn't include that level of detail.

N330001

Budgets
In IBM Unica Marketing Operations, a budget allows you to plan expenses that will
occur as you execute your plan, program, or project. After setting the plan budget, you
can fund linked programs, and ultimately projects, from it. Marketing Operations tracks
budgets of child programs and projects in the form of allocations, forecasted or
committed spending, and actual expenses.
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IBM Unica Marketing Operations tracks budgets of child programs and projects,
although these objects may have different owners. For example, a program linked to a
plan may have a different owner than the plan itself. As such, the person who allocates
a budget from a plan down to a program may be different from the person forecasting
expenses from a program up to a plan. Marketing Operations allows a plan owner—a
marketing manager for example—to track of expected expenses from child programs
and projects as well as the plan budget itself, and remain responsive to budgetary
needs.

Budgets are available only when the Marketing Operations financial module is
enabled.

Fiscal year
You can view the total budget for all years, or see a detailed view for a particular year
broken down into weeks, months, or quarters.

IBM Unica Marketing Operations keeps budget information for the current fiscal year,
the next two fiscal years, and any past fiscal years dating back to when you first
installed Marketing Operations.

On the plan level, to view or edit a different fiscal year, change the Fiscal Year field
value on the Plan Summary tab. Linked programs and projects take the financial year
from the parent plan; standalone programs and projects use the system's current fiscal
year.

Granularity
IBM Unica Marketing Operations allows you break fiscal years into weeks, months, or
quarters. When creating a new plan, program, or project, choose the desired increment
from the drop-down Budget Granularity on the Summary tab.

Users is not allowed to edit budget granularity. Plans, programs and projects with
different budget granularities are not allowed to be linked together.

For example, if a plan’s fiscal year is broken into months, you can link it only with
programs and projects with months as the budget granularity; in this scenario, programs
and projects with weeks or quarters as their granularity are unavailable for linking.

For more information about linking plans, programs, and projects, see To link and
program to a plan, To link an existing project to a program, and To link a child project or
request to a project.

N340001

Cost categories
Cost Categories are used to categorize expenses into types, such as travel expense,
mailing expense, and so on. For details on creating and editing cost categories, see the
IBM Unica Marketing Operations Administrator’s Guide.

Cost categories are used both when tracking invoices and creating budgets.
N350001
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Invoices
In IBM Unica Marketing Operations, an invoice electronically captures a paper invoice
submitted to a marketing department for services, time, or materials provided by a third-
party vendor or supplier. You must manually enter the information captured in paper
invoices into an Marketing Operations invoice.

Here are some advantages of transferring your paper invoices to IBM Unica Marketing
Operations.

• Easy accessibility

• Accurate and immediate expense tracking

• Vendor spend analysis

• Rollup reporting

• Periodic transfer or export to a general ledger (GL) system
N390001

Libraries of reusable elements
IBM Unica Marketing Operations allows you to reuse marketing items by providing the
following.

• Marketing objects

• Digital Asset Management

Related Topics
• Marketing objects

• Digital asset management

N3A0001

Marketing objects
You can create new marketing objects if you have permission to do so. Once you create
a marketing object, you can start it at any time. Starting the marketing object makes it
active.

A marketing object is any work product a team develops and reuses in the course of
its marketing activities. A marketing object can represent either a physical item, such as
a letter, credit card, or banner ad, or a business component, such as a credit card offer,
a target segment definition, or a rewards program definition.

• You define and manage marketing objects that represent all reusable work products.

• You can perform basic operations (create, edit, change state, copy, link, and delete)
on marketing objects.

• You enter and manage all of the attributes that define a particular marketing object,
such as name, owner, state/status, description, etc.

• You can define and manage business processes (such as projects) that produce,
modify, and retire marketing objects.
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• You can construct robust projects which define multiple marketing activities by
“assembling” each discrete marketing activity from existing marketing objects.

IBM Unica Marketing Operations marketing objects are defined in stages, and how they
are defined influences how they are organized and presented to users. The following
terms are important in understanding the definition and organization of marketing
objects.

Marketing object type
A Marketing object type is the highest-level division for marketing objects. An
administrator creates marketing object types. Each marketing object type has a menu
item, but the menu on which it appears depends on how the administrator configured
the marketing object type.

Marketing object template
A marketing object type is broken down into one or more marketing object templates.
Typically, an administrator creates a marketing object template for each significant
characteristic for the marketing object type.

Marketing object instance
A Marketing object instance is a single marketing object. Users with the proper
security permissions create marketing object instances from marketing object templates.
Throughout the documentation, we refer to marketing object instances simply as
“marketing objects.”

N3B0001

Digital asset management
An asset is any electronically stored document that you may want to use or reference in
a marketing program. This can include brand images, marketing research documents,
reference materials, corporate collateral, letterheads, or document templates.

You can store all marketing assets in a secure, central location, using IBM Unica
Marketing Operations Assets, with the following advantages.

• leverage concepts that were approved in previous marketing campaigns

• require pre-approval of material to reduce review times

• assign usage guidelines and expiration dates to items.

Additionally, assets contained in Approval objects have integrated mark-up capabilities,
enabling collaboration between staff and agency partners and tracking of comments,
edits, and changes within creative content.

NB0001

To sign in to IBM Unica Marketing
Operations

To use IBM Unica Marketing Operations, you must sign in. If you are uncertain of the
correct URL or you need a user name or password, contact your administrator.
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1. Open your web browser.

If you are using a Safari browser, and you are experiencing cache-related
problems, for example, icons have been updated but new ones are not showing,
you can manually empty the cache by pressing Command+Option+E or
choosing Empty Cache from the Safari menu.

2. In the address field of the browser, enter the web address (URL) for IBM Unica
Marketing Operations. For example:

http://unicaserver:7001/plan/

31

3. If your administrator set up security for IBM Unica Marketing Operations, the
application prompts you to accept a digital security certificate the first time you log
in. Click Yes to accept the certificate.

The IBM Unica Marketing Operations sign in screen appears.

4. Enter your user name and password, then click Sign In.

If your sign in is successful, IBM Unica Marketing Operations displays the main
application screen. Depending on how your administrator configured your options, you
may see the Programs List page or the Projects List page.

NC0001

About customizing Marketing Operations
Users can customize the Marketing Operations interface to meet their needs. These
settings are available in the Marketing Operations Settings. The following table
describes what you can customize.

Option Description

Basic Settings Use these options to set your default security policy.

Analysis options Use this option to set a default report to be displayed when you go to the Analytics
Home page and to set the Analytics Home page as your login page in Marketing
Operations, if desired.

Projects Options Use these options to customize the way you work with projects.

Task Options Use these options to customize the way you work with tasks.

Approvals Options Use these options to customize the way you work with approvals.

Calendar/ Timeline Use these options to customize how you view the system calendar.
Settings
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Related Topics
• To set your basic options

• To set your project options

• To set your task options

• To set your approval options

ND0001

To set your basic options
Your basic options allow you to choose the security policy used by default when you
create new items.

1. Select Settings > Marketing Operations settings.

The Administrative Settings page opens.

2. Click Basic Settings.

The Basic Settings page opens.

3. Select the security policy you want to use by default when you create new items in
Marketing Operations in the Default Security Policy field.

You can leave Global selected, which is the default, to use the global security policy
set up by your administrator, or you can select a security policy that your
administrator instructed you to select. As a best practice, do not change the security
policy without the guidance of your administrator. For more information on security
policies, contact your administrator or see the Marketing Operations Administrator's
Guide.

4. Click Save Changes to save your changes.

Related Topics
• To set your task options

N3F0001

To set your Analysis options
By default, the Analytics Home page shows a list of all available reports. Your Analysis
options allow you to set a default report to be displayed when you go to the Analytics
Home page.

1. Select Settings > Marketing Operations Settings.

2. Click Operational Analytics Options.

The Analysis Options page appears.

3. Select the report you want as the default report.

If at any time the report you select is not available, the list of all available reports is
displayed.

4. Click Save Changes.
N3C0001
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To set your project options
Project options allow you to customize Marketing Operations so you view and receive
project information that is important to you. For example, you may want to specify the
list of projects that appears by default when you open the Projects page.

You set project options through the Options icon ( ) on the Projects page. A
subset of these options is also available through the Administration page. To easily
access these options, we recommend you set them through the Options icon on the
Projects page.

1. Select Operations > Projects.

2. Click the Options icon ( ).

The Projects Options page appears.

3. In the Default List field, select the default project list view to appear when you open
the project list page.

By default, the Active Projects and Requests view appears in this field (unless you
previously changed the setting.

If you have any saved searches, this list also includes that information.

4. In the Default View Mode field, select the default list view mode that appears when
you open the Projects page. You can display projects in a list view or a calendar
view.

5. In the Optional Project Columns field, select any optional project columns to add
to the current project list view.

Note that the columns you select here appear only on this specific project list view.

6. Click Save Changes to save your changes.

The settings you chose remain in effect for all of your Marketing Operations sessions.

Related Topics
• About optional project columns

N400001

About optional project columns
For Project List view pages, you can customize which columns appear in the list.

When you select optional columns, note that you select them for a particular view.

For example, if you select an optional column called Objectives in the Active Projects
and Requests view, this column does not appear in the All Projects and Requests
view.
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The column choices in the Optional Columns field include all fields used in all project
templates in the system. Template creators define fields in project templates. Some
projects that appear in the Project list view may have been created with a project
template that did not contain a certain field. If a project does not have a field defined,
there will be no value in the corresponding column on the project list view.

If you are in the Project Calendar view instead of the Project List view, in the
Optional Information to Show field, select any optional project milestones or project
start and end dates that you want to view. These milestones and dates appear in the
calendar.

Related Topics
• To set your project options

N3D0001

To set your task options
Your task options allow you to customize Marketing Operations so you view and receive
task information. For example, you may want to specify the list of tasks that appears by
default when you open the Tasks page.

1. Select Settings > Marketing Operations Settings > Tasks Options.

The Task Options dialog box appears.

2. In the Default List field, select the default Task List view that you want to appear
when you open the Tasks list page.

By default, the My Tasks view appears in this field, so Marketing Operations
displays only tasks currently awaiting your action when you click Operations >
Tasks.

This list also includes saved searches.

3. In the Default List View field, select the default list view mode that appears when
you open the Tasks page. You can display tasks in a list view (the default) or a
calendar view.

4. Click Save Changes to save your changes, Revert to Saved to discard the
changes you made since the last time you saved changes, or Cancel to exit the
screen.

Related Topics
• To set your approval options

N3E0001

To set your approval options
Your approval options allow you to customize Marketing Operations so you view and
receive information about approvals that is important to you.

1. Select Settings > Marketing Operations Settings > Approvals.

The Approvals Options page appears.
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2. In the Default List field, select the default Approval List view that you want to
appear when you open the approval list page.

By default, the My Active Approvals view appears in this field; the result is that
Marketing Operations displays only your active approvals when you select
Operations > Approvals.

If you have any saved searches, this list also includes that information.
N410001

Setting your start page
If you do not want to have a dashboard page appear when you first log in to IBM Unica
Marketing, you can select a page from one of the installed IBM products as your start
page.

To set a page you are viewing as your start page, select Settings > Start on current
page. Pages available for selection as a start page are determined by each IBM Unica
Marketing product and by your permissions in IBM Unica Marketing.

On any page you are viewing, if the Start on current page option is enabled, you can
set the page as your start page.
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2 CommonTasks

■ About common tasks
■ Working with attachments
■ Statuses of business processes
■ Using disabled attribute values
■ Selecting resources
■ Save and Return to List
■ Column headers
■ To print an object
■ To export information in Microsoft Excel format

N420001

About common tasks
Some tasks are not specific to IBM Unica Marketing Operations objects. For example,
several objects contain attachments. You work with project attachments in the same
way as you work with program or plan attachments.

Related Topics
• Working with attachments

• To change the status of a process

• Using disabled attribute values

• Selecting resources

• To print an object

N430001

Working with attachments
You can attach relevant documents to IBM Unica Marketing Operations objects (such
as plans, programs, and so on). The Attachments tab of an object contains links to all
files or URLs related to the object.

IBM Unica Marketing Operations automatically creates a thumbnail for documents,
images, PDFs, and web pages when these items are attached or sent for approval.
Files types supported are as follows.

• BMP

• Doc

• Docx
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• GIF

• htm

• html

• JPEG

• JPG

• pdf

• ppt

• pptx

• RTF

• xls

Note the following limitations.

• By default, IBM Unica Marketing Operations allows you to attach up to five files at
once. This number is configurable, and may be different in your system.

• Attachment size is limited to under 2 gigabytes (GB) in size. The exact limitation
depends on your browser and operating system.

Related Topics
• Assets and asset libraries

• To add an attachment to an object

• To remove an attachment from an object

• To send e-mail attachments

N4D0001

To add an attachment to an object
Users can add attachments on an ongoing basis.

1. Navigate to the object to which you would like to add an attachment.

2. Click the Attachments tab.

The tab displays any attachments that already exist for the object.

3. Click the Add icon ( ) to add an attachment to the object.

The Add Attachment window appears.

4. From the drop-down list in the Save Attachment To field, select where you want to
save the attachment.

5. In the File to Attach field, select From My Computer, From the Asset Library, or
URL.

6. Do one of the following.

Version 8.5.0 37



2 - Common Tasks

• Click Browse to search for a file on your computer. When the dialog box
appears, navigate to the file you want to attach, and click Open.

• Click Browse Library to attach a file in an asset library. Click the library that
contains the file you want to add and use the tree in the left pane of the screen
to navigate to the folder and then the asset that you want to attach. Click Accept
Asset when viewing the asset in the right pane.

• Enter the URL in the field provided.

7. Add any comments about the attachment.

8. Click Add More to display an additional set of fields for each additional attachment
you want to add.

9. Click Save Changes to add the attachment or attachments.

The attachments are added to the Attachments tab for the object.

Related Topics
• To add an attachment to a task

N4E0001

To remove an attachment from an object
1. Navigate to the object to which you would like to remove an attachment.

2. Click the Attachments tab.

The tab displays any attachments that already exist for the object.

3. Click Remove beside the attachment you would like to delete.

A message appears asking you to verify the deletion.

4. Click OK.

The attachment is removed.
N4F0001

To send e-mail attachments
Users that have a valid e-mail address configured in IBM Unica Marketing Operations or
IBM Unica Marketing Platform can send e-mail attachments. If your e-mail address is
configured incorrectly in the system, you receive an error message.

1. Navigate to the object to which you would like to add an attachment.

For approvals and assets, attachments are available on the summary page. For all
other objects, click the Attachments tab.

The tab displays any attachments that already exist for the object.

2. Click Send as Mail Attachment beside the attachment you would like to send.

You can also right-click the attachment icon and choose Send as Mail Attachment
from the menu.
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The Send Mail Attachment window appears.

3. Enter or select values in the To and Cc fields for the email recipients.

• To send the attachment to IBM Unica Marketing Operations users, click the
arrow at the right side of the field and select one or more email addresses. The
addresses you select are added to the field. If you deselect an address, it is
removed from the field.

• You can also enter any valid external email address in the fields. Separate
multiple addresses by a comma. For example:
user1@inbox.com,user2@myCompany.com

4. Enter values for the Subject field and body of the message.

5. Click Send to send the attachment.

The system displays a message that confirms that the e-mail has been sent or that
an error occurred while the system attempted to send the message.

The Send Mail Attachment window remains open until the e-mail server has sent the
message. If you close the window while the mail is being sent, you do not receive
any confirmation.

Note the following.

• Any replies to the message go directly to the e-mail address of the sender.

• If you sends an attachment to an invalid address, a message is sent to the user that
the e-mail was not delivered.

• If the mail server is down (for the Marketing Operations server), the system displays
a message that the attachment could not be sent. You can take either of the
following actions:

• Wait until the mail server is available and try again.

• Download the attachment to your local machine and use the local client e-mail
application to send the attachment.

• If the mail is accepted by the e-mail server for delivery, and it cannot be delivered
for any reason (for example, if an email address is invalid) the e-mail server sends
the details directly back to the user in the local client e-mail application.

N440001

Statuses of business processes
The following table describes the possible statuses for plans, programs, projects, and
approvals.

Status Description

Not started Indicates the object has been created.

In progress Indicates work on the object has been started.
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Status Description

On hold Indicates work on this object should not continue at this time.

Cancelled Indicates that no users should access the object; work on it has been stopped
permanently.

Completed Indicates that work on the object is finished.

In Reconciliation (Projects only). Indicates someone is editing a cancelled or completed project.
This is a temporary state available to users having the proper security permission.

N4B0001

To change the status of a process
You can change the status of a business process, thereby controlling its lifecycle. Your
administrator can set up IBM Unica Marketing Operations to send an alert to owners
and members of a process when its status changes.

The following procedure describes how to change the status for plans, programs,
projects, marketing objects, and approvals.

1. From the appropriate navigation menu, select the object type.

For example, click Operations > Plans to work with a plan.

2. Click the object whose status you wish to change.

The object’s Summary tab appears.

3. Click the Status icon and select a status as follows.

• Start <object>. Places the object into the In Progress state.

• Submit <object>. Used for requests and approvals, places the object into the In
Progress state.

• Pause <object> (or Stop Review for an approval). Results in a state of On Hold.
Available as a choice once you have started the object.

• Continue <object>. Results in a state of In Progress. Available as a choice if
you have placed an object on hold.

• Finish <object>. Results in a state of Completed.

• Cancel <object>. Results in a state of Cancelled. Select this option if you want
to cancel the object permanently.

A dialog box appears in which you can add comments. If you select Completed or
Cancelled, you cannot change the status of the object at a later time (except for
projects, which you can reconcile after completing or canceling).

4. Click Continue to close the dialog box and apply the new status.

Related Topics
• Statuses of business processes
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N450001

Using disabled attribute values
Throughout IBM Unica Marketing Operations, users select an item or items from a drop-
down list. Over time, the items in the lists can change; administrators can add, remove,
or disable items from drop-down lists. When an administrator disables an attribute, it
affects the behavior of Marketing Operations in the following ways.

• When users perform advanced searches.

• When users edit an existing object that contains a disabled value in one of its drop-
down lists.

Related Topics
• Disabled attribute values in searches

• Disabled attribute values in objects

• Disabled attribute values example

N520001

Disabled attribute values in objects
When an administrator disables an attribute value, it no longer appears in drop-down
lists for new objects. However, users need to consider disabled values in the following
situations.

• A user edits a tab for an existing object with an attribute that is set to a disabled
value. The attribute is optional.

If the user edits the attribute, he or she must select an enabled value. However, the
user can save the page without editing the attribute (that is, the attribute can be
saved with the existing, disabled value).

• A user edits a tab with an attribute that is set to a disabled value. The attribute is
required.

The user must select an enabled value for the attribute. The system does not allow
the user to save the data until an enabled value has been set for the attribute.

• A user creates a new object. One tab contains an optional attribute that has a
disabled, default value.

The attribute is set to a blank value.

• A user creates a new object. One tab contains a required attribute that has a
disabled, default value.

The system presents an error message that the attribute is required. The user
cannot finish creating the object until he or she sets the value of the required
attribute.

N510001
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Disabled attribute values in searches
When users search on an attribute that contains disabled values, they can select from
both enabled and disabled values. This allows users to find objects that contain values
that may no longer be used.

N530001

Disabled attribute values example
Consider a project template, Marketing Collateral, which contains a tab, Production
Info. Production Info contains several attributes, including a required attribute, Color,
and an optional attribute, Coating. The attributes have the following values:

Color (required) Coating (optional)

(default value) Gloss Aqueous (default value)

4C Dull Aqueous

4/4 UV Coating

Black and White Etched

Tom creates a marketing collateral project, MC001, and sets the Color to 4/4 and the
Coating to Dull Aqueous.

An administrator then disables the 4/4 and Dull Aqueous values.

Tom opens the MC001 project, and edits the Production Info tab:

• He can leave the Coating value as Dull Aqueous, or set it to any of the enabled
values, such as Etched.

• He must change the value of Color to one of the enabled values before he can save
the Production Info tab.

The administrator re-enables 4/4 and Dull Aqueous values, and disables the default
value (Gloss Aqueous).

Tom creates a marketing collateral project, MC002:

• The value of Coating is blank.

• Tom must select a valid value for Color before he can finish creating MC002
N460001

Selecting resources
Throughout IBM Unica Marketing Operations, users can select people and teams as
resources. Users add and remove members to planning objects, marketing objects,
assets, invoices and approvals. When users perform advanced searches, they can add
people and teams to the search criteria.
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Save and Return to List

The list of people available in IBM Unica Marketing Operations is populated from
IBM Unica Marketing Platform. Administrators can limit the list of teams and people
a particular user sees, depending on the role and permissions for the user.

N470002

Save and Return to List
When you create or edit a project, request, or marketing object, you can save your work
at any time. If you click Save and Return to List, your work is saved and you see a list,
saved search, default search, or summary page, as described here.

• If you start a wizard from a saved search or list page, you return to that page.

• If you start a wizard from the Actions menu, you return to your default search page
for the object type.

• If you start a wizard from the Manage Linked Objects menu, you return to the
parent program's Summary page.

• If you edit an existing object, you return to the saved search page, if that is where
you initiated the edit, or the default search page, if you initiated the edit from the
summary page of the project or request.

N480001

Column headers
Many IBM Unica Marketing Operations pages contain a summary table, where the rows
contain objects (such as program, plans, tasks, etc.), and columns contain
characteristics for the object (such as name, status, owner, etc.)

In these pages, you can click the column headers to sort or group the table on the
selected column. Clicking a second time on the column name reverses the sort order.

You can determine how data on the page is sorted.

• If a column contains the symbol, data on the page is sorted in ascending order
based on the contents of this column.

• If a column contains the symbol, data on the page is sorted in descending order
based on the contents of this column.

• If the current sort column is any column other than Name, the list is sorted by
current sort column, then by the Name column.

N490001

To print an object
You can print the current page for many IBM Unica Marketing Operations objects. Use
the following procedure to print any of these objects: accounts, approvals, invoices,
plans, programs, projects, and marketing objects.
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IBM Unica Marketing Operations prints the information found on the tab currently
showing.

1. Navigate to the Summary tab of the object to print.

2. Select the tab to print and click the print icon ( ) on the Marketing Operations
toolbar.

For some objects, a drop-down menu displays with two choices: Print and Export.

3. If the menu appears, click Print.

A print dialog appears.

4. Complete the fields in the dialog and click Print.

The data on the screen prints to the selected printer.
N4A0001

To export information in Microsoft Excel
format

You can export information from IBM Unica Marketing Operations to an Excel
spreadsheet for programs, projects, and project requests.

You cannot export Tracking, People, Attachment, Workflow, Budget, or Analysis
tabs to Excel.

In particular, you can export the Summary tab or a custom tab. From the Program or
Project List page, you can export summary information for multiple programs, projects,
or requests.

When you export list pages for programs, projects, tasks, and marketing objects, all the
items in the list are exported, even if the list spans multiple pages.

1. You can export information for a single object or for a list of objects.

• To export information to Excel for a single object, navigate to Summary or
custom tab of the object.

• To export a list of objects to Excel, click Operations > Programs or Operations
> Projects and open the view you want to export.

2. Click the Print icon ( ) and select Export from the drop-down menu.

A window displays, asking whether to Open or Save the file that will be exported. If
you are exporting a list, IBM Unica Marketing Operations prints information about all
the objects in the current view of the list page.

3. You can either open the item in Excel, or save it to disk.

• Click Open to launch Excel. The information you exported displays on the
spreadsheet.
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• Click Save to save the file. You can then open the Excel spreadsheet, displaying
summary information about the object or list of objects.
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3 Plans

■ Plans
■ Plan views
■ Summary information for plans
■ Fiscal year for plans
■ To add a plan
■ To add or remove a program area
■ To link a program to a plan
■ Adding a new program from a plan
■ To remove a program from a plan
■ To start a plan
■ To delete a plan

NE0001

Plans
A plan is intended to capture the objectives of a given business unit/area, for a given
period of time, typically measured yearly or quarterly. Additionally, a plan serves as a
container and "rollup" point for the various programs and projects that you define in
order to meet your marketing goals.

Information from "child" programs and child projects of the programs roll up to the plan,
tracking linked information. For example, for a plan that has a child program, you can
make metrics or budget information related to the program roll up—or move upwards
from the program—to the plan, so that you can study and keep track of this information
from the perspective of the plan.

Related Topics
• Summary information for plans

• Plan views

• Fiscal year for plans

N1B0001

Plan views
IBM Unica Marketing Operations organizes plans in views.

• All Plans lists all plans. It also contains links to the Active Plans view.
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Summary information for plans

• Active Plans lists all the plans that are now in the In Progress state. This is the
default view.

You can also access the different views of plans using the Actions menu. It contains
links to the views listed above. In any view, you can change the sort order by clicking on
the column you want to sort by. Click the column a second time to reverse the sort
order.

Additionally, you can search for a plan.
N1A0001

Summary information for plans
On the plan Summary tab, IBM Unica Marketing Operations lists summary information
about a plan, such as status, program areas, security policy, and so on. You are taken
to the plan's Summary tab by default when you select a plan from the Plan List page.
Any programs linked to the plan are listed on the Summary tab. You can perform tasks
such as changing plan status, editing the plan, adding a new program, linking an
existing program, or removing a linked program.

N1C0001

Fiscal year for plans
When you add or edit a plan, you choose a fiscal year from a pull-down menu. The
fiscal year you choose determines for which year you can edit budget information. IBM
Unica Marketing Operations keeps multi-year budget data for plans. The system keeps
budget information for the current fiscal year, the next, two fiscal years, and any past
fiscal years dating back to when you first installed IBM Unica Marketing Operations.

Viewing budget information
Budget information that you view in Total mode is for the life of the plan. Budget
information that you view in Detailed mode is for the specified fiscal year.

Editing budget information
Budget information that you edit on the Budget tab corresponds to the selected fiscal
year. You can edit only the budget for one fiscal year at a time. To edit budget data for
a fiscal year, edit the Fiscal Year value on the summary page for the plan; set the value
to the fiscal year that corresponds to the budget data you want to edit.

N540001

To add a plan
When you add a plan, you become an owner of that plan.

1. Click Operations > Plans.

2. Click the Add Plan icon ( ).
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3. Enter a plan name in the Name field.

4. Enter a description of the plan in the Description field.

5. Click Add/Remove Members to add team members to the plan.

6. Enter a plan ID in the Plan ID field.

By default, the Auto-generate on save field is checked and IBM Unica Marketing
Operations generates a number automatically when the plan is saved. To manually
enter a plan ID in the Plan ID field, clear the Auto-generate on save checkbox.

The plan ID must be unique.

7. Select the security policy from the Security Policy drop-down list.

This is a required field and defaults to Global (unless an administrator has changed
the default security policy).

8. Select a business area in the Business Area field.

9. Select a fiscal year from the Fiscal Year drop-down list.

This is the year in which the plan is active. The years from which you can choose
are the current year, and the following two years.

The budget information available on the Budget tab corresponds to the value in
this field.

10. Select the program areas to use for programs in this plan in the Program Areas
field.

11. Click Save Changes to save the plan.

To edit an existing plan, click the Edit icon ( ) found on the plan Summary tab.

Related Topics
• Fiscal year for plans

• To add or remove a program area

N550001

To add or remove a program area
Program areas are subsections of plans, allowing programs that are linked to the plan to
be arranged into logical subgroups.

IBM Unica Marketing Operations administrators create the program areas from which
you can choose.

1. Follow the steps for adding a plan, until you get to the step of adding a program
area.

2. Click the Add/Remove Program Areas button, (located under the Program Areas
field.
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To link a program to a plan

3. To add a program area, select a program area from the Available Program Areas
field and click the right-pointing arrows to add the program area to the Selected
Program Areas field.

When you add a program area to the Selected Program Areas field, it populates
the Program Areas field on the plan Summary tab.

4. To remove a program area, select a program area in the Selected Program Areas
field and click the left-pointing arrows to remove it.

You cannot remove a program area if any programs are assigned to it. You must
first remove the program from the program area, and then remove the program
area.

N360001

To link a program to a plan
Once you have created a plan, you can link existing programs to it. When you link a
program to a plan, all the plan participants receive an e-mail message informing them of
the link.

1. Navigate to the plan to which you want to link a program.

2. Click the Manage Linked Objects icon ( ) and select Link Existing.

The Link Existing Programs to Plan window appears.

3. Enter a string in the Find by name or code field and click Find or leave the field
empty and click Find

The Search Results field shows only programs which you can link to the plan.
Only programs with the same budget granularity and security policy as the plan
will be available. Programs with a status of Cancelled, Deleted, or Completed
never appear in Search Results.

4. In the Select a Program Area field select a program area. The program will belong
to the program area that you choose.

5. In the Search Results field, click the programs to link to the plan.

To select more than one program at a time, press the Ctrl key and click each
program.

6. Click the right-pointing arrows. The Selected Items to link field populates with your
selections.

To deselect a program, click the program in the Selected Items to link field and
click the left-pointing arrows.

7. Click Save Changes.

The program appears in the Supporting Program(s) field on the Plan Summary tab.
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Linked programs appear with summary information on the Plan Summary tab in the
Supporting Programs field. Click the program name to be taken to the Summary tab
for that program.

N5A0001

Security considerations for linking plans and
programs
Linked programs and plans must have the same security policy. Once you link a
program to a plan, you cannot change the security policy of either object without first
removing the program from the plan.

In order to link an existing program to the plan, you must have Edit Summary Tab
permission on each program you want to link. If you do not have this permission, ask
your administrator for help.

N560001

Adding a new program from a plan
You can create a new program when you are in a plan; IBM Unica Marketing
Operations links the new program to the plan. The program areas you choose in the
program creation process are the program areas currently defined for the plan.

After you click the Add Program icon ( ) on the plan summary page, the process is
similar to creating a new, non-linked program.

Linked programs
If you add a program from the plan summary page, the new program’s program area is
constrained by the plan’s program areas.

• If the plan from which you add a program contains more than one program area,
you will be asked to choose the program area to which you would like the new
program to belong.

• If the plan contains only one program area, the new program will default to that
program area.

• If you want to re-assign a different program area to a linked program, you must first
remove that program from the plan, then link the program to the other program area.

Non-linked programs
If you add a program that is not linked to a plan, you can assign it to any program area.

Related Topics
• To add a program

N570001
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To remove a program from a plan
Before you can delete a plan, you must remove any programs linked to it. Removing the
link does not delete the program from IBM Unica Marketing Operations, it simply breaks
the link.

1. Navigate to the Summary tab of the plan from which to remove a linked program.

2. Click the Manage Linked Objects icon ( ) and select Remove.

The Remove Program Links From Plan window appears.

3. Select the program you want to remove from the Linked Program(s) field.

4. Click the right-pointing arrows button to move the program into the Selected Items
to Remove field.

To move the program back to the Linked Program(s) field, click the program in the
Selected Items to Remove field and click the left-pointing arrows.

5. Click Save Changes.
N580001

To start a plan
Once you start a plan, all participants can work on the plan.

1. Navigate to the Summary tab of the plan that you would like to start.

2. Click the Status icon ( ) and select > Start Plan.

A window appears in which you can add comments or additional information about
the plan.

3. Click Continue.

The plan Summary tab displays. The status is set to In Progress.
N590001

To delete a plan
You can delete a plan from the Plan List page or from the plan Summary tab.

You cannot delete a plan if it has linked programs. You must first remove the link to
the program before deleting the plan.

The following procedure describes how to delete a plan from the Plan List page.

1. Click Operations > Plans.

By default the Active Plans view of the Plan List page appears.

2. Select the checkbox next to each plan that you want to delete.
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3. Click the Delete this Item icon ( ).

4. When IBM Unica Marketing Operations prompts you to verify that you want to delete
the plans, click OK.

Related Topics
• To remove a program from a plan
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4 Programs

■ About programs
■ To add a program
■ To start a program
■ To add new project requests and projects to programs
■ To link an existing project to a program
■ To navigate from a program to a plan
■ To remove projects from programs
■ To delete a program

NF0001

About programs
If you have permission to create programs, you can add a new program. As part of
adding a new program, you select a template set up by an IBM Unica Marketing
Operations administrator.

Once you create a program, you can start the program at any time. Starting the
program makes it active and changes the status of the program to In Progress.

Program views
IBM Unica Marketing Operations organizes programs in views.

• All Programs lists all programs. It also contains links to the Active Programs and
My Programs views.

• Active Programs lists all the programs that are now in the In Progress state. This
is the default view.

• My Programs lists all the programs that you own or are part of as a team member.

You can also access the different views of programs using the Actions menu. It
contains links to the views listed above. In any view, you can change the sort order by
clicking on the column you want to sort by. Click the column a second time to reverse
the sort order.

Additionally, you can search for a program.
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Summary information for programs
On the program Summary tab, IBM Unica Marketing Operations lists summary
information about a program, such as status, security policy, and so on. By default, you
are taken to the program’s Summary tab when you select a program from the Program
List page. Any projects linked to the program are listed on the Summary tab as well.

From the Summary tab, you can also perform tasks such as changing program status,
adding a request, editing the program, linking an existing project, or removing a linked
project.

Supporting projects and requests
At the bottom of the Summary tab, the Supporting Projects and Requests section
displays information about all child projects for the program. This list shows the name of
the project, the name of the project owners, the project ID, the date and time when the
last person updated the project, the target start and end dates of the project, and the
project status.

N5B0001

To add a program
When adding a program, note the following

• To add a program you must have permission to add a program.

• If you add a program, you are the owner of the program.

• You can add other team members, some of whom can also be program owners.

1. Click Operations > Programs.

2. Click the Add Program icon ( ).

3. Select the appropriate template for your program.

Your administrator sets up templates that correspond the types of programs that fit
your organization’s needs. For more information on templates, see the IBM Unica
Marketing Operations Administrator’s Guide.

4. Click Continue.

On the Summary page of the program wizard you can click the Add/Remove
Members button to add team members to the program. You can add members as
either owners or participants in the program. For details, see About Team Alerts.

5. Fill in the fields and continue clicking Next and filling out the required fields until you
reach the Attachments page. The required fields have a double asterisk (**) next to
them.

The number and content of your program pages differ depending on the template
you use. A typical program contains program summary information, perhaps some
additional information pages, and attachments of documents related to the program.

N5C0001

54 IBM Unica Marketing Operations - User's Guide



To start a program

To start a program
You can start any program you created, or any program for which you are listed as an
owner. Additionally, a user may have permission to change the status of all programs.
These permissions are assigned based on a user’s role in the program’s security policy.

1. Navigate to the Summary tab of the program you want to start.

2. Click the Status icon ( ) and select Start Program.

A dialog box appears.

3. Add any comments in the dialog box, then click Close to start the program.

The program’s status changes to In Progress.
N5D0001

To add new project requests and projects to
programs

After you create a program, you can create a new project request or project from within
the program. This automatically links the project request or new project to the program.

Once you add a new project request or a new project to a program, you cannot change
the security policy of the project request, project, or program. You must remove the item
from the program to change the security policy.

1. Navigate to the Summary tab of the program that you want to contain the new
project request or project.

2. Click the Manage Linked Objects icon ( ) and select Add Request if you want
to create a project request or Add Project if you want create a new project.

The wizard for adding a project request or adding a project opens

3. Do one of the following.

• Follow the steps in Requesting a project to add project request and associate it
with this program. Once a user accepts the request, the project created from this
project request is also part of this program.

• Follow the steps in Adding a project to add a new project and associate it with
this program.

When you complete the steps, the project request or project is open to the Summary
tab. The Summary tab has a field called Parent Items and Code. This field contains
a link to the program of which the project is a part.

4. Click the link to open the program.

Scroll to the bottom of the Summary tab of the program to view a list of all the
projects contained in the program.
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Related Topics
• About programs

• To remove projects from programs

N370001

To link an existing project to a program
Before you can link an existing project to a program, there must be existing projects in
your system and you must have the appropriate permission.

After you create a program, you can link existing projects to the program. When you link
a project to a program, all the team members listed in both the project and the program
receive an e-mail message informing them of the link.

1. Navigate to the Summary tab of the program that you want to link to an existing
project.

2. Click the Manage Linked Objects icon ( ) and select Link Existing.

A dialog box appears, where you specify projects to link.

3. Enter search criteria in the Find by name or code field.

4. Click Find.

The Search Results field displays only projects which you can link to the
program. Only projects with the same budget granularity and security policy as
the program will be available. Programs with a status of Cancelled, Deleted, or
Completed never appear in Search Results.

5. In the Search Results field, select the projects to link.

6. Use the >> and << buttons to move projects into or out of the Selected Items to
Link list box.

7. Click Save Changes to create child links to the projects you selected.

The projects you added appear in the list of projects at the bottom of the Summary tab
of the program.

N640001

Security considerations for linking projects and
programs
Linked projects and programs must have the same security policy. Once you link a
project to a program, you cannot change the security policy of either object without first
removing the project from the program.

In order to add projects to the program, you must have Edit Summary Tab permission
for each project you want to add. If you do not have this permission for one or more
projects, ask your administrator for help.

56 IBM Unica Marketing Operations - User's Guide



To navigate from a program to a plan

Related Topics
• To remove projects from programs

N5E0001

To navigate from a program to a plan
You can link the programs you create to a plan. A plan may contain several programs
and helps organize programs in logical groups.Once you link a program to a plan, you
can navigate to the plan from within that program.

1. Navigate to a program that has a parent plan.

The Summary tab has a field called Parent Items and Code. This field contains a
link to the plan that the program is part of.

2. Click the link to open the plan. The Summary tab of the plan appears. Scroll to the
bottom of the Summary tab of the plan to view a list of all the programs contained in
the plan.

3. Click the name of the program you were just in to go back to that program.
N5F0001

To remove projects from programs
You can remove new project requests, new projects, and existing projects from a
program.

1. Navigate to the Summary tab of the program that contains the project you want to
remove.

2. Click the Manage Linked Objects icon ( ) and select Remove.

The Remove Project Links From Program window appears.

3. In the Linked Project/Request list box, select the project requests or projects to
remove.

4. Use the arrow button to move selected items to the Selected Items to Remove list
box.

5. Click Save Changes.

The project requests and projects no longer appear in the list on the Summary tab of
the program.

N600001

To delete a program
When you delete a program, IBM Unica Marketing Operations checks to see if the
program contains links to any projects. If so, you cannot delete the program until you
remove all linked projects.
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1. Select Operations > Programs.

2. Select the checkbox next to each program to delete.

3. Click the Delete this Item icon ( ).

The selected programs are deleted from the system.

You can also delete a program when you have the program open, from any of the

program's tabs, by clicking the Delete this Item icon ( ) in the IBM Unica
Marketing Operations toolbar.
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5 Projects

■ About Projects
■ About campaign projects
■ Creating projects and requests
■ Reconciliation
■ Request statuses
■ Project views
■ Searching for projects
■ Team projects and requests
■ To add a project
■ To start a project
■ Projects attachment tab
■ Project requests
■ To copy a project or request
■ To navigate from a project to a program
■ Linking projects
■ To assign work
■ Selecting projects or requests
■ To change the status of projects and requests
■ To reconcile a project
■ To delete a project

N650001

About Projects
A project contains all the information related to developing and executing one or more
related marketing deliverables or initiatives. This information can include a checklist or
schedule of tasks that people working on the project must perform in order to prepare
and produce the deliverables for the project.

For example, you might use a project called Monthly Tradeshow to collect all the
information needed for the one tradeshow each month that your organization attends.
This information could include who attends the show, what equipment you need in the
booth, copies of demos of the product that you intend to present, collateral you want to
hand out to customers, costs of promotional materials, and any additional information
that pertains to the tradeshow.
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Projects can have subprojects. A subproject has all the same characteristics as a
project. A subproject is linked to a parent project; any project linked in this manner is
referred to as a subproject.

Related Topics
• Projects

• Project requests

• Creating projects and requests

• Team projects and requests

N660002

About campaign projects
If your IBM Unica Marketing Operations system is integrated with IBM Unica Campaign,
you can create campaign projects.

A campaign project collects the information related to developing a marketing campaign
and executing it through Campaign.

A campaign project can contain any features available to projects, including subprojects.
Campaign projects also contain a TCS tab with a Target Cell Spreadsheet and an
additional Campaign Summary section of the Summary tab.

In a campaign project, you synchronize the project's campaign, offer, contact history,
and response history data with Campaign.

N720001

About project codes and campaign codes
When you create a campaign project, you must specify a project name and code. The
same name and code are used as the campaign name and code when you click the
Create Linked Campaign icon to create the campaign in IBM Unica Campaign.

The code must be unique in both IBM Unica Marketing Operations and IBM Unica
Campaign. The system checks the uniqueness of the code before creating the project
or saving the project if you have changed the code.

N1D0001

Creating projects and requests
You can create either a project or a project request.

• If you have permission to create projects, you can add a new project by selecting a
project template set up by your administrator. You select this template from a list of
available templates. A project is one instance of a template. For example, you would
not use one project to capture information about more than one tradeshow.
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• If you do not have permission to create a project, you can instead create a project
request by selecting the type of project you want to request from a list of available
templates. Project requests allow you to get formal approval of a proposed project,
or allow for acceptance of a work request.

For example, people within the marketing department or outside vendors that do not
have permission to create projects can create project requests that ask someone
with the permission to create projects, to create a specific project. Specifically, a
marketing manager may submit a project request to the CMO to have the request
formally approved, or a sales account manager may submit a project request to the
marketing services department requesting development and production of some
specialized collateral.

After you create a project request, you submit it to an authorized individual, and when
they accept the request, IBM Unica Marketing Operations creates a project.

You can also create a project request or a project from within a program.

Once you create a project, you can start the project at any time. Starting the project
makes it active and you can view it in different views in IBM Unica Marketing
Operations. When you create a project you become the owner of that project.

Related Topics
• About programs

N200001

Reconciliation
Projects can be in a temporary state, In Reconciliation. A user can re-activate a
completed or cancelled project, update project information, then change the state back
to its previous state (completed or cancelled). For example, the owner of a project can
make private changes to a cancelled project.

While a project is in this state, it is not available to any other participants for editing. The
project is read-only for users not having reactivate rights.

The spirit of reconciliation is that one can do anything within the project but nothing
externally. That is, for the rest of the IBM Unica Marketing Operations system, the
project is not available. For example, while in reconciliation, you cannot reassign tasks.

Related Topics
• To reconcile a project

• To change the status of a process

N210001

Request statuses
The following table describes the possible statuses for requests.
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Status Description

Draft Indicates the request has been created, but not yet submitted.

Submitted Indicates the request has been submitted to the proper person who can accept or
reject the request.

Returned Indicates the person who reviewed the request has returned it to the submitter,
either for rework or some other deficiency.

Accepted Indicates the request has been accepted. Once this occurs, IBM Unica Marketing
Operations creates a corresponding project. This indicates the end of the life cycle
for the request.

N220001

Project views
IBM Unica Marketing Operations organizes projects and project requests in views as
follows.

View Description

All Projects and Lists all projects and requests. It also contains links to the other project views and
Requests any saved project searches.

Active Projects and Lists any active projects or project requests. A project is active when it is in the In
Requests Progress state and a request is active when it is in the Submitted state. This is

the default view.

My Projects Lists all the projects that you own or are part of as a team member.

My Requests Lists all the requests where you are either the requestor or the recipient.

Completed Pro- Lists all projects with a status of Completed.
jects

This Week's Pro- All projects and requests that fall within the current week.
jects and Requests

Next Week's Pro- All projects and requests that fall within next week.
jects and Requests

This Month's Pro- All projects and requests that fall within the current month.
jects and Requests

Next Month's Pro- All projects and requests that fall within next month.
jects and Requests
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View Description

All My Teams Pro- All projects assigned to a team to which you belong.
jects

All My Teams Pro- All project requests assigned to a team to which you belong.
ject Requests

All My Teams Un- Lists all project requests assigned to a team to which you belong but not assigned
assigned Project to a team member.
Requests

N730001

Choosing list or calendar view
You can view projects in a project list view or a calendar view. By default, IBM Unica
Marketing Operations displays projects in a list view when you select Projects from the
Operations menu.

View Description

List view Displays all the projects listed alphabetically in ascending order. You can change
the order by clicking once on the Name/Owner column.

If you want to sort by any of the other columns, click that column. Click the column
a second time to change the order of the column from ascending to descending.

Displays a calendar view of projects, listing any projects taking place and theirCalendar view
dates of activity.

N740001

To select project views
You can access the different views of projects using the Actions menu. In any view,
you can change the sort order by clicking on the column you want to sort by. Click the
column a second time to reverse the sort order.

1. Open Marketing Operations and select Operations > Projects.

The default page that appears is the Active projects and Requests view. You can
change this default page by modifying your user options.

2. Click the Actions icon ( ) and select All Projects and Requests or My
Requests or My Projects to view all projects, only project requests that pertain to
you, or only projects that pertain to you.

3. Click the Actions icon ( ) and select Search for Projects to search for projects
meeting a specified criteria. You can then save that search.
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Related Topics
• Project views

• To set your project options

• To perform an advanced search (except for assets)

N670001

Searching for projects
You can search for projects grouped by any criteria that is useful to you and save the
results of that search for later viewing. For example, you might search for all projects
that started in June and then save the results of that search by naming it June
Searches. You could also search for all projects of a certain type, such as all tradeshow
projects, and save that search. You can then access those search results at any time.

Related Topics
• To perform an advanced search (except for assets)

N1E0001

Team projects and requests
Users can submit requests to a team, rather than an individual. Such requests are
referred to as team requests. When someone accepts a team request, the resulting
project is referred to as a team project.

Related Topics
• Team projects lifecycle

• To reassign a team project

N1F0001

Team projects lifecycle
The following table describes the life cycle of team requests and projects.

The following steps are somewhat dependent upon the routing model used for the
particular team involved in the request.

User action System action

• Creates a team request.1 A user submits a request to a team.
• Populates the My Team Routing field for

the request.
• Sets the status of the request to Submit-

ted.
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User action System action

• Changes the status of the request to2a A team manager or member returns the
Returned.request.

• Clears the My Team Routing field for the
request.

• Sets the owner of the team project to the2b A team manager assigns the request to a
team member selected during the assign-team member.
ment.

• Sets the owner of the team project to the2c A team member accepts or returns the re-
team member selected during the assign-quest.
ment.

3a If accepted, the owner of the team project Updates the status for the team project as
sees it through to completion. applicable.

• Sets the owner of the team project to the3b If the owner becomes unavailable, a team
newly-assigned team member.manager or member can reassign the pro-

• Updates the My Team Routing field forject.
the project.

N760001

To reassign a team project
A team project can be reassigned, for example if the team member responsible for the
project goes on vacation or otherwise becomes unavailable.

1. Navigate to the Projects list page by selecting Operations > Projects.

The Active Projects and Requests view appears. If the project you wish to
reassign does not display, click All Projects and Requests.

2. Select the team projects to reassign by checking the box next to each project.

3. Click Reassign Team Projects.

A dialog box appears. Note that you can only reassign team projects for which you
have the proper authorization (via team membership and routing options).

4. In the Assign to field for each project, select the user to whom the project should
belong (this user becomes the owner of the project).

5. Optionally, enter comments into the Comments text box.

6. Click the Reassign Project(s) button to complete the reassignments, or click
Cancel to close the dialog box without changing any project ownerships.

N770001
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To respond to team requests as a team manager
When someone submits a request to a team on which you are the manager, you may
be required to assign a team member to the request. The assigned team member
becomes the owner of the resulting project.

1. Select Operations > Projects.

2. Respond to team requests in either of the following ways:

• Select a single project and click the Assign Team Request icon ( ).

• Click the Actions icon ( ) and select All my teams project requests. From
this view you can respond to one or multiple project requests by selecting the
requests you want to assign and clicking the Assign Team Request icon

( ).

Note that you can respond only to team requests for which you have the proper
authorization (via team membership and routing options).

3. In the dialog box, assign the request or requests to the appropriate team members.

4. Optionally, enter comments into the Comments text box.
N630001

To add a project
When adding a project, note the following.

• To add a project, you must have the proper security permission.

• If you add a project, you are the owner of the project.

• You can add other team members (some of whom can also be project owners).

• You may also add a project in response to a project request.

1. Select Operations > Projects.

2. Click the Add a Project icon ( ).

3. Select a template for your project.

A IBM Unica Marketing Operations administrator sets up templates that correspond
to the types of projects that fit your organization’s needs. You must select a
template configured as a campaign project template to access any of the IBM Unica
Marketing Operations and IBM Unica Campaign integration features.

4. Click Continue.

5. Fill in the fields in the wizard and continue clicking Next and filling out the required
fields until you reach the Attachments screen.
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You can click Finish on any of the wizard pages; IBM Unica Marketing Operations
automatically saves all default values for non-mandatory attributes in the remaining
steps. You can also click Save and Duplicate on any of the wizard pages;
Marketing Operations automatically the current project with default values for non-
mandatory attributes in the remaining steps, and you then see the Summary tab of a
new project with data already populated.

6. Do one of the following.

• Click Finish to save the project. The project Summary tab is displayed.

• If you need to create another project that is similar to the one you have just
created, click Save and Duplicate. The current project is saved, and you then
see the Summary tab of a new project, with data already populated. You should
change the default name, and then you can edit the new project as needed.

7. Do one of the following if you want your project or projects to be active.

• If you created a single project, click the Status icon ( ) and select Start.

• If you created multiple projects, click the Actions icon ( ), select All
Projects and Requests to see your draft projects, and start them.

The tabs in a project differ depending on the template you used. A typical project
contains project summary information, strategy, workflow, including a schedule of tasks
and deliverables, tracking of expenses and resources, and attachments of documents
related to the project. When IBM Unica Campaign is integrated with Marketing
Operations, a campaign project also contains a Target Cell Spreadsheet tab.

N680001

To start a project
You can start any project you own.

• A project you or someone in your organization created.

• A project created when you or someone in your organization accepted a project
request.

Once you start a project, all project participants can work with their assigned tasks.

1. Navigate to the Summary tab of the project you would like to start.

2. Click the Status icon ( ) and select Start.

Related Topics
• To add a project

• To add a request

N690001
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Projects attachment tab
The Project Attachments tab is broken into two sections, one for the project's
attachments, and one attachments for tasks that belong to the project.

Column Description

Icon, file name Icon of the file and file name that links to the file. The file type and file size are
listed in brackets.

Description This column displays the name of the person who added the file, timestamp when
added and the description for the file.

Task This column is for the Task Attachments section of the page only. Displays a link
to the parent task of this attachment

Actions This column contains the following links:

• Send as Mail Attachment: Click to send this attachment via email.
• Remove: A user having privileges to remove the attachment can delete the

attachment using this link. The task owner would receive an alert of the
attachment being removed. This attachment would no longer be available
from the task attachment tab.

N180001

Project requests
A project request is similar to a work order, or creative brief. It represents a request for
someone else to do work according to the requester's specifications.

There may be times when users within an organization or outside vendors would like to
request a project. For example, as an outside vendor, you may submit a project request
to the marketing services organization requesting some collateral. The marketing
services representative accepts the request and creates a project, organizing and
assigning resources to the project in order to manage the creation of the collateral.

If you request a project, you are a requestor. You then submit the request to a recipient
for approval. Once the recipient accepts the request, the recipient owns the project and
is called the owner.

A project request does not contain a workflow. Once the request is approved and
transitions to a project, it contains the appropriate workflow.

N620001

To request a project
When adding a project request, note the following.

• To request a project you must add the request and then submit it.

• To add a request you must have the proper security permission.
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• If you request a project, you are a requestor. You then submit the request to a
recipient for approval. Once the recipient accepts the request, the recipient owns the
project and is called the owner.

Related Topics
• To add a request

• To submit a request

N780001

To add a request
Adding a request is the first step in requesting a project. After you add the request you
must submit it.

Your request pages differ depending on the template you use. A typical request can
contain the following sections:

• Summary information about the request

• Tracking information

• Attachments that are part of the request.

1. Select Operations > Projects.

2. Click the Add Request icon ( ).

3. Select a template for your request.

Your administrator sets up project templates that correspond to the types of projects
that fit the needs of your organization. You must select a template configured as a
campaign project template to create a project that uses any of the IBM Unica
Marketing Operations and IBM Unica Campaign integration features.

4. Click Continue.

5. Fill in the fields in the wizard and continue clicking Next and filling out the required
fields until you complete your request, then click Finish.

Note the following.

• You configure the request recipients in the wizard. Depending on the template
you chose, some of the recipients may already have been set up. Also,
depending on your permissions and the way the template was set up, you may
or may not be able to change the recipients, their roles, sequence order, and
how long they have to respond (duration).

• Recipients may be assigned a sequence number that determines the order in
which they receive and must approve the request.

• Recipients may be assigned a duration that determines how long they have to
respond.

6. When you have finished configuring your request, do one of the following.

• Click Finish to save the request. The request Summary tab is displayed.
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• If you need to create another request that is similar to the one you have just
created, click Save and Duplicate. The current request is saved, and you then
see the Summary page of a new request, with data already populated. You
should change the default name, and then you can edit the new request as
needed.

7. Do one of the following if you want your request or requests to be active.

• If you created a single request, click the Status icon ( ) and select Submit.

• If you created multiple requests, submit them as described in To change the
status of projects and requests.

When the last required recipient approves the request, IBM Unica Marketing Operations
creates the project.

Related Topics
• To submit a request

N790001

To submit a request
To submit a request, you must first add the request. You then submit the request to the
request recipient(s). If the request is accepted, then one of the recipients becomes the
owner of the project.

1. Add a request.

2. If recipients have not been pre-selected, add one or more recipient steps and assign
a User or Team to the recipient step.

3. On the Summary tab, click the Status icon ( ) and select Submit.

4. Enter any comments that you want the recipient to view regarding the request.

5. Click Continue.

The recipients whose turn it is to receive notification are notified of your request and the
status of the request changes to submitted. The recipients appear in the Recipient
section of the request’s Summary tab.

Related Topics
• To add a request

N7B0001

To monitor the status of a project request
You can view the following information about project request recipients.

• Role

• User assigned to the role

• The sequence number assigned to the recipient
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• The status of the recipient's response (Not yet notified, Waiting, Accepted, or
Returned)

• Any comments the recipients have added (click the User comments link)

1. Select Operations > Projects.

The Active Projects and Requests page appears.

2. Click the project request you want to monitor.

The project request's Summary page appears, with information about the recipients
and the status of their responses.

N7C0001

To re-draft or cancel a request
You can re-draft a request before it has been accepted or if it has been returned by a
required recipient. To re-draft or cancel a request, do one of the following.

• To add or change information, click the Status icon ( ) and select Re-draft.

While you re-draft the request, the recipient cannot respond to the original request.
If you need to change recipients, select Edit.

• To cancel the request, click the Status icon ( ) and select Cancel.

When you re-draft or cancel a request, you can add comments indicating the reason for
the re-draft or the cancellation.

If you re-submit a request, recipients are notified of the re-submission according to the
re-approval rule selected when the request was created. If the re-approval rule allows
you to select recipients, and if you have not changed recipients when re-drafting the
request, when you re-submit the request you can select from a list of required recipients
who have accepted the request. If the recipients have been assigned sequence
numbers, recipients are notified in sequence.

N7D0001

To respond to a request as an individual
When someone creates a request for a project and names you as the recipient of the
request you receive an alert message in the My Alerts page and an e-mail message
notifying you of the request.

1. Navigate to a request by selecting Operations > Projects.

The Active Projects and Requests view appears. If the request you wish to accept
is not in the list, click All Projects and Requests.

2. Click the request to open it.

3. Review the request and decide whether you want to accept it or return it to the
submitter.

4. Enter any comments in the Comments field and click Accept or Return.

Version 8.5.0 71



5 - Projects

5. If you are accepting a team request, in the Assign to field, select the user to whom
the resulting project will be assigned.

6. Click the Actions icon ( ) and select All Projects and Requests:

• If you accepted, both the accepted request and the not yet started project appear in
the list. You are the owner of the not yet started project.

• If you returned the request, Marketing Operations notifies the requestor. The
request’s status changes to Returned.

• If the request is returned, the requestor has options to resubmit or cancel the project
request.

N6A0001

To copy a project or request
You can copy a project or request when it is in any state. You can copy a project
request before or after you submit it. You may want to copy a project or request if you
want to create another project or request that is very similar to an existing one. You can
make a copy of the existing project or request and modify it.

1. Navigate to the Summary tab of the project or request you want to copy.

2. Click the Copy icon ( ).

The Copy to dialog box opens.

3. You can optionally also copy the parent program or project link:

• Select Copy parent program link to copy the parent program link.

• Select Copy parent project link to copy the parent project link.

4. Click OK.

The copy of the project or request opens to the Summary tab. The copy appears as
Copy of <original project name>. For a project, its status is Not Started; for a
request, its status is Draft.

5. Modify any information you want to change in the copy and click Save Changes.

The copy appears in your All Projects and Requests view and your My Projects or
My Requests view.

N6B0001

To navigate from a project to a program
You can link a project to a program. Programs help you organize projects in logical
groups. Once you link a project to a program you can navigate to the program from
within that project.

1. Open the All Projects and Requests view (by selecting Operations > Projects
and clicking All Projects and Requests in the breadcrumb).
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2. Click a project to open it.

The Summary tab has a field called Parent Items and Code. This field contains
links to the ancestors of the project (its container program and plan).

3. Click the link to open the program.

The Summary tab of the program appears. Scroll to the bottom of the Summary
tab of the program to view a list of all the projects contained in the program.

4. Click the name of the project you were just in to go back to that project.

Related Topics
• To link an existing project to a program

N6C0001

Linking projects
Marketing projects often involve people from outside the marketing department, making
it difficult to track everything from within a single, comprehensive project.

For example, work for a tradeshow might involve the following types of work, each a
project in its own right.

• Identify and sign up individuals to attend, present, cover the booth, and so forth.

• Produce marketing collateral.

• Design, build, and test a demo.

• Set up training sessions and/or speaking engagements.

• Generate the customer invitation list, create the invitation, send the invitation, track
the responses, and so forth.

• Create and maintain the tradeshow web page(s).

Many of these individual projects are tracked and managed within the respective
departments, but this never truly gives the coordinator a full view of whether the
tradeshow will occur on time and without problems.

A project coordinator can create all of the necessary individual projects, assign owners
to each, and then create child links from the tradeshow project to each of the
subprojects. This provides the project coordinator with a single view in to the entire
project.

You can organize projects by creating parent/children relationships between them.

No data is exchanged between parent and children projects; the relationship is for
organizational purposes only.

N7E0001
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Subprojects overview
From a project’s summary page, you can manage subprojects using the following menu

items that display when you click the Manage Linked Objects icon ( ) .

• Add Project: to create a new child project.

• Add Request: to create a new child request.

• Link Existing: to create a child link to one or more existing projects or requests.

• Remove: to remove existing links to one or more child projects or requests.

Note the following.

• Security policies must be the same for parent and child projects.

• A project’s summary page contains an area showing the links to all of its direct
children.

• A project can have a child/parent relationship with either another project or a
program, but not both. That is, if a project is linked to a program, it cannot be linked
to a parent project.

• Once you add a subproject, you cannot change the security policy of the parent or
child project; you must first remove the link.

N7F0001

Details on the project/subproject relationship
The project-to-subproject relationship has the following characteristics.

• Any existing project or request (having the same security policy) can be linked to
another project (requests can only be children, not parents).

• A project can have at most one parent project or program, but not both.

• A project can have an unlimited number of children projects.

• A project can have both a parent and children; this makes it possible to have an n-
level deep hierarchy for projects.

• You cannot delete a project that is linked to either a parent or child; you must first
remove all parent/child (and project/program) relationships before you can delete a
project.

• When copying a project that is either linked as child or parent, the new project is not
linked.

• Metrics, budgets, and workflow do not roll up from a child project to a parent project.
N800001

To create a child project/request
1. Navigate to the Summary tab of the parent project.

74 IBM Unica Marketing Operations - User's Guide



Linking projects

2. Click the Manage Linked Objects icon ( ) and select Add Project or Add
Request.

These options are available only if you have the appropriate security
permissions.

3. Choose a template for the a new subproject or request.

The wizard for adding a project request or adding a project appears.

4. Complete the wizard.

• The owner and security policy fields default to the values for the parent project.
The owner of the new subproject is the user completing these steps; so the
owner of the child project may be different from the owner of the parent.

• If you use the Save and Duplicate button to create multiple projects or
requests, they are linked to the same parent.

When you complete the wizard, the project request or project is open to the Summary
tab. The Summary tab has a field called Parent Items and Code. This field contains
links to the ancestors of the project.

N380001

To link a child project or request to a project
1. Navigate to the Summary tab of the parent project.

2. Click the Manage Linked Objects icon ( ) and select Link Existing. Note this
link only appears enabled if you have the appropriate security permission.

A dialog box appears, where you specify project(s) to link.

3. Enter search criteria in the Find by name or code field.

4. Click Find.

IBM Unica Marketing Operations displays search results of only those projects and
requests that have the same security policy and budget granularity as the project.
For example, if your project uses the global security policy, only projects and
requests that also use the global security policy appear after a search. Additionally,
projects with a status of Cancelled, Deleted, or Completed never appear in your
search results.

5. In the Search Results field, select the project(s)/request(s) to link as children.

6. Use the >> and << buttons to move projects/requests into or out of the Selected
Items to Link list box.

7. Click Save Changes to create child links to the project(s) or request(s) you
selected.

N810001
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Security considerations for linking projects
Linked projects and sub-projects must have the same security policy. Once you link a
project to another project, you cannot change the security policy of either object without
first removing the relationship.

In order to link, add, or remove parent/child projects (and requests), you need to have
the appropriate security permission. If you do not have the appropriate permission for
the task you attempt, ask your administrator for help.

N820001

To remove a parent-child project link
You can remove N-level deep child relationships using this procedure. That is, you can
remove “grandchild” and “great-grandchild” relationships, and so on.

1. Navigate to the Summary tab of the parent project.

2. Click the Manage Linked Objects icon ( ) and select Remove.

A dialog box appears, where you specify project(s)/request(s) to remove.

The list contains children from all levels; that is all children, direct and indirect,
appear on the list.

3. In the Linked Project... field, select the project(s) to remove as children.

4. Use the >> and << buttons to move projects into or out of the Selected Items to
Remove list box.

5. Click Save Changes to remove child links to the project(s) you selected.

The project requests and projects no longer appear in the list on the Summary tab of
the project.

Removing the link does not remove or delete the project; it simply removes the
relationship.

N6D0001

To assign work
Once a project exists, users can assign work (tasks) to people or teams.

1. Navigate to a project.

2. Add people and teams to the project. To assign work to an individual or team, they
must be members (or reviewers) of the project.

3. Assign tasks in any of the following ways:

• Use the Assign Work By Role icon ( ) on the People tab of the project to
assign all tasks based on user roles.
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• Use the Find And Replace Task Members icon ( ) or the Find and

Replace Task Reviewers icon ( ) on the People tab to reassign work for
certain people or teams.

• Use the Workflow tab to individually assign tasks to users and or teams.

• Use the Members/Roles icon ( ) on the People tab of the project to assign a
team.

When users login, they can act on the work (tasks) that have been assigned to them.

Related Topics
• To assign work by role

• Finding and replacing task members or reviewers

N6E0002

Selecting projects or requests
When you select checkboxes on the Projects list page, IBM Unica Marketing Operations
retains your selections during a session, as follows.

• In View mode, your checkbox selections are retained until you navigate to a list
page for a different object. For example, if you make a selection on page 1 of a
multi-page project list, go to page 2, and then return to page 1, either by clicking the
page number at the bottom of the page or using the Recent menu, your selections
are retrained. However, they are discarded if you navigate to the Tasks page.

• If you edit a project by clicking the Edit a Tab icon on the list page, your selections
are retained if you click Save and Return to List.

N6F0002

To change the status of projects and
requests

You can change the status of one or more projects or requests. Your change must meet
the following prerequisites; if it does not, you will see a warning message that describes
the possible problems.

• The new status must be a valid transition from the existing status.

• You must have appropriate permissions to make the change. If you are accepting or
rejecting a project request, you must be an appropriate approver.

Your administrator can set up IBM Unica Marketing Operations to send an alert to
owners and members of a process when its status changes.

1. On the Projects and Requests list page, select the checkbox next to each item
whose status you want to change.
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Note that, although you can select items across multiple pages, your changes are
applied only for the selected items on the page you are viewing when you select the
new status.

2. Click the Status icon ( ) and select the desired status. A dialog box appears in
which you can add comments.

3. Enter any comments, and click Continue to close the dialog box and apply the new
status.

N700001

To reconcile a project
After you complete (or cancel) a project, you can edit certain portions of the project by
placing it into a temporary state, In Reconciliation.

1. Navigate to the Summary tab of a cancelled or completed project.

2. Click the Status icon ( ) and select Reconcile.

A dialog box appears in which you can add comments.

3. Click Continue to close the dialog box.

The status of the project is set to In Reconciliation.
N710001

To delete a project
When you delete a project, IBM Unica Marketing Operations checks to see if you linked
the project to a program. If you did, you cannot delete the project until you remove it
from the program.

1. Open IBM Unica Marketing and select Operations > Projects.

By default the Active Projects and Requests page appears.

2. Select the checkbox next to each project you want to delete.

3. Click the Delete this Item icon ( ).

Related Topics
• To remove projects from programs
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6 Workflows

■ About workflows
■ Workflow concepts
■ About the workflow spreadsheet view
■ About the workflow timeline view
■ About the workflow process flowchart view
■ Workflow tab layout page
■ Scheduling work time
■ To edit the the default workflow
■ About adding a stage or task
■ Updating and finishing tasks
■ To add roles to tasks
■ About copying and pasting tasks
■ To fill data into a range of cells
■ To print the Workflow tab
■ Post task update dialog box
■ Managing task dependencies

N850001

About workflows
When you create a new project , you use the Workflow tab to customize the workflow
provided by the project's template. When you participate in a project , you use the
Workflow tab to keep track of your work. If you have the appropriate permissions, you
can save a workflow as a workflow template.

Any member of the project can edit any column of the Workflow tab as long as he or
she has the appropriate access permission.

The workflow tab has an edit mode and three view modes.

• To edit the workflow displayed on the tab, click the Edit icon ( ).

• You can view the workflow as a spreadsheet, a timeline, or a process flowchart.

Related Topics
• About the workflow spreadsheet view

• About the workflow timeline view

• About the workflow process flowchart view
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N860001

Workflow concepts
Workflows contain Approvals and Tasks.

Tasks
Tasks are steps in the workflow where a user must take an action. The task is not
complete until the action is complete.

Tasks have several types of data associated with them, described below.

Stages
You can group workflow tasks under headings called stages. Stages can help you with
task organization. For example, you can create a stage that has all tasks performed by
your specific users. Stages are the headings in bold that group the tasks together.

Dates
Workflows contain the following types of dates.

• Actual/Forecast dates are dates a task owner plans on starting and completing a
task. These dates are specified while the task is still pending. When a member
starts and completes a tasks, he or she can specify the same dates or different
actual dates (the real dates that they started and completed the task).

• Target dates are dates used to plan the project schedule. Typically, they are set at
the beginning of the project.

• Anchored dates are fixed dates that cannot change, even if the dates of the tasks
upon which they are dependent change.

• Non-work time are dates when people do not work so the system skips those dates
when calculating durations for tasks. Marketing Operations currently supports
system-wide non-work time that applies to all tasks. It is up to the project manager
to determine whether overriding any of these dates is necessary. System
administrators enter and maintain these dates.

• Weekend dates are dates you use to specify work that occurs on a weekend on a
per-task basis. You can schedule work on a weekend date using the Schedule
Through option for each task.

Effort
The work effort in days (as opposed to duration) that it takes a user to complete a task.
For example, the task may have taken three calendar days to complete, but the task
owner only spent half a day on the task for each of the three days, so the effort is one
and a half days.
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Locked tasks
When you edit a task, the task is locked so no other user can edit it at the same time.
Additionally, when someone creates an approval from an approval task, the approval
task becomes locked permanently.

If anyone attempts to edit a locked task, they receive a warning message, indicating that
it is currently in use.

People and roles
You can assign tasks to individual team members or you can assign tasks to all team
members in a given role. When you assign a task to one or more team members, they
are considered to be the task owner.

Workflows use the following concepts to identify the people who perform work.

• Task owners are the people responsible for executing or managing tasks. For
approval tasks, these members become the owners of the approval.

• Reviewers are reviewers of approval tasks. These members become the approvers
of the approval.

• Roles are used as a bridge between tasks and people. They are useful for
assigning work on a generic basis. For example, each type of project you create can
have its own workflow template, and the template can contain standard roles for
certain tasks. Then when you create a project, some (or all) of the tasks have a
default role already associated with them.

N970001

About My Tasks
IBM Unica Marketing Operations allows users to view the list of tasks assigned to them.
We refer to this list as My Tasks, since each user gets a customized view when
selecting Operations > Tasks.

The My Tasks list enables you to see all tasks to which you are assigned, allowing you
to view tasks across multiple projects. This feature consolidates the information that you
would otherwise retrieve by navigating individually to each of your projects, clicking on
its workflow tab, and searching for all tasks to which you are assigned.

From this screen, you can perform the following actions.

• Get a summary view of all your tasks and approvals.

• Mark selected tasks as completed or skipped.

• Navigate to a task’s Workflow tab.

• Update task properties.

• Search or filter the task list by criteria you choose.

Related Topics
• Filtering My Tasks

N980001
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Filtering My Tasks
By default, the My Tasks page displays all of your tasks, for all projects and

requests.You can filter the list of tasks displayed by clicking the Actions icon ( ) at
the top of the page.

This table describes the available filters.

Filter Description

All My Teams Lists the tasks assigned to all teams of which you are a member.
tasks

All My Teams Un- Lists the tasks that are assigned to a team of which you are a member but that
assigned Tasks are not yet assigned to an individual.

All Tasks Lists all tasks in the system.

My Active Tasks Lists your assigned tasks for all projects that are currently active (started but not
yet completed).

My Completed Lists tasks assigned to you that are marked as completed.
Tasks

My Future Mile- Lists tasks where all the following criteria are met.
stones • The task has a milestone flag specified.

• The task must be assigned to you.
• The task is not completed or skipped.

My Milestones Lists all milestones in tasks that are assigned to you.

My Recent Tasks Lists all upcoming and in-progress tasks meeting the following criteria.

• The task must be assigned to you.
• The task has not been completed or skipped.
• The task must have a start or end date that falls within the past 14 days.

My Pending Ap- Lists all the approvals waiting for your response. It includes any approvals that are
provals waiting for your approval that you have not responded to already.

My Tasks Lists all assigned tasks. This is the default view when you select Operations >
Tasks.

My Upcoming Lists tasks assigned to you that are scheduled to end within the next 14 days.
Tasks

N990002
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About the task pane
When you click on a task in the My Tasks page, the task pane opens on the right and
the task's parent object opens on the left. The task pane provides shortcuts to many
IBM Unica Marketing Operations functionalities, context for the task you are working on,
and tools that allow you to move directly through the workflow.

Depending on the parent object you are working on and permissions, you may be able
to do the following tasks by clicking on links in the task pane.

• Edit the project's tabs

• Add Attachments

• Read and post messages

• Manage team members and reviewers

• Find and replace task owners

• Edit the workflow

• Edit budget allocations and line items

• Edit Tracking

• Add a child object or request

• Link an existing program, project, or request to the parent object

The task pane also provides context while you work by showing the next task in the
workflow (that you have permission to see) on the bottom of the task pane. If you do not
have permission to edit it, the task is in view mode. You can also record effort time and
write hand-off comments.

The following tools allow you to move through multiple tasks and approvals directly on
the task pane.

• Save the task to work on later by clicking Save for Later

• Mark the task complete by clicking Finish

• Skip the task by clicking Skip
NA00001

About schedules
There are two options for scheduling in workflows.

• Baseline

• Up-to-date

Baseline scheduling
You use baseline scheduling when you want to compare an actual schedule to a fixed
target schedule. With baseline scheduling, you never change the target schedule,
allowing it to serve as a baseline. Users who are assigned tasks receive reminders on
the forecast/actual dates.
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Up-to-date scheduling
You use up-to-date scheduling when you want to establish the schedule as the official
schedule that is updated regularly. This mode enables project managers to capture the
most up-to-date, official schedule; however, it does not provide easily for viewing a
baseline version of the schedule.

NA10001

To use a baseline schedule
Before creating your projects, have the system administrator set up permissions and
reminders as follows.

• Set permissions so that only project owners can update Target dates.

• Set reminders (Alerts) based on the Forecast/Actual dates.

While working with a baseline schedule, team members perform the following high-level
steps.

1. The owner sets the initial Target Start and End dates for each task.

These dates stay fixed throughout the entire project .

2. As the project progresses, team members update the Forecast/Actual dates with
real data.

NA20001

To keep an up-to-date schedule
Before creating your projects, have your system administrator set up permissions and
reminders as follows.

• Set permissions so that only project owners can update Target dates.

• Set reminders (Alerts) based on the Target dates.

• Set reminders to be sent only to the owner or owners.

• Optionally, set reminders on the Forecast/Actual dates to be sent to team members.

While working with an up-to-date schedule, team members perform the following high-
level steps.

1. The owner sets the initial Target Start and End dates for each task.

2. As the project progresses, team members update the Forecast/Actual dates with
real data.

3. Once a task is delayed (the owner receives reminders based on Target dates), the
owner assesses the situation and adjusts the Target dates and durations as
necessary.

NA30001

About date rippling
When you enter or change the date for a task, Marketing Operations can calculate other
dates based on your entry. It uses an internal algorithm to bi-directionally calculate the
dates of dependencies, starting with the cell where you entered the date.
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When you recalculate dates on a workflow, note the following.

• In addition to factoring in non-work days and hours, date calculations use two
additional system-wide properties: start time of day and, number of hours per day.
Your system administrator configures these parameters.

• If a task row is anchored, date rippling does not update its dates (even if the date
columns are empty).

• Date rippling does not affect active and finished tasks; only tasks with a status of
Pending.

• Date rippling observes the per-task options for non-work time. That is, the date
rippling algorithm takes into account whether or not a task is scheduled to progress
during non-work time and/or weekends.

• Do not log forecast times outside of business hours if you intend to do date rippling
or other automatic calculations afterwards, because that information will be
overwritten.

NA40001

To automatically calculate workflow dates
When you enter or change the date of a task, Marketing Operations can calculate other
dates based on your entry.

1. Enter or change the date for a task in any of the date fields.

2. Select the date and click anywhere on the screen except for another date field.

The Ripple icon ( ) appears next to the end date.

3. Click the Ripple icon.

Alternatively, you can select one of the toolbar icons for recalculating dependency
dates.

The other dates in the workflow change, based on the new entry.

Related Topics
• Workflow toolbar

• To ripple dates above a locked task

NA60001

To ripple dates above a locked task
If a workflow has a locked task, and you change the date of a task that is located above
the locked task, you receive a warning when you attempt to ripple dates.

To clarify this task, the steps below assume the following:

• Task 1.8 is locked.

• You need to change the duration of task 1.5 from 5 days to 10 days.

• All tasks are dependent on the previous task.
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1. Open the workflow for editing, and change the duration on task 1.5 from 5 days to
10 days.

2. Click the ripple icon next to the end date of task 1.5.

The system displays a warning message, saying you cannot ripple through the
locked row.

3. Click the start date of task 1.8

4. Click the ripple icon ( ).

The system calculates the dates below the locked task.
NA70001

Workflow links
The Workflow tab displays the following links.

Link Description

Breadcrumbs Click any active link in the breadcrumbs trail to go to that page.

Breadcrumbs (a list of pages you visited prior to arriving at the current page)
are located above the project name.

Edit
Click the icon to add, remove, or make changes to workflow stages and
tasks.

View as spreadsheet
Click the icon to view the workflow as a spreadsheet.

This view provides access to granular information about a task, presented in
table format. For example, you can easily look up a task's status, duration,
forecasted end date, and team members using the column headers. This is
the default view.

View as timeline
Click the icon to view the workflow as a timeline.

This view provides a graphic view of information such as task duration and
status. From the Project Timeline drop-down menu, select various options
such as Dates/Progress to show this information on the timeline.

View as process flow- Click the icon to view the workflow as a process flowchart.
chart

This view shows the workflow tasks as a network diagram.

Layout
Click the icon to open a dialog for adding and removing columns from
the spreadsheet view.
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Link Description

Save as template Click to save the workflow definition directly into the template library (if you
have the permission to do so).

A dialog is presented to allow you to name the template. For more details,
see the Marketing Operations Administrator’s Guide.

Tasks and stages In the spreadsheet view, tasks are links that behave as follows:

• Clicking an approval tasks pops up the summary page for the approval in
a new window.

• Clicking a workflow task pops up the Post Task Update dialog in a new
window.

Related Topics
• To edit the the default workflow

• About the workflow spreadsheet view

• About the workflow timeline view

• Workflow tab layout page

• Post task update dialog box

N870001

About the workflow spreadsheet view
When you display the workflow as a spreadsheet (the default), the workflow displays the
information about the stages and tasks in your workflow as a list in a spreadsheet. You
use this view to update task status, add reviewers, and changes dates, among other
tasks.

Related Topics
• Workflow tab fields

• Workflow toolbar

NA80001

Workflow tab fields
When the workflow appears in spreadsheet view (the default view), it includes the
following fields and columns.
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Field Description

Tasks and stages Lists the task stages and tasks that comprise the project .

When in edit mode, click a stage or task to revise or change.

When in view mode:

• Clicking an approval task opens the approval’s summary page in a new
window.

• Clicking a workflow task opens the Post Task Update screen in a new
window.

Status The status of the task.

Approval tasks can have one of the following statuses.

• Not started
• In Progress
• On hold
• Completed
• Canceled

People tasks can have one of the following statuses.

• Pending
• Active
• Skipped
• Finished

When an approval task has a status of In Progress, On hold, or Completed, this
field is read-only.

When an approval task has a status of Not started, in edit mode you can change
the status to In progress or Canceled.

% Complete The percentage value that represents how complete a task is.

When in edit mode, click the measuring bar for a task (but not for an approval
task, which determines progress in a different way) and enter a number. The
measuring bar expands to a comparable level. For approval tasks, this field is
read-only.

Forecast/Actual For tasks in the pending state, this field represents the Forecast Start date.
Start Forecast Start dates are in italicized font. After you change a task from Pending to

Active, this field represents the Actual Start date. Actual Start dates are in regular
font.

In edit mode, use the pop-up calendar to select a date and time.

Forecast/End For tasks in the pending state, this field represents the Forecast End date.
Forecast End dates are in italicized font. After you change a task from Active to
Finished, this field represents the Actual End date. Actual End dates are in regular
font.

In edit mode, use the pop-up calendar to select a date and time.
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Field Description

Forecast/Dur. The duration of the task, in days, hours, and minutes.

If you enter both start and end dates, the system automatically calculates a value
for this field (the Forecast/End date minus the Forecast/Actual Start date).

Actual Effort The actual effort it took to complete the task, as opposed to calendar duration.
Effort is measured in days, hours, and minutes.

Anchored Dates Indicates whether the task is anchored. If a lock appears in this field, the task’s
dates are anchored.

To specify a fixed date for a task, click the column, then select Anchored from the
pull down menu. The task date cannot move even if the dates of the tasks it is
dependent on change.

If a dependency is not met, the dates in conflict appear with a different icon and in
a different font.

For example, suppose task 2.2 is dependent on task 2.1. If the target end date of
task 2.1 is after the target start date of task 2.2, both the target end date of 2.1
and the target start date of 2.2 appear in red, if you anchored the date for task 2.2
by selecting the lock icon in the Anchored Dates column.

Schedule Through Indicators for which dates to use when determining task dates. The following
options are available.

• Business: indicates this task includes only standard, non-holiday, non-
weekend dates. This is the default for all tasks.

• Weekends: indicates this task includes weekends. The system includes
weekends when it calculates dates for this task.

• Off.: indicates this task includes system-wide non-work time that has been
defined. The system takes into account these times when it calculates dates
for this task.

• All: indicates this task includes all dates. No dates are ignored when dates
are calculated for this task.

Target Start The targeted start date of the task. In edit mode, use the pop-up calendar to
select a date.

Target End The targeted end date of the task. In edit mode, use the pop-up calendar to select
a date.

Target Dur. The actual duration of the task, in days, hours, and minutes. The Target End
minus the Target Start dates.

Target Effort The targeted effort estimated to complete the task, as opposed to calendar
duration.
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Field Description

Milestone Type A task milestone that you choose from a drop-down list. Example options might be
Meeting, Event, and Job Start. Plan administrators set the milestone types that
appear on the list.

For more information on setting up milestones, see the Marketing Operations
Installation Guide.

Member Role(s) A role or roles associated with the task. These can be loaded automatically from
the project template used to create the project, or the project owner can set them
up manually.

When an approval task has a status of In Progress, On hold, or Completed, this
field is read-only.

Members The people associated with the task.

If a workflow task has a role in its Member Role(s) column, when you assign
people to roles, the workflow automatically adds a person in the corresponding
Members column.

You can also add people to the Members column manually, while editing the
workflow.

When you edit the workflow for an approval task, teams are not listed in this field
because a team cannot be the owner of the approval task.

Typically, standard tasks have members.

When an approval task has a status of In Progress, On hold, or Completed, this
field is read-only.

Reviewer Role(s) A read-only field that shows the role or roles associated with an approval task.

These can be loaded automatically from the project template used to create the
project, or the project owner can set them up manually.

Reviewer roles are used to pre-populate an approval process.

Reviewers A read-only field that shows the reviewers associated with an approval task.
Reviewers are used to pre-populate an approval process.

If a workflow task has a role in its Reviewer Role(s) column, when you assign
people to roles, the workflow automatically adds a person in the corresponding
Reviewer column.

Enforce Dep. If this task is dependent on other tasks, determines how strictly the system
interprets dependencies. When this option is selected, the system restricts project
members from updating this task until the tasks it depends on are finished.

Required Whether or not this is a required task. Required tasks cannot be skipped or
deleted and their names cannot be changed.
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Field Description

Task Code A read-only code that identifies each task uniquely within a project. System
integrators use this code to implement custom business logic involving tasks.

Notes Any comments about the task.

Related Topics
• Updating and finishing tasks

• Scheduling work time

NA50001

Workflow toolbar
When the Workflow tab is in edit view, a toolbar appears. You use the buttons on the
toolbar to make changes to the workflow. For example, you can insert and delete tasks,
add a stage, clear all entries, and so on.

The following table explains each button.

Icon Description

Add Task Row. Adds a new people task in the spreadsheet.

Add Approval Row. Adds a new approval task in the spreadsheet.

Click a dependency option

• No dependencies
• In series
• In parallel

This option determines how IBM Unica Marketing Operations behaves when
adding new tasks.

Add Stage Row. Adds a new stage in the spreadsheet. Tasks are grouped in
stages.
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Icon Description

The Tools menu contains the following choices.

• Copy: copies the contents of the selected cells to the clipboard.
• Paste: pastes the contents of the clipboard, beginning at the selected cell.
• Paste Rows After: pastes the contents of the clipboard below the selected

row.
• Mark as...: marks the selected task appropriately. For example, selecting

Mark as Finished changes the status of the selected task to Finished. You
can mark the task Skipped, Finished, Active, or Pending.

• Fill Down/Up: copies a cell’s values to a range of cells.
• Clear: erases all entries in the selected cell or group of cells.
• Clear Column: erases all entries in the selected column.

The date columns have dependents as follows: if you select Clear Column
to erase the Target Start, the Target End column is also erased and vice
versa. If you select Clear Column to erase the Forecast/Actual Start, the
Forecast/Actual End column is also erased and vice versa.

• Clear All: erases all entries in the workflow.

Click to recalculate dependent dates while preserving slack time. Recalculates all
date dependencies based on your changes; leaves any existing slack time
between dependent tasks.

Click to recalculate dependent dates while removing slack time. Recalculates all
date dependencies based on your changes; removes any slack time between
dependent tasks.

Click to undo your last change.

Click to reapply a change you undid with the Undo action.

Move row up. Click to move the selected task or stage upward. If you move a
stage, the associated tasks move with it.

Move row down. Click to move the selected task or stage downward. If you move
a stage, the associated tasks move with it.

Delete row. Click to delete the selected task or stage. Note the following.

• If you delete a stage, all of its associated tasks move up one stage.
• If you delete the first stage, the first task associated with it becomes the stage

for the rest of the tasks.
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Related Topics
• To create an approval process for a workflow approval task

• Managing task dependencies

• To copy tasks in Internet Explorer

• To fill data into a range of cells

NAB0001

To set first column width on workflow
spreadsheet
You can change the width of the first column in the workflow spreadsheet view, and
keep this setting for your entire session. That is, your changes remain after you
navigate to other pages and subsequently return to this tab.

1. Navigate to the Workflow tab of the project.

2. Use the column width control to resize the first column to your preferred width.

3. Click the Layout link in the top right section of the screen.

4. In the Project Workflow Tab Layout dialog, do the following:

a. In the First Column Width section, select the Remember Last Setting radio
button.

b. At the bottom of the dialog, check the Make these the default settings for this
project's workflow tab box.

5. Click Apply and Close to save your changes and close the dialog.

The first column width is now set for this project, for the remainder of your session; no
matter which pages you navigate to, when you navigate back to this workflow tab, the
first column width remains as you set it.

N880001

About the workflow timeline view
The timeline view of the workflow tab presents a view of the project over a period of
weeks or months. To view the project schedule in a timeline view, click the View as

Timeline icon.

You can customize the timeline view by using the Layout link from the workflow tab.
Use this dialog box for the following purposes.

• Select the captions, if any, to appear next to each bar in timeline.

• Choose a weekly or monthly view of the timeline.

• Select the types of dates to view.

If you click the Edit link from the timeline view, the spreadsheet opens for editing.

N890001
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About the workflow process flowchart view
The process flowchart view shows displays the tasks in a network diagram style, as
follows.

• Each task is displayed as a box with a task number and ID.

• Tasks that have dependencies are connected to any tasks they depend on.

• Sequential tasks are displayed on the same line.

• Parallel task are displayed on different lines.

• Independent/orphan tasks are displayed on their own line, with no connections.
N8A0001

Workflow tab layout page
Use this page to set the appearance for both the spreadsheet and timeline views of a
workflow tab.

To hide the Spreadsheet Layout or Timeline Layout section, click the icon next to
the title. To view a hidden section, click the icon.

Spreadsheet layout section
Field Description

Columns Check a column to display, or uncheck to hide.

Preset Column Click a link to select one of a preset group of columns to display.
groups • All: default setting; all boxes checked (all columns displayed)

• Targets: hides Status, % complete, and Actual date columns.
• Actuals: hides Target Dates/Effort and Member/Reviewer roles columns.
• All dates: displays all columns related to target and actual dates.
• Responsibility: displays columns related to who is assigned to complete the

tasks.

First Column Width Select one of the radio buttons.

• Remember Last Setting: When viewing the workflow spreadsheet, you may
adjust the first column width to see more or less of the task names.

• Exactly: Select this button and enter a number to set the column to an exact
width in pixels.
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Timeline layout section
Field Description

Time Scale The increment of time used for measurement. Select either Weeks or Months.
The default setting is Weeks.

Bars Represent The bars in the timeline view indicate durations. You can choose to display either
Forecast/Actual dates, Target dates, or both. The default is to display both.

Bar Captions By default, the bars do not have captions. Select one of the choices from the drop
down menu to display certain information as bar captions. For example, you can
have the task name or milestone type display as a caption.

First Column Width See the First Column Width description for in the Spreadsheet Layout section
above.

Buttons
Button Description

Make these the de- Check this box to keep your settings as the default for the workflow. This ensures
fault that whenever you navigate away from and back to this tab, your display setting

will not change (until the next time you make changes and check this box).

These are the defaults for all users, for this workflow, until someone changes
the defaults.

Apply and Close Click to apply your changes and close the dialog.

Apply Click to apply your changes. Your changes display on the workflow, and the dialog
remains open for further editing.

Restore Defaults Restores all settings to their default values, undoing any customizations you have
made.

Cancel Click to close the dialog without changing any settings.

Related Topics
• To set first column width on workflow spreadsheet

N8B0001

Scheduling work time
Plan offers the following settings to help effectively manage and allocate resources.

• Specify non-work time: allows your organization to define a set of dates that, by
default, are not included when the system calculates dates for a task.
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• Include weekends in work time: by default, weekends are not included when
calculating task dates and durations. However, you can override the default to
schedule certain tasks through weekends.

Note that by default, tasks do not include weekends nor non-work dates when
calculating their start or end dates.

To view a list of defined non-work dates, click Non-working Business Days from the
Administration page.

When viewing the IBM Unica Marketing Operations calendar, any day that has been
specified as non-work time is indicated by a gray X in the background (or by a gray-
shaded column in the timeline view). Additionally, the name of the non-work time (for
example Labor Day) displays when you mouse over the date.

Related Topics
• About non-work time

• About including weekends

NAC0001

About non-work time
If there are days where no work is typically done by employees, you can set these dates
as non-work time in IBM Unica Marketing Operations. Marketing Operations supports a
set of system-wide non-work time, separated into user-defined types.

For example, assume you have the following non-work dates set in Marketing
Operations.

Category Dates

Corporate Holiday 1/1/2006, 7/4/2006, 12/25/2006

State Holiday 4/15/2006, 10/3/2006

Corporate Off-site 8/15/2006

After you define a set of non-work time, you can elect whether or not to schedule work
on these days, for each project and its tasks.

If the active time for a task includes any non-work time, its end date is pushed out by an
extra day for each of these dates. For example, assume 7/4/2006 is defined as non-
work time. If Task 1.3 is scheduled to start on 7/3/2006, and has a duration of 3 days,
its end date is 7/7/2006; work is not scheduled for 7/4, since it is defined as non-work
time.

For any task, you can choose to ignore the non-work time; if so, the workflow includes
any non-work time as normal work days. So, if you choose to ignore non-work time for
Task 1.3, its end date becomes 7/6/2006.

NAD0001
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About including weekends
For certain tasks, you might need to schedule work to proceed on weekends. For
example, print shops often work 24 hours a day, 7 days a week, so if you have tasks
that go to a print shop, you can have these tasks take into account weekend days.

For example, suppose you have a task called “Print Brochures at print shop.” This task
might start on Friday 6/15, and have a duration of 3 days. If you choose to include
weekends for this task, its end date is end of business Monday, 6/18. If you choose not
to include weekends for the task, it ends on end of business Wednesday, 6/20.

NAF0001

Work and non-work time settings
By using the Schedule Through indicator on the workflow, you have many options for
scheduling tasks. You can schedule tasks in any of the following manners.

Flags Behavior

Bus. (Business) Non-work time and weekends are excluded from task scheduling.

This is the default setting for all tasks.

Wkd. (Weekends) The task is scheduled to include weekends, but not system-wide non-work
time.

Off. (Days off) Weekends are excluded from task scheduling, but work is expected to be
done during other non-work time.

All (All calendar days) The task is scheduled to include all days.

The Schedule Through column is a planning and targeting tool; it should not be
altered once actual dates and times have been logged on a task. Doing so may
overwrite the actual dates and times.

N8C0001

To edit the the default workflow
When you create a new project, the system guides you through a wizard based on the
template you selected. When you finish with the wizard forms, you might need to
customize the default workflow provided by the project's template. The ability to
customize default workflows is controlled by your user permissions.

When you open the Workflow tab in edit mode, if any of the toolbar buttons are disabled
or the values in the columns are read-only, it means that you do not have the
appropriate security permissions to edit the workflow.

1. Open the project that has a workflow to set up and open the Workflow tab.

This tab displays the workflow as designed in the template.
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2. Click the Edit icon ( ).

3. Edit the names listed in the first column to change the default task and stage names
to specific tasks and stages.

Stages are the headings in bold that group the tasks together.

4. Add any stages or tasks, as necessary.

• Click the Add a Stage Row icon ( ) to add a stage.

• Click the Add Task Row icon to add a standard task.

• Click the Add Approval Row icon to add an approval task.

5. Enter target or forecast actual dates, depending on how you want to use the
schedule.

• You can enter start dates, end dates, and duration for a task. Enter any two, the
third value is calculated automatically. For example, if you enter a target start
and a target end date, the system calculates the duration.

• You are not prevented from picking any dates that are not in agreement with the
per-task options for non-work-time. For example, even if a task is not scheduled
to include weekends, you can still pick a Sunday as an end-date for the task.

6. To specify that a task is a milestone of some sort, for example, a drop date, select
the Milestone Type column and select a milestone that appears in the drop-down
list.

Your administrator can set the milestones that appear in the list.

7. Select members or roles to assign the task to in the Members and Reviewers
columns .

8. Enter any notes about the task in the Notes section.

9. Perform one of the following actions.

• Click Save to save your changes and remain in edit mode. If you are making
extensive edits, it is a best practice to click Save occasionally to prevent any
loss of work.

• Click Save and Finish to save your changes and return to view mode.

• Click Cancel to undo any changes and return to view mode.

Related Topics
• To add a stage or task

• About team alerts

• About schedules

N8D0001
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About adding a stage or task
To add a task or stage to a workflow, your security role must grant you the permission
named Add/Edit/Delete Tasks/Approvals, Dependencies and Targets for the
template you select. If the Add button is missing from the toolbar, contact your
administrator about obtaining the appropriate access rights.

Note the following about stage and task rows.

• When adding a stage or task, if you place the number of the task in front of the task
name, the task is inserted in the place that the number indicates.

For example, if you enter 2.3 Have team meeting anywhere in the task list, the
task is placed under the task labeled 2.2 and the numbers of subsequent tasks
shifts, so that the step previously labeled 2.3 is now 2.4.

• You can add a stage or task anywhere in the list and then use the up and down
icons on toolbar to move the stage or task to the appropriate place in the list.

• There are several options for managing dependencies on tasks as new rows are
added and existing rows are removed.

• After you create an approval from a workflow task, you can only edit the approval
itself; you cannot edit the corresponding task in the workflow.

If you try to edit the approval from its workflow task, you receive an error stating the
task row is locked. You must navigate to the approval to update any of its fields.

Related Topics
• Managing task dependencies

NB00001

To add a stage or task
Before adding a stage or task, open a workflow in edit mode.

1. In the workflow, select the stage or task above the place to insert the new stage or
task.

2. Add a stage, approval task, or standard task.

• Click the Add Stage Row icon ( ) to add a stage.

• Click the Add Task Row icon ( ) to add a standard task.

• Click the Add Approval Row icon ( ) to add an approval task.

3. Optionally, to make a task dependent on another task, enter the number of the task
it is dependent on after the task in parentheses ( ).
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For example, suppose task is named Deliver draft to vendor. To make this
task dependent upon task 1.3, name the task 2.5 Deliver draft to vendor
(1.3).

4. When you have finished editing the workflow, save your changes.

The stage or task is added to the workflow, after the insertion point.

If the date of one task changes, it changes the dates of all the dependent tasks. For
example, if task 2.2 Setup Milestone Schedule is dependent on task 2.1 Kickoff
Meeting w/Creative Team, enter (2.1) after you enter, Setup Milestone
Schedule.

If a task has more than one dependency, separate the task numbers with commas. For
example, use 2.2 Setup Milestone Schedule (1.1, 2.1).

NB10001

To add a stage or task below a locked task
Before adding a stage or task, open a workflow in edit mode.

If you select a locked task, the insert task/stage links do not work. To add a task directly
below a locked task, you must perform the following steps.

1. Navigate to the workflow page to change and click Edit.

2. Select any task row that is not locked.

3. Add a stage, standard task, or approval task.

• To add a stage, click the Add Stage Row icon .

• To add a standard task, click the Add Task Row icon .

• To add an approval task, click the Add Approval Row icon .

4. Change the number of the task or stage so that it directly follows the locked task it
should follow.

For example, suppose the locked task is 2.5 Review copy - informal (2.3) .
You would set the number of the new task to 2.6. Once you finish naming the task,
the system moves it so it is after task 2.5.

NA90001

To create an approval process for a workflow
approval task
From the spreadsheet view of a workflow, you have the option of adding an approval
process to a particular task. A task with an approval process attached to it has the
approval icon ( ) in the Linked Step field.

1. Navigate to the Workflow tab of the project that contains the approval task.
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2. Still in view mode, click the name of an approval task. The Start Approval dialog
appears as a popup.

3. Complete the details for the approval.

4. Click one of the following to complete the process.

• Send Approval: saves the approval and submits it (changing the status from
Not Started to In Progress).

• Save for Later: saves the approval process and sets the status to Not Started.

• Cancel: discards the changes you have made in the dialog, and does not create
a new approval.

The dialog closes and the system displays the workflow tab where you initiated the
approval process.

After you create an approval from a workflow task, you can only edit the approval itself;
you cannot edit the corresponding task in the workflow.

Related Topics
• To skip an approval task

• New/edit approval page

NB40001

About editing a stage or task
If you change the number for a task or stage, the task is inserted before the row
matching the new number.

For example, assume the stage order as shown here.

1. Planning

2. Collateral Design

3. Lead Generation

4. Show Setup-to-Breakdown

5. Marketing Review

If you edit task 5, Marketing Review, changing its number to 3, the new order is as
follows.

1. Planning

2. Collateral Design

3. Marketing Review

4. Lead Generation

5. Show Setup-to-Breakdown

Now suppose you edit task 2, Collateral Design, changing its number to 4. The new
order is the following.
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1. Planning

2. Marketing Review

3. Collateral Design

4. Lead Generation

5. Show Setup-to-Breakdown

To move a task or stage to the end, give it any number higher than the final task or
stage. For example, to move stage 2, Marketing Review to the end, change its number
to 6 or higher.

N8E0001

Updating and finishing tasks
When you create a task, or open a new workflow with existing tasks, the status of the
task or tasks is Pending. As project members work on tasks, they update the status to
indicate the current progress.

To place a task into any status, ensure the workflow is in edit mode, and click the
Status column of the task, then choose the appropriate status from the drop-down list

Status Description

Pending Indicates a task has not yet started. When you create a task, it defaults to
the pending state. The pending state is symbolized by a blank status field.

Active Indicates a task is in progress. Symbolized by the icon. You can also type
A to place a task in the active state

Skipped Indicates a task has been skipped. Symbolized by the icon. Skipped
tasks are tasks for which members no longer do work. Any dependencies of
this task are also disregarded. You can also type S to place a task in the
skipped state.

Finished Indicates a task has been completed. Symbolized by the icon. You can
also type F to place a task in the finished state.

Note the following behavior.

• If you enter 100 in the % Complete column for a task, the status is updated to
Finished.

• If you enter 0 in the % Complete column for a task (if it was previously finished), the
status is updated to Pending.

• If you enter any number from 1 to 99 in the % Complete column for a task (if it was
previously finished), the status is updated to Active.
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• If you mark the status for a task as Skipped, all of the dates for the task are
cleared. Until you hit Save (or Save and Finish), you can retrieve the dates by
canceling out of the editing session. However, once you save the spreadsheet with
the dates cleared, you cannot retrieve them.

NB50001

Approval tasks
Once you create an approval task, you cannot change its status from the workflow tab.
The status of an approval task is automatically set depending on the status of the
approval itself.

NB20001

To skip an approval task
This topic describes how to skip an approval process from a task on the Workflow tab.

1. Navigate to the Workflow tab of the project that contains the approval to skip.

2. Click the name of the approval task to skip. The Approval dialog appears as a
popup.

3. Click Status > Cancel Review.

4. Close the dialog.

The approval task is crossed out and can no longer be accessed. If necessary, you can
also delete the approval.

Related Topics
• To delete an approval

NB70001

To skip multiple tasks
You can perform this task when you have been assigned tasks for one or more projects.

1. Open the Tasks list page to view all of your assigned tasks.

2. Select the checkbox for each task to skip.

3. Click Skip Selected.

4. In the confirmation dialog box, click OK to skip the selected tasks, or Cancel to
return to the list page without making any changes.

Any tasks you selected and skipped are removed from the Tasks list page, and their
status is changed to Skipped.

NB80001

To complete multiple tasks
You have been assigned tasks for one or more projects.

1. Open the Tasks list page to view all of your assigned tasks.
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2. Select the checkbox for each task you wish to complete.

3. Click Complete Selected.

4. In the Complete Selected Tasks dialog box, select one of the radio buttons:

• Leave all dates as they are. The tasks are marked as complete, but no end
dates are modified.

• Set all actual end dates to now. Each selected task is marked complete, and
its actual end date field is set to the current date and time.

5. Click Continue to complete the selected task or tasks, or Cancel to return to the list
page without making any changes.

Any tasks you selected are removed from the Tasks list page, and their status is
changed to Complete. Additionally, their end dates are set, if you selected that option.

N500001

To add an attachment to a task
To add attachments for a task, a project owner must enable adding attachments for the
task. The following users can add or remove task attachments.

• Task owners only can add attachments to their tasks.

• Task owners and users with the Delete Attachment security permission for projects
can delete task attachments.

Adding attachments to tasks is similar to adding attachments to other objects (such as
programs). However, note the following behavior that is specific for adding attachments
to tasks.

• You cannot use markup on task attachments

• There is no versioning for task attachments: uploading a new version overwrites the
existing version of the attachment.

• It is possible to have multiple task attachments with the same name for the same
task. This can occur if multiple owners of the task each upload a file with the same
name. You can differentiate the files by the the user who created the attachment.

• You can add and remove attachments no matter the state of the task. That is, even
if a task is marked complete or skipped, you can still add and remove attachments.

• The Attachments tab for projects is divided into two sections: one for files attached
to the project's tasks, and one for files attached directly to the project.

• If a task owner adds task attachments, and later the project owner sets the Enable
Task Attachment flag to false, nobody would be able to add or remove attachments
from the Post Task Update dialog. However, task attachments for the project could
still be removed from the project attachment tab.

1. Navigate to the task to which you would like to add an attachment.

Click the task from a project workflow or from the Tasks list page.

The Post Task Update dialog box opens.

104 IBM Unica Marketing Operations - User's Guide



To add roles to tasks

2. Click the Attachments tab.

The tab displays any attachments that already exist for the task.

3. In the File to Attach field, select From My Computer , From the Asset Library, or
URL.

4. Do one of the following:

• Click Browse to attach on your computer. When the dialog box appears,
navigate to the file you want to attach, and click Open.

• Click Browse Library to attach a file in an asset library. Click the library that
contains the file you want to add and use the tree in the left pane of the screen
to navigate to the folder and then the asset that you want to attach. Click Accept
Asset when viewing the asset in the right pane.

• Enter the URL in the field provided.

5. Add any comments about the attachment.

6. Click Add More to display an additional set of fields for each additional attachment
you want to add.

7. After you have added all your attachments, click Save and Return to close the
dialog box.

Any new attachments are added to the Attachments tab for the task.

Related Topics
• To add an attachment to an object

N8F0001

To add roles to tasks
Normally, when you create a project, the workflow automatically contains member and
reviewer roles for all tasks if the template selected contains this information.

However, you may occasionally need to assign roles to workflow tasks that differ from
the template settings.

1. Navigate to the Workflow tab of your project.

2. Click Edit ( ).

3. Select the Member Role cell for the task you wish to assign.

4. Click the turndown icon ( ) to expand the list of available roles, and select the one
to assign to this task. Repeat this step until you have assigned all the tasks.

If you have permission to View people tab and Edit team members and roles,
then all system users, system teams, and member roles are available in the
Members and Member Roles dropdowns even if they were not previously included
on the people tab; adding a new user to the project workflow will automatically add
the user to the people tab.
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By contrast, Reviewer and Reviewer Role cannot be edited directly on the workflow
spreadsheet. Add new reviewers and reviewer roles on the Approval popup.

5. Save your work.

Related Topics
• To add a role

NBA0001

About roles, people, and approval tasks
You can assign order to roles when you add them to an approval task in a workflow.
This order is saved if you save the workflow as a template.

When you add people to the roles and then assign work, the spreadsheet lists the
people alphabetically by their name. When you create an approval from the task, the
reviewers are ordered according to their role order. However, in the To field of the
approval, they are still listed in alphabetical order. If more than one user is in a role,
those users are sorted alphabetically by their name.

Related Topics
• Example ordering of reviewers for an approval task

NBB0001

Example ordering of reviewers for an approval
task
Assume your workflow has approval task 1.5 Review printed Brochure. For reviewer
roles, you have added the roles in the following order.

1. Legal reviewer

2. Marketing manager

3. Content reviewer

If you save this workflow as a template, and then later create a project using this
template, this order is preserved.

Now assume you assign people to roles as follows.

1. Legal reviewer: Nancy Chan

2. Marketing manager: Brian Doyle, Andy Proctor

3. Content reviewer: Elaine Jones, Mark Davis, Brad Johnson, Wilson Alverez

When you click task 1.5 and create the corresponding approval, the reviewers are listed
in the following order, alphabetically within their role

1. Nancy Chan

2. Andy Proctor

3. Brian Doyle
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4. Brad Johnson

5. Elaine Jones

6. Mark Davis

7. Wilson Alverez

To list the reviewers in a different order, move them up and down within the approval.

Related Topics
• About roles, people, and approval tasks

N900001

About copying and pasting tasks
When copying and pasting tasks, note the following.

• For copying, you must select a continuous range of tasks, rather than selecting
multiple, disconnected tasks (by using Ctrl+click).

• If you do not insert enough blank tasks to correspond to the ones you are copying,
existing tasks are overwritten.

• To paste rows at the insertion point, you can click Paste from the Tools menu or
press Ctrl+V. To paste rows after the selected row, you must click Paste Rows
After from the Tools menu.

• You can copy the status from one approval task and paste it in another approval
task status column (but not in a people task status column).

• If you copy the status from one approval and paste it in a new row of an approval
that is not saved, the Not started status is pasted, regardless of what you copied.

NBC0001

To copy tasks on Macintosh/Safari
Copying and pasting tasks on a Safari browser is slightly different than the procedure
described for Internet Explorer. The following procedures describe the steps involved.

When selecting multiple task rows on the Macintosh using the Shift key, it may be
difficult to determine which rows are selected by their appearance. Take extra care
to make sure you know which rows you have selected.

1. Select and copy tasks.

a. Select the task, tasks, or the block of cells to copy.

b. Select Copy from the Tools menu or press Ctrl+C. A "Text To Copy" dialog
appears, with the information from your selection already highlighted.

c. Press Apple+C to copy all text in the dialog to your clipboard.

d. Click Continue to close the dialog.
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You can now paste the information to another application or to another area on your
spreadsheet.

2. Paste selected tasks.

a. Copy information from another application or from another area on your
spreadsheet.

b. In Plan, select the destination row, rows, or block of cells in the workflow.

c. Select Paste from the Tools menu or press Ctrl+V. A "Text To Paste" dialog
appears, containing an empty text box.

d. Press Apple+V to paste your clipboard information in to the text box.

e. Click Continue to paste that information into the spreadsheet at your previous
selection location.

NAA0001

To copy tasks in Internet Explorer
You can copy a continuous group of tasks to another place in the same workflow or into
the workflow for another project.

1. Open the project that has the tasks to copy and click the Workflow tab.

2. Click Edit.

3. Select the first source task. If this is the only task you are copying, skip to step 5.

4. Mouse over the final source task, then Shift-click over this task. A range of tasks you
selected is highlighted.

5. From the workflow toolbar, select Copy from the Tools menu item to copy the
selected task or tasks.

If you are pasting the tasks into the same workflow, skip to step 7.

6. If you are copying the tasks to another project workflow, navigate to the destination
workflow tab, and open it for editing (click its Edit link).

7. Optionally, insert enough blank rows below the destination to act as placeholders for
the tasks you are copying.

For example, if you are copying 6 tasks, make sure there are 6 blank rows available.
If you do not create the necessary rows, existing tasks below the insertion point are
overwritten.

8. Click the destination task.

9. From the workflow toolbar, select Paste from the Tools menu item to paste the
task.

The source tasks are placed in the workflow, starting from the selected destination task.

Related Topics
• To add a stage or task

N910001
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To fill data into a range of cells
You can copy a value in one or more cells to a group of continuous cells above or
below the selected cells. This can greatly reduce the data entry time for adding
duplicate information. For example, assume you have a workflow that contains ten
consecutive tasks all having the same target start. target emd. target duration, and
target effort.

You can fill in this data for the first task, then copy the values to all the other tasks, by
selecting these four columns for all ten tasks and using Fill Down.

1. Open the project that has the task values to duplicate, and click the Workflow tab.

2. Click the Edit icon ( ).

3. Select the first cell.

4. Mouse over the final cell, then Shift-click over this cell.

A range of cells you selected is highlighted.

You must select a continuous range of cells, rather than selecting multiple,
disconnected cells.

5. Click the Tools icon ( ), and select Fill Down or Fill Up.

• Fill Down copies the values in the top-most cell (or cells) to all the other
selected cells, including the bottom-most.

• Fill Up copies the values in the bottom-most cell (or cells) to all the other
selected cells, including the top-most.

All the selected cells now contain the same value.

Remember to save the workflow to keep your changes.
N920001

To print the Workflow tab
You can print all information found on your project Workflow tab, or select certain
columns of information to print.

1. From the Workflow tab, click the Print icon ( ).

A window appears with a list of columns from which you can choose to print. By
default, all columns are selected.

2. Clear any columns you do not want to print.

By default, the Shrink to Fit Landscape Page Width box is checked.

3. Optionally, clear the Shrink to Fit Landscape Page Width checkbox to print the
columns at a size of 100%.
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If you keep this option checked, all selected columns print on a single page. If you
use this feature, change your printing preference (for this print job) to landscape.

4. Click Print Selected Columns.

5. Click Print.

6. Select your printer and printer options, then click Print to print the selected workflow
columns.

Choose landscape mode for best results.

7. In the preview window, click Close to close the print preview.
N930001

Post task update dialog box
This dialog appears when you click a workflow task in view mode. Use this dialog as a
quick alternative to editing the entire workflow, when you only need to update a single
task. From this dialog, you can update certain items, add task attachments, as well as
adding comments to the revision history of the project .

The Post Task Update dialog box contains two tabs, Status and Attachments.

Status
The Status tab contains the following fields.

Field Description

Owner(s) The task owner or owners. At the task level, project members are referred to as
task owners.

That is, in the workflow spreadsheet, you use the Members column to add people
to a task; this column refers to project members. When you open the task in the
Post Task Update screen, these members are listed as Owners (which refers to
task owners).

Target Dates The forecast or actual start and end dates, as well as the duration for the task.
You can edit either or both of the date and time selectors to update the
information.

Status The status of the task. Edit this field by selecting a value from the field’s pull down
menu.

% Complete The current progress for the task. Enter a number between 0 and 100 to change
the value.

Actual Effort The effort for the task, measured in days. Enter a value to update the field. This
field can contain partial days, for example, 3D-2H-0M
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Field Description

Forecast /Actual The Forecast/Actual begin and end dates and times for the task. You can edit
date and time either or both of the date and time selectors to update the information.
fields

Begin and end dates are mandatory; you receive a warning if you attempt to
save without entering values for both fields. Additionally, the system checks to
ensure the end date is not earlier than the begin date.

Comments Displays comments for the task. You can enter text to update the field.

These notes go in to the revision history of the project and any notifications that
may be sent about the task.

Enable Task At- A flag to determine whether or not the task can contain attachments. This field is
tachments visible to project owners only. Check the box to allow the task to contain

attachments.

Make sure you close the dialog box by clicking either Save and Return or Cancel; if
you do not use one of the buttons to close the dialog box, the task may remain
locked, and no one else can edit it.

To change the state of a finished task back to active, you must set both the Status
to Pending, and the % Complete field to an integer less than 100. If you do not
change both fields, after you close the dialog box, the task is still marked as
completed.

Attachments
The Attachments tab contains the following fields.

Item Description

Current attach- The top portion of the page describes the current attachments of the task. It
ments section contains three columns of information for each attachment:

• File: Contains a link to the attachment file and describes the file type and size.
• Description: Contains revision history and description for the attachment.

The name of the user who added the attachment is listed. This is
important, as the creator differentiates attachments with the same name
for the same task.

• Actions: Contains links for deleting the attachment or for sending the
attachment via email.

File to Attach Contains a drop-down menu that allows you to specify the source of the file to
attach.

Browse Use this button to browse your computer or the asset libraries for the file to attach.
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Item Description

Comments Use this text box to add any comments for the attachment.

Attach Selected Use this button to attach the selected file or URL.
File

Related Topics
• Workflow tab fields

N940001

Managing task dependencies
IBM Unica Marketing Operations has several options for managing dependencies on
tasks as new rows are added to the spreadsheet and existing rows are removed.

• Normal: no dependencies are automatically created. If you need dependencies for
the new tasks and stages, create them manually.

• Sequential: insert the new task in an existing chain of tasks.

• Parallel: insert a new task branch parallel to an existing chain of tasks.

Inserting tasks in sequence
Insertion in sequence makes the new task dependent on the task before it, and then
makes all items that were dependent on that task dependent on the new task.

You insert a task in sequence when it can only start after the previous task has
completed. For example, in the figure below, if task X cannot be worked on until task B
has been completed, you insert task X in sequence.
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Inserting tasks in parallel
Insertion in parallel makes the task dependent on the items (tasks or stages) that the
task before it was dependent on, and makes the items dependent on the previous task
dependent on the new task as well.

You insert a task in parallel when it can be worked on at the same time as another task.
For example, in the figure below, if task X can be worked on simultaneously with task B,
you insert task X in parallel.

Deleting tasks
Deleting a task removes the selected task from the chain, but re-links the two remaining
segments of the chain together so that it is one continuous chain again.

When a task is deleted its dependents are made dependent on its dependencies before
the deletion takes place. This preserves all sequential chains of dependencies.
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Default and "last used" modes
To make adding a task as simple and consistent as possible, IBM Unica Marketing
Operations provides the following behavior.

• The default mode is "in series;" when you begin an editing session, this is the
insertion mode.

• There is a "last used mode," remembered for each editing session. Once you select
a mode from the menu, this mode is used each time you add a task during the
remainder of your session.

For example, to add several tasks in parallel, you only need to select the in parallel
mode once; then every time you insert another task, the system inserts it in parallel,
unless you explicitly select another mode.
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7 Approvals

■ Approvals
■ About approvals
■ Reviewing attachments in Unica Marketing Operations
■ Approval process workflow
■ To respond to an approval
■ New/edit approval page

N120001

Approvals
An approval allows you to streamline and track the process of having your work
reviewed and approved. This allows many users to review work in parallel or in an order
that represents your business processes. Reviewers (or approvers) can electronically
mark up content submitted for review. IBM Unica Marketing Operations then records
approvals and denials for audit purposes. You can tie approvals to a project or they can
exist independently from any project.

Related Topics
• About approvals

• Approval dates

• Due dates for approvals

• Approval views

N240002

About approvals
An approval is an item or group of items that approvers review and respond to, either
by approving, suggesting changes, or denying. IBM Unica Marketing Operations
contains two types of approval processes: stand-alone approvals and approval tasks in
workflows.

The approval process is the lifecycle of an approval. It is set up by a project owner,
and contains all the details about what to approve, who should approve, and when
people should approve. Typically, an approval goes through four stages: it is created,
submitted, active and completed. The system notifies the required approvers by sending
alerts and emails. The approvers can pose comments or questions before they make a
decision. And when the approval is completed—either approved or denied—the
approval owner or reviewer gets notified about the results.

Version 8.5.0 115



7 - Approvals

Note that you can create an approval process without any approval items, and
approvers can still respond to it.

The following are valid approval statuses.

• Not Started: an owner creates an approval, beginning the approval process.

• In Progress: when ready, an owner submits the approval, changing its status from
Not Started to In Progress.

While the approval’s status is In Progress, approvers review it, comment on it, and
respond. Additionally, if the approval is linked to a task in a workflow, its progress is
tracked in the % Complete column.

• On Hold: an owner can temporarily stop an approval, if necessary, changing the
approval’s status to On Hold.

• Cancelled: an owner can cancel the approval, changing its status to Cancelled.

• Completed: the owner marks the approval as finished, changing its state to
Completed.

An approval owner is the person who created the approval. Normally, the owner has
all the capabilities associated with the approval (such as being able to delete it or
change its status), although this can be changed depending on the security policy
associated with the approval.

An approver is someone who has been designated to review a particular deliverable
and approve or deny it. There are several ways an approver can be designated:

• add the person directly to the approval process itself, or

add the person as a reviewer to the project, and this may auto-populate approval
processes created from the workflow, depending on how your administrator has set
up the project templates.

A required approver is an approver who has been designated as required, as opposed
to optional. For an approval process to be marked complete, all required approvers
must respond to the approval.

An approval round indicates how many times an approval has been submitted. The
first time an approval owner submits an approval, its round number is 1; the system
increments the round number each time the approval is resubmitted.

NC00001

Stand-alone approvals
Stand-alone approvals exist apart from any projects or other business process. They
are not connected to any workflows and their security permissions are configured
differently.

To create a stand-alone approval, select Operations > Approvals and click the Add

Approval Process icon ( ).
NC10001
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Approval tasks
An approval task is an approval process that is connected to a step in a workflow. An
approval that is linked to an approval task in a workflow can be updated in either the
workflow or in the approval itself. Additionally, changes made to one are automatically
propagated to the other.

If you want the approval process to be connected to an approval task in a workflow,
create the process from the Workflow tab of the project. To add an approval task to a
workflow, your security role must have the Add/Edit/Delete Tasks/Approvals,
Dependencies and Targets setting enabled.

An approval created from a workflow task may already have some information filled in,
based on the approval task it represents.

N250001

Approval dates
When you create an approval from a workflow task, note the following behavior
concerning the Forecast/Actual and Target dates for the approval.

• If the task contains a date in either the Target End Date or Forecast/Actual End
Date field, the system automatically copies the date into the approval’s Target Due
Date.

If the task contains dates in both fields, the Forecast/Actual date is copied to the
approval.

• If you modify the date in the approval’s Target Due Date field, the Forecast/Actual
End Date in the corresponding workflow approval task is updated with the new date.

Note the following about the way IBM Unica Marketing Operations calculates duration
when the project owner enters the start and end dates for an approval from a workflow
task.

• If the duration is less than what is specified in the approval for each approver, an
equal amount of time is deducted from each required approver.

• If the duration is more than what is specified in the approval for each approver, an
equal amount of time is added to each required approver.

• If the approver has already responded, the duration for that approver is not
adjusted. The durations of the remaining approvers are adjusted if possible; if this is
not possible an error message is displayed.

• If for any reason an approver's duration can not be adjusted automatically, an error
message is displayed requesting different values.

• The Forecast/Actual Duration field in the workflow is overwritten with the sum of
approver durations if an approver's duration is changed and saved.

• Marketing Operations automatically calculates the approval start date if the
Forecast/Actual duration and Forecast/Actual end date are changed .

N260001
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Due dates for approvals
Approval due dates are determined differently for required reviewers than they are for
optional reviewers. For optional reviewers, the due date is the date the approval was
submitted plus the duration specified for the reviewer, regardless of the reviewer's
sequence in the process.

Due dates for required approvers do not include durations for optional revieweres and
are calculated as follows:

Approval submission date + sum of previous required approvers' durations =

current approver's due date

IBM Unica Marketing Operations - User's Guide

For example, if there are three required approvers, each approves in sequence, and the
duration for each is one day, then the due date for the third approver is three days after
the approval was submitted.

The durations for approvers working in parallel - that is, they have the same sequence
number in the process - is calculated as follows.

• The duration is counted once; it is not summed.

• If the durations have different lengths, the longest duration is used.

For example, consider an approval process configured as follows.

• Approval submission date: 25 August 2008 03:00 PM

• Target due date: 30 August, 2008 05:00 PM

• Four approvers:

Approver Sequence Duration Required?

A 1 01D-00H-00M yes

B 2 01D-00H-00M yes

C 2 01D-00H-00M yes

D 3 01D-00H-00M yes

The due dates for the approvers would be.

• Approver A: 26 August 2008 03:00 PM

• Approver B: 27 August 2008 03:00 PM

• Approver C: 27 August 2008 03:00 PM

• Approver D: 28 August 2008 03:00 PM

Now, if the duration for Approver C was two days, then the due date for C would be 28
August and the due date for D would be 29 August. That is, there would be two days
between Approvers A and D, not three.
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While calculating dates, the system-wide setting for non-work time is considered.
Depending on the value of this setting, weekend and/or other non-business days
could be included in the calculation.

Related Topics
• About non-work time

• Approvers

N270001

Approval views
IBM Unica Marketing Operations organizes approvals in views as described in the
following table.

View Description

All Approvals Lists all approvals. It also contains links to the other approval views. Additionally, if
there are any saved searches for approvals, they appear as links on this page.

My Active Approv- Lists any active approvals to which you can respond. It also contains a link to the
als Approvals Pending My Response view. This is the default view.

Approvals Pending Lists all the approvals waiting for your response. This is a subset of the My Active
My Response Approvals view. It includes any approvals that are waiting for your approval (that

you have not responded to already). You can also see approvals pending your
response on the My Tasks page.

All My Teams Ap- Lists all approvals assigned to members of your team.
provals

All My Teams Un- Lists all approvals that have been assigned to your team but that have not yet
Assigned Approv- been assigned to an individual team member by your team leader.
als

NBD0001

Reviewing attachments in Unica Marketing
Operations

The markup tools play an important role in the review process, enabling you and others
to add feedback directly on top of an attachment. IBM Unica Marketing Operations
allows users to mark up attachments for plans, programs, projects, and marketing
objects in either of the following ways.

• Marketing Operations can open a PDF document in Adobe Acrobat. Users can use
all of Acrobat's markup features to make comments, then save the comments in
Marketing Operations.

• Marketing Operations can be set up to use native markup functionality, which allow
users to mark up the following file types.
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• PDF (each page of the PDF is converted to an image for markup)

• GIF

• JPG (RGB only, not CMYK)

• PNG

• BMP

• HTML pages and hosted web sites

During installation, an administrator chooses which type of markup to enable throughout
the application.

For both types of markup, note the following:

• You access the IBM Unica Marketing Operations markup tool by clicking the
View/Add Markup link for an individual approval item.

• Marketing Operations tags markups with the name of the person who made the
comments, so everyone can view all review comments at once, or one reviewer's
comments at a time.

About HTML and native markup
You can upload an entire web site for review. However, the following limitations apply.

• Unica native markup does not support markup on web sites that include or are built
entirely using Flash.

• Pages that require server side processing, such as CGI, ASP, ASPX, CFM, do not
work properly in the markup tool.

• Framed sites are not supported.

As an alternative solution to uploading HTML files, consider a URL to link to externally
hosted content.

Related Topics
• About using Adobe Acrobat markup in Unica Marketing Operations

• About native Unica Marketing Operations markup

• About enabling markup for approval items

• To use markup

• Using Adobe markup on the Apple Macintosh

NC30001

About using Adobe Acrobat markup in Unica
Marketing Operations
If you are using Internet Explorer as your browser for IBM Unica Marketing Operations,
you must set your Internet Explorer preferences to display PDFs in the browser.
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If your Marketing Operations installation is set up to use Adobe Acrobat markup, and
you are working on a Microsoft Windows platform, you must have the
skdSOAPCollabSample.js file in the JavaScripts subdirectory of the directory where
you installed Adobe Acrobat. For example:

C:\Program files\Adobe\Acrobat 6.0\Acrobat\Javascripts

Your IBM Unica Marketing Operations administrator should be able to provide this file if
you do not have it already. It is located in the tools\admin\db directory under the
Marketing Operations installation.

Note the following.

• If you cannot view other approvers' comments, you may be missing the
sdkSOAPCollabSample.js file

• If you run Acrobat before copying this file, you must reboot your computer to use the
markup capability.

Unica does not support using the Save and Work Offline button in Adobe Acrobat.
That is, if you use Save and Work Offline, add markup, go back online, and try to
send and receive your comments, your edits may be lost.

Related Topics
• Reviewing attachments in Unica Marketing Operations

NC40001

About native Unica Marketing Operations markup
The native IBM Unica Marketing Operations markup tool uses the following buttons and
items. All buttons include mouse over help.

If another user is marking up a document at the same time as you, refresh the
browser page to see their comments.

Menu bar
This table describes the items in the menu bar.

Icon Description

Click Add Note button, then drag and drop to add feedback to a specific location
on a page.

You cannot move a note once saved. Each note is fixed to a location that is
important to the context of the feedback and any replies.

You can attach a file to a note.

Use the action links in a note to reply to, update, or delete the note.

Click Add Scribble, then drag and drop to add a free-from "scribble."
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Icon Description

Click the Zoom In to zoom in.

Click the Zoom Out to zoom out.

Click Zoom Reset to reset the size of the page to the original display.

Click Download Original to acquire a copy of the original attachment that you can
save to your local machine.

Click Toggle Annotations to display or hide comments.

Click Help for tips on using native markup.

Click Close Markup Window to close the markup tool.

Annotations List
This table shows the items available in the annotations list. Note that you can sort on
any column by clicking its header.

Item Description

Page filter A drop-down list where you can choose to view annotations for the current page
only, or for all pages in the document. If you select All Pages, you can sort in
ascending or descending order by clicking the heading of the Source column.

Annotations filter A drop-down list where you can choose to view all annotations, only active
annotations, or only archived annotations.

Author filter A drop-down list where you can choose to view annotations from all authors or
only a single selected author. If you select Any Author, you can sort by
ascending or descending order by clicking the heading of the Author column.
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Item Description

Actions column On the page you are viewing, contains the following options.

• —Show Reply Dialog allows you to reply to the comment. Your reply can
include a heading, a body, and an attachment.

• —Update allows you to edit the comment. You can archive the comment,
change the text in the heading and body, and add an attachment.

• —Delete allows you to delete the comment

If you are viewing all pages, the Actions column for comments on pages you are
not viewing contains a V (View) option that allows you to jump to the page on
which the comment exists.

Created Date col- Shows the date on which the comment was added.
umn

Author column Shows the comment's author.

Title Shows the comment's title.

Attachments Provides a link to the comment's attachments, if any.

Archived A check in this column means the comment is archived.

NC50001

About enabling markup for approval items
Owners of approvals can choose whether to enable markup for attachments. If markup
is enabled for an attchment, and if IBM Unica Marketing Operations is configured to
enable markup for the attachment's file type, anyone who can view the attachment can
use the markup functionality to comment on the object.

Approval owners enable markup functionality on attachments in two ways.

• When an owner adds an item to an approval, the system prompts to enable markup
for the PDF.

• For an existing approval screen, each approval item has Enable/Disable Markup
links. Click the link to toggle the markup functionality.

To allow users to add comments, choose Enable Markup when prompted.
NC60001

To use markup
During installation, IBM Unica Marketing Operations was configured to use either Adobe
Acrobat markup or native Marketing Operations markup.
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Anyone who has permission to view an approval can add comments to items attached
to the approval.

Note the following.

• Markup is only for latest/last version of the approval item.

• You can mark up items for an approval with a status of In progress or On hold only.

1. Navigate to the approval that contains the item to edit.

2. Click View/Add Markup next to the item on which to add comments.

If the link is unavailable, the owner of the approval has chosen not to enable markup
for the item.

The item opens in a browser containing the document.

3. Mark up the item using either Adobe Acrobat or the native Marketing Operations
markup tool, depending on your installation.

• If your system uses Adobe Acrobat markup, only PDFs can be marked up. Click
Review & Comment in the Acrobat toolbar and click Note Tool in the
Commenting toolbar to start adding comments to the PDF.

• If your system uses the native Marketing Operations markup, use the icons and
action buttons in the markup tool. All buttons include mouse over help. Inactive
buttons are gray and cannot be selected.

4. Close the window that contains the marked-up item.

Any member can see the marked-up item by opening the container object and clicking
View/Add Markup. Members keep adding markups to the file this way. To view the
original file without the markups, click the link containing the name of the attached item
instead of View/Add Markup.

Related Topics
• About native Unica Marketing Operations markup

• About using Adobe Acrobat markup in Unica Marketing Operations

NC70001

Using Adobe markup on the Apple Macintosh
This section discusses behavior for users working on Macintosh, using the Safari
browser, and Adobe Acrobat markup functionality.

• You must have Adobe Acrobat Standard or Professional 6.0 or higher.

• You must configure Acrobat as follows. Note that you must perform this
configuration when Acrobat is opened on its own, not through the browser.

• Select Edit > Preferences > Reviewing and select Custom in the ServerType
drop-down list.

• Select Comments > Show Comment & Markup Toolbar.

• IBM Unica Marketing Operations tags the approvers' comments with their Macintosh
login name, which may be different than their Marketing Operations user name.

124 IBM Unica Marketing Operations - User's Guide



Approval process workflow

• If you use Notes, Text Annotations, or other Acrobat markup functionality where text
is entered, after you mark up a page of the item to be approved, you must click
outside the text field (outside the Notes text field, for example) before you click
Send Comments. If you do not do this, the Macintosh will not send the text portion
of the markup back to the server, and the field appears empty when a user opens it
in Acrobat.

• When you use Acrobat markup on the Macintosh, the stamp tool always displays the
name of the user currently viewing the markup, not the name of the user who is
doing the markup.

• Each time you open a PDF, a blank Safari window opens.

• When using the markup capabilities within IBM Unica Marketing Operations with the
Safari browser, temporary internet files are stored on the Macintosh desktop.

• There are two Send icons: one is the same as seen in Windows, and the other is a
IBM Unica Marketing Operations custom button specific to the Safari browser on

Macintosh: . You should use this button to capture markup comments; the
Windows icon does not work.

• If you are using Acrobat version 6, when you click the markup link for an approval,
the Safari browser opens the PDF inline, rather than in an Acrobat screen.

This behavior does not exist if you are using Acrobat version 7. Unica recommends
you upgrade to version 7, if possible.

If you want to view the PDF in an Acrobat screen, perform one of the following actions:

• To open the current document in an Acrobat screen, right-click (hold the CTRL key
down while clicking the mouse if using a one-button mouse) on the PDF and choose
Open with Acrobat 6.0 Professional.

• To always open PDFs in an Acrobat screen, run the following command in Terminal:

$> defaults write com.apple.Safari WebKitOmitPDFSupport–bool YES
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Approval process workflow
The lifespan of an approval process includes the following general stages.

1. You create the approval process, either as a stand-alone approval or as an approval
task in a workflow.

2. Add the items to be approved.

3. Add approvers.

• You can add as many approvers as you need.

• You specify whether each approver acts in parallel with other approvers or
before or after any other approver by specifying a sequence number.
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• You specify approvers as required or optional.

• You can create individual instructions for each approver.

• If you are adding an approval workflow task, you may need to select project
roles for the approvers, for example legal approver and subject approver.

4. Submit the approval.

5. The system immediately notifies all the approvers with the sequence number of "1."

No other required approver can respond to the approval yet; they must wait their
turn, which is based on the sequence order you specified when creating the
approval. However, optional approvers can respond at any time; optional approvers
are not tied to the established approver order.

6. Approvers respond to the approval. Depending on how IBM Unica Marketing
Operations is configured, the approver may also be able to place comments in
approval items.

7. Approvers assess each item attached to the approval and then post their completed
response.

8. The system notifies the next approver(s), based on the sequence numbers set in the
approval.

Several things to note about approval processes.

• The approval owner can cancel the approval process at any time in the process.

• Approvers provide a separate opinion about each item in the approval: approve,
approve with changes, or deny. They then post the entire response.

• Marketing Operations organizes approvals in views. When you click Operations >
Approvals, by default the My Active Approvals view appears. This list shows only
approvals that are active and you are a member of (as either an owner or approver).

You can click the Actions icon ( ) and select All Approvals, All My Team's
Unassigned Approvals, or All My Team's Approvals.

• In any view, you can change the sort order by clicking on the column you want to
sort by. Click the column a second time to reverse the sort order.

• If an approval is linked to a task in the workflow, then the system takes into
consideration the Schedule Through setting for the task in addition to the system-
wide setting for non-work days.

• Approvals do not appear on the approval list of required approvers until it is their
turn to respond, at which time they will also receive a notification.
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Related Topics
• New/edit approval page

• About enabling markup for approval items

• To submit an approval for review

• Due dates for approvals

• Work and non-work time settings

• About native Unica Marketing Operations markup

• About using Adobe Acrobat markup in Unica Marketing Operations

NC80001

To submit an approval for review
After you add an approval process you must submit the approval to notify the approvers
that the approval exists and they need to approve it.

1. Navigate to the Summary tab of the approval you want to submit.

2. Click the Status icon ( ) and select Submit for Review.

The Approvals window appears.

3. Enter any comments you want the approvers to see when they receive notification
of your approval, and click Continue.

The Summary tab of the approval appears with In Progress at the top of the
page.

After an owner submits an approval, its status changes to In Progress. If an
owner makes any further changes to the approval, IBM Unica Marketing
Operations sends notifications to all owners and approvers.

NCA0001

About modifying approvals
After an approval has been created and even submitted, the owner may want to make
changes. For example, the owner can add new items for approval or new approvers to
the list. The owner may also want to delete items and approvers, or update existing
items to be reviewed.

The process of modifying an approval is very similar to creating one. Keep in mind the
following rules and behaviors for modifying an approval.

• Any owner of the approval process can modify it.

• By default, approvers cannot modify the information in the approval; they can only
respond to the approval, unless the security policy allows it.

• If modifying an approval that has been submitted, the Approvals screen appears and
prompts you to add comments to send to new and existing approvers.

• If you want to have an approver that has already responded view the changes,
check the approver’s Request Reapproval checkbox.
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Note that whenever any approver is checked and you want them to re-approve, the
system increments the approval round number.

Related Topics
• New/edit approval page

• Items to approve

NCC0001

To cancel an approval process
You can cancel the approval process at any time. Canceling the process does not
delete the approval. You might decide to cancel rather than delete a review if you think
you will need to see its details in the future.

If you cancel the approval process you cannot submit it for review at a later time. Any
responses or comments made before cancellation will be saved, essentially “freezing”
the approval with all of its current details.

1. Select Operations > Approvals.

The My Active Approvals view appears by default.

2. Click the Actions icon ( ) and select All Approvals.

3. Click the approval you want to cancel to open it to the Summary tab.

4. Click the Status icon ( ) and select Cancel Review.

The Approvals window appears.

5. Enter any comments you want to add to the approval, for example, why you want to
cancel the review, and click Continue.

The Summary tab of the approval appears. The All Approvals view shows the
approval as Cancelled.

If you cancel an approval that is linked to a workflow task, the task is “crossed out”
on the workflow tab. That is, the font for the task and all of its details changes to
italics, strikethrough. Additionally, there is an ‘x’ in the status column, indicating the
workflow is considered "Skipped."

Related Topics
• New/edit approval page

• To delete an approval

NCD0001

To copy an approval
You may want to copy an approval if you want to create another approval that is very
similar to an existing approval. You can make a copy of the existing approval and
modify the copy, leaving the original approval intact.

1. Navigate to the approval that you want to copy.
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2. Click the Copy this Item icon ( ).

3. Click OK when Marketing Operations prompts you as to whether you want to copy
the approval.

The copy of the approval opens to the Summary tab. The copy appears as Copy of the
original approval name. The new approval has a status of Not Started.

Modify any information you want to change in the copy and click Save Changes.

The copy appears in your All Approvals view.

Details copied
The following details are copied.

• List of approvers and whether they are required or optional

• List of owners

• The subject, with “Copy of” prepended to the original approval name

• Target Due Date

• Sequence

• Description

• Items to approve

Details not copied
The following items are not copied.

• Any instructions for individual approvers are not copied.

• The contents of the message board are not copied.

• Information on the Analysis tab is not copied.

• The copy will not be linked to any project workflow, even if the original is. That is,
copying an approval creates a stand-alone approval

NB60001

To delete an approval
As the owner of the approval, you can delete the approval at any time.

1. Select Operations > Approvals.

2. Select the checkbox next to the approvals you want to delete.

3. Click the Delete this Item icon ( ) and click OK when IBM Unica Marketing
Operations prompts you to confirm the deletion.

You cannot delete an approval that is linked to a workflow task.
NCE0001
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To complete an approval
After some criteria are met, it is a good idea to mark the approval complete. Unless the
approval was created with the Enable approval auto completion flag enabled, it is
entirely up to the approval owner as to when to do this. If auto-completion is enabled,
the approval is automatically marked Complete when the last required approver
approves.

The following are some examples of when you might want mark an approval as
complete.

• After all approvers have responded

• After the Target Due Date has passed

• After all suggested changes to approval items have been made

1. Select Operations > Approvals and then click the approval that you would like to
complete.

2. From the Summary page, click the Status icon ( ) and select Finish Review.

3. Enter a comment about why you want to complete the review in the Approvals
window, and click Continue.

The approval appears with a status of Completed, and IBM Unica Marketing
Operations sends a notification that the approval process is finished.

NCF0001

To put an approval on hold
At any time after you submit an approval for review you can put the approval on hold.
You can do this to revise the approval items and request re-approval. Putting an
approval on hold is different than canceling a review of an approval process because
you can make modifications and continue the approval process.

Note the following behavior when you put an approval on hold.

• IBM Unica Marketing Operations notifies the approvers that the approval is on hold.

• Approvers cannot approve or reject the approval during the time it is on hold.

• Owners can view the approval and add comments to any items submitted for
approval while the approval is on hold.

1. Select Operations > Approvals and then click the approval you want to put on hold
to open it.

2. Click the Status icon ( ) and select Stop Review.

3. Enter a comment about why you want to stop the review in the Approvals window.

4. Click Continue.

130 IBM Unica Marketing Operations - User's Guide



To respond to an approval

The Summary tab of the approval appears with the status set to On Hold. IBM Unica
Marketing Operations sends a notification to the approvers informing them that the
approval is on hold.

ND00001

To reactivate an approval that is on hold
1. Select Operations > Approvals and then click the approval you want to reactivate.

You may need to click the Actionsicon and select All Approvals to see your
approvals that are currently on hold.

2. Click the Status and select Continue Review.

3. Enter a comment about why you want to continue the review in the Approvals
window, and click Request Approvals.

Note that whenever any approver is checked and you want them to re-approve,
the approval round number is incremented.

The approval appears with a status of In Progress and IBM Unica Marketing
Operations sends a notification to the approvers that the approval is active and they can
respond.

NBF0001

To respond to an approval
When it is your turn to respond to an approval or complete an approval task, IBM Unica
Marketing Operations notifies you through the Alerts window and via email. Both the
alert and the email contain a link to the approval. You can view the approval in various
views in Marketing Operations, such as the My Active Approvals view.

Complete the following steps.

1. Click the link to the approval.

2. At the top of the Approval Response form, examine the approval description and
the instructions.

3. View an approval item by clicking the item’s thumbnail image or the link next to it.

The item opens in a browser.

Select View/Add Markup to add in-document comments to the item. If you do
not choose this link, any comments you make are lost when you close the item.

4. For each item listed, complete the following steps.

a. Click Post Feedback.

b. In the Response window, enter your review comments in the Your Response
section.
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c. As an alternative to entering comments in this form, you can attach a document
that contains your comments. Under Additional Comments, click Attach
Comments File and upload the file that contains your comments.

d. Select the appropriate response for the item.

• Approve: indicates that you approve of the item as it is.

• Approve w/Changes: indicates that you made comments in an item or
added comments in the text box and you approve the item with those
exceptions

• Denied: indicates that made major comments or suggestions necessitating
fundamental editing of the item(s) by the approval owner.

5. When you have responded to each item in the list and you are sure that you are
finished commenting, click Post Complete Response. At this point you cannot
change your response.

The response form appears with your response listed next your name in the list of
approvers. IBM Unica Marketing Operations sends an alert and an email message
containing your response to the approval owner and sends an alert to the next
reviewer, if any.

Related Topics
• To reassign a team approval

• About alerts and the message board

• About native Unica Marketing Operations markup

• About using Adobe Acrobat markup in Unica Marketing Operations

ND10001

To reassign a team approval
A team can be assigned as an approver. The routing options for the team determine
whether team members can respond to such an approval, or whether the team manager
must assign it.

• If the team has Managers can route approvals to members enabled, the manager
can assign approvals to members.

• If the team has Members can accept team-assigned approvals enabled, team
members can assign themselves approvals, without the manager needing to do so.

• If the team has Members can return team-assigned approvals back to the team
enabled, team members can return approvals back to the queue for the team.

1. Select Marketing Operations > Approvals.

2. Click the Actions icon ( ) and select one of the following searches.

• All My Team Approvals or

• All My Team Unassigned Approvals

3. Select the approval or approvals to assign.
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4. Click the Reassign Selected icon ( ).

5. For each selected task, select a team member for the assignment in the Assign To
field.

Team members can only assign tasks to themselves or back to the team.

6. Once you have made all the assignments, click Save Assignments to save your
changes and return to the Approvals list page.

Once you or your team manager has assigned an approval to you, you respond to it in
the same way you respond to approvals assigned to you as an individual IBM Unica
Marketing Operations user.

Related Topics
• To respond to an approval

• Task routing options

ND40001

To add comments to an approval item
The owner can open an approval at any time and add in-document comments to
approval items. Approvers or other team members who can access the approval can
also use the markup capabilities to add comments to the item. Approvers can view the
comments added by other approvers.

1. Click the link in an alert or email notification message to open the approval, or select
Operations > Approvals and click the approval that has an item you want to
modify.

2. Click View/Add Markup next to the item that you want to add comments to.

3. The exact steps for adding in-document comments depend on whether you use
Marketing Operations or Adobe markup. In either case, add any comments to the
document.

4. After you finish marking up the document, close the window that contains the
marked-up item.

Any team member of the approval can see the marked up approval by opening the
approval and clicking View/Add Markup. Team members keep adding markups to the
file this way. To view the original file without the markups, click the link containing the
name of the attached item instead of View/Add Markup.

ND50001
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Editing an approval that is linked to a workflow
task
Both standalone approvals and workflow approvals are listed in the approval views.
When you select an approval from either the view mode of a workflow or from a list in
an approval view, IBM Unica Marketing Operations displays the approval in a pop-up
window. When you edit an approval that is linked to an approval workflow task, your
work is reflected in the workflow task as follows.

Your action Changes to the linked workflow task

Cancel the approv- The task status changes to Canceled.
al

Change the ap- The task Forecast/Actual End Date changes to match.
proval due date

Start the approval The task status changes to Active, and the Forecast/Actual Start Date is set to
the current date.

Pause the approv- The task status changes to On Hold.
al

Complete the ap- The task status changes to Finished, and the Actual End Date is set to the
proval current date.

Delete the approv- You cannot delete a linked approval from the approval itself. You must delete the
al approval task row from the workflow.

ND60001

Approval response form
The Approval response form has two main areas, the Approval Summary and
Responses.

Approval response header
The header displays the name of the approval, the user that sent it, and the date the
approval is due. For example:

Handouts for Leads, sent by asm admin (due 03/20/2009)

IBM Unica Marketing Operations - User's Guide

The following icons may appear, depending on the user's permissions.

• The Edit icon ( ) is visible, if the user has edit permission for approvals.

• The Status icon ( ) is disabled, unless the user has alter approval status
permission.
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Approval summary
This section of the Approval Response form displays the items for review and their
accompanying descriptions.

On the right side of the section, the state of the approval (for example, In Progress)
is displayed.

You can select an item to view. If commenting is enabled, you can also view comments
other approvers have made and add your comments to the file.

Item Description

Description Displays the description for the entire approval.

List of items Displays all the items for the approval. Note the following:

• Click the item name to open the item in its own window.
• Click View/Add Markup to add comments to a PDF. This link is available for

PDFs only, and only if markup has been enabled for the item.
• Click Post Feedback to add comments for the item. A new page appears that

allows you to enter comments.
Use the feedback page to add comments, attachments (such as screen
shots), or add or view markup if applicable.

• Click Send as Mail Attachment to send the item via your email application.
• Click the status of the approval item (for example "2 of 3 Approved") to view

the details of each response.

Instructions Displays any instructions for the approver.

Approval status Displays your progress for the current approval. For example:
bar

You have approved 1 item(s), denied 0 item(s) and pending

1 item(s).

Post Complete Re- Click this button when you have responded to all the approval items. A
sponse confirmation page appears where you can add any final comments.

Note the following.

• If the approval owner has required disposition of all items, and you click this
button before responding to all items, the system generates the following
warning message: "Please respond to all documents before marking the
process as complete."

• If the approval owner has not required disposition of all items, you must
respond to at least one approval item, or the system generates the following
warning message: "Please respond to at least one document before marking
the process as complete."

• You can respond to an approval item multiple times before you complete your
response to the entire approval process. However, once you click the Post
Complete Response button to complete the review, you cannot respond to
the approval again.
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Approval responses
This section lists overall status of the approval for each approver, in the following
format.

• Name of the approver

• (Required) if the approver is marked as required.

• Response status: either Approved, Denied, Approved w/Changes, waiting, or not yet
notified.

• Date of response, if the approver has responded.

Note the following.

• Overall approval response status is dependant on the response status of each
approval item. For example, if an approval contains 2 items to approve, and
approver approves (or approves with changes) both the items, then the overall
response is Approved. But if approver denies one of the items, then the overall
response is Denied, and the approval state is changed to Rejected.

• Once you complete your review, the Post Feedback link changes to View Item
Responses. You then could only view the item responses and response history.

ND70001

Notes on responding to an approval
Approval processes can contain sequential and parallel portions. For example, suppose
the following approvers are set with the following sequence numbers.

• Mary Manager: 1

• Connie Contact: 2

• Larry Lawyer: 2

• Pablo Picasso: 2

• Charlie CFO: 3

Mary Manager, Larry Lawyer, and Charlie CFO act sequentially; that is, Mary Manager
must act before Larry Lawyer, who must act before Charlie CFO.

Connie Contact, Larry Lawyer, and Pablo Picasso all act simultaneously, in parallel.
That is, Larry Lawyer can respond even if Pablo Picasso has not yet responded, and
vice versa.

Note the following approval behavior.

• You cannot respond to the approval if it is not your turn. When selecting such an
approval, you will get a message that you cannot yet respond to the approval. Once
the required approvers ahead of you have responded, you will be notified and be
able to complete your review.

• If it is not your turn to respond, but you navigate to the approval and click View/Add
Markup for an approval item, you receive a warning message.
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• If a required approver denies the approval, the approval is put On Hold and no other
required approvers can respond. For example, if the third of five required approvers
denies the approval, neither the fourth nor fifth required approvers can respond.
Instead, the system sends a notice to the approval owner and the first two
approvers that the approval changed to On Hold.

An approval owner must update the approval and request reapproval from the
person who denied the approval in order for the next required approver to be able to
respond.

IBM Unica Marketing Operations does not support using the Save and Work
Offline button in Adobe Acrobat. That is, if you use Save and Work Offline, add
markup, go back online, and try to send and receive your comments, your edits may
be lost.

NB30001

New/edit approval page
This page appears when you begin to add an approval process. It also appears when
you open an existing approval process for editing. It contains two sections, Approval
Summary and Approvers .

If you do not see the Approvers settings, click the turn down ( ) next to the
Approvers label.

Related Topics
• Approval Summary

• Items to approve

• Approvers

ND80001

Approval Summary
This section of the New or Edit Approval Process form contains some summary
information for the approval.

The name of the approval contains a round number, if the approval round is greater
than 1. For example, assume there is an approval titled Handout: Final Approval that
has been resubmitted once. On its summary page, the title is Handout: Final Approval
(Round #2).

The Approval summary page contains the following fields.
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Field Description

Sent By Displays a list of the owners of the approval.

By default, this field is auto-populated with the user name of the person creating
the approval.

While the system allows owners to be approvers, this is not typical behavior;
we recommend specifying people as owners or approvers, but not both.

Add/Remove Own- Click this button to add or remove owners for the approval process.
er(s)

The Select Member Access Levels dialog box appears. Browse to a user in the
one of the folders and use the arrows to add the user to the Selected Team
Members list and click Save Changes.

Security Policy Select the security policy you want to apply to the approval. If this approval is
already part of a project (or being linked to a workflow task), IBM Unica Marketing
Operations defaults to the security policy for the project and you do not have to
change it.

If creating a stand-alone approval, this setting defaults to the security policy in
your preferences (in the Administration > Basic Settings screen). If you don’t
know which security policy to select, contact your administrator.

Enable Mark up When viewing the Summary tab, use this link to toggle the setting, either enabled
or disabled. Once this option is enabled, the item can be marked up using IBM
Unica Marketing Operations mark up functionality. This option is available only for
file types for which markup is supported.

NC20001

Approvers
This portion of the New or Edit Approval Process form contains a list of approvers and
items to approve, as well as other options to configure the approval process.

List of approvers
This section of the page displays a list of approvers. By default, this field is empty. Add
approvers by using the Add Approvers link.

Note the following:

• Individual users or teams can be set as approvers.

• By default, approvers are added as Required.

Field Description

Approver role A role or roles associated with the approval task. These can be loaded
automatically from the project template used to create the project, or the project
owner can set them up manually. This field is not available in standalone
approvals.
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Field Description

Approver Name Displays the user name of the approver. You can use the drop-down menu to
update the approver.

Default Duration Displays a duration selection control. Specify the actual duration for each approver
or approval step.

Sequence Displays the order in which the approvers need to respond. Enter integer values in
the field for each approver, as follows.

• Assigning the same number to more than one approver means that these
approvers act in parallel, and can respond to the approval simultaneously.

• When a user revisits this page, approvers are listed by their sequence
number, rather than the order they were added to the approval.

• Use the sequence numbers to specify the order in which approvers act, as
well as whether some approvers act in parallel or in sequence.

Required Check the box next to each approver who must approve. If this box is not
checked, the approver is optional. Note the following behavior for required
approvers.

• If an approver is required, the next approver in sequence will not be notified
(and can not respond) until the current approver has responded.

• If an approver is required, and that approver denies the approval, then the
next sequential approver is not notified; rather, the approval is placed on hold,
and the owners are notified.

• If multiple approvers have the same sequence number (and therefore can act
simultaneously), and one of the required approvers rejects the approval, a
notification is sent to the approval owner. However, the approval process
continues until all the required approvers of the simultaneous process have
responded.

• At least one approver must be set to Required. Although a user can save the
approval with all optional approvers, he or she could not start such an
approval process. The system would generate a warning message if someone
tries to start an approval that contains no required approvers.

Instructions for ap- Add any instructions or comments for the approver to see when they open the
provers approval.

This field is not available in a standalone approval.

Add approvers Clicking this link opens the Select Approvers dialog box, where you can edit the
list of approvers.

Other fields
The bottom portion of the page, above the list of approval items, contains the remainder
of the approval settings.
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Field Description

Subject Add a short subject for the approval. This text should be fairly descriptive, as it will
show up in the Approval List for help in differentiating between all the approvals
on the list.

Target Due Date Enter a target date by which you want the overall approval process completed.
Use the calendar icon in the drop down list to choose a date from the calendar.

Note the following.

• This field is required to start the approval process.
• Depending on project reminder settings, a reminder will be sent to approvers

on the date you enter here.
• If the approval is sequential, the Target Due date should be equal to today’s

date plus the sum of the values in the Default Duration field for each approver.
• If the approval is simultaneous, the Target Due Date should be equal to

today’s date plus the maximum of the values in the Default Duration field for
each approver.
For example, suppose the following approvers are added to the approval.

Name Seq. Dur. A

1 1 day B 2 2

days C 3 1 day

If the approval is started on 14 July 2008, the Target due date would be 18
July. If you set the Target due date earlier than the correct calculation
dictates, the system generates an error, and the approval cannot be saved
until the durations and dates are reset to appropriate values.

• You cannot start an approval process if its Target due date is past. You must
first change the target date to some future date.

Description Displays the text details for the approval.

Re-approval Rules Select the rule to use for this approval. You can restart the approval, continue
from current review step, or select the approvers who need to review again.

Disposition on all Check box that determines whether all approval items need to be reviewed. If this
approval items re- box is checked, each approver must approve or deny all approval items.
quired

Enable comment Check this box to allow approvers to add comments attachments while responding
attachments to the approval. By default, this option is selected.

Enable approval Check this box to have the system automatically mark the approval Completed
auto completion after the last required approver approves. By default, this option is not selected.

NCB0001

Items to approve
This section contains a list of actual items to be reviewed, and controls to add and
configure approval items.
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Field Description

Item Thumbnail Displays a thumbnail image of the item, if one was added when adding the item. If
the item is a PDF, the image is the one your system uses to represent PDFs.

Item Description Text box displays the comments for the item.

File Update, Asset When editing an approval, use these links to update items with a new version.
Update, URL Up- • Use File Update to upload an item stored on your computer or network.date • Use Asset Update to upload an item from an asset library.

• Use URL Update to change a URL pointing to a web site.

When you use one of these links, you attach a new version of the item; users can
then access the older version and the newer version of the item in the approval.

There is no limitation placed on what kind item you select when you update.
That is, the system does not object if you update a brochure with a logo
image. However, if you are updating an item with something that is totally
different from the original item, it is best practice to add it as a separate item
rather than updating the original item.

Remove When editing an approval, use this link to delete an item. It will no longer be
available for review.

Add Item(s) to ap- Attach documents or URLs for approvers to review by clicking this link.
prove

The Add Item(s) to Approve page appears.

• In the Add Item to Approve field, select one of the following options: From My
Computer, From the Asset Library, URL,URL, or Marketing Object.

• Do one of the following.

• Browse to the file you want to attach, and click Open.

• Click Browse Library to attach a file in an asset library. Click the library
that contains the file you want to add and use the tree in the left panel of
the screen to navigate to the folder and then the asset that you want to
attach. Click Accept Asset when viewing the asset in the right panel.

• Enter the URL in the field provided.

• Click Browse to search for a marketing object. When the dialog box
appears, search and select a marketing object. Click Accept and Close
to close the dialog or Accept to temporarily accept marketing object and
search for more.

• Add any comments in the Comments field. Click Add More to display an
additional set of fields for each additional attachment you want to add.

• Click Save Changes when you have added all your attachments.

Note the following.

• To add an item from your computer or network, choose Add Item(s) to Approve.
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• If IBM Unica Marketing Operations is configured to use Adobe Acrobat markup, and
if you want the approvers to have the ability to electronically add comments to a
document, then the document must be a PDF. If you attach any other file format,
approvers can not use the markup capability. You can use Adobe Distiller to convert
a document to a PDF.
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8 People and teams

■ People and teams
■ About people and teams
■ Managing project members
■ To manage reviewers
■ Editing access levels for a member
■ About roles
■ To assign people to roles

NDA0001

People and teams
In IBM Unica Marketing Operations, you assign work to individual users or to teams.

Related Topics
• About people and teams

• To manage project members

• To manage reviewers

• Editing access levels for a member

• To change the access level for a project member

• To assign people to roles

• To add a role

• To remove a role

• To assign work by role

• Finding and replacing task members or reviewers

• Select project members/reviewers

• Team summary page

• To add or edit teams

• To edit members of a team

• About routing work for teams

• Assigning team tasks

NDB0001

About people and teams
You assign people or teams to units of work. You do this primarily through the People
tab on a project. You can also add and assign members, teams, and roles when editing
the workflow tab.
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You may see only a subset of the peopleand teams available. Your organization can
limit the view of available resources.

Related Topics
• About the People tab

• Managing teams

• About team alerts

NE80001

About the People tab
Each project contains its own People tab. Use this screen to do the following.

• Manage the members of a project.

• Edit a member's access level.

• Replace a person in a role when a team member becomes unavailable.

• Add or remove a role.

A project template can contain information about the functional roles for the project. A
template can reduce some of the work necessary to assign people or teams to units of
work within the project.

N9C0001

Managing project members
Use the People tab to perform the following tasks.

• Add a project member.

• Remove a member from the project.

• Change a role for a member.

• Additionally, use this page to add and remove roles.

A role must exist within the project before you can assign it to a team member.

Security permissions for the People tab are as follows.

• View People tab.

• Edit Team Members, Roles, and Access Levels.

• Assign Work by Role. Users with this permission can also access the Assign Work
by Role and Find/Replace dialog boxes.

Users with View People tab and Edit Team Members, Roles, and Access Levels
permissions can automatically add members and member roles on workflow
spreadsheets without adding them to the People tab first.
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Notes on managing project members
• To assign an unlisted role, create it using the List Definitions section of the

Administrative Settings if you have proper permission to access this item.

• The list of people in the Folders section of the Select Project Members dialog box is
populated from IBM Unica Marketing Platform, and may be limited based on your
role and permissions. For details, consult your IBM Unica Marketing Operations
administrator or the IBM Unica Marketing Platform Administrator’s Guide.

The list of teams in the dialog box is based on the teams that have been defined in
Marketing Operations. As with the list of people, the teams you can view may be
limited based on your role and permissions.

• The email address appears only if this information has been entered for the user in
the platform.

• You cannot remove project members (or roles) who have tasks assigned to them.
You must remove them from all future work before removing them from the project.

• In the Project Members column, teams are in italics and are preceded by the
icon. Individuals are preceded by the icon.

NDF0001

To manage project members
1. Navigate to the People tab of the project.

2. Click the Edit Member/Role Settings icon ( ).

The Select Team Members dialog box opens.

3. Do one of the following.

a. To add a person or team, select the name from the left pane of the dialog, and
click >>.

b. To remove a person or team, select the name in the Select Team Members list
box and click <<.

c. To change the role for a person or team, select the name in the Select Team
Members list box and use the Up and Down buttons to move them to the
required role.

Note that you cannot remove a user or team assigned to a task.

4. Click Save Changes.

The Select Team Members dialog box closes. The People tab becomes the active
window.

The changes you have made are reflected in the list of people and roles. For example, if
you added a creative lead, the screen would contain a line similar to the following.

Member/Access Level Role Email Address
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P Picasso (participant) Creative Lead ppicasso@unica.com

IBM Unica Marketing Operations - User's Guide
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Managing teams
Selecting Operations > Teams opens the My Teams page. Use this page to do the
following.

• Create and remove teams

• Assign team managers and members

• Set the work routing model

• Enable and disable teams

These groups of people are available across templates and object instances. Project
Managers can assign tasks to teams, in addition to being able to assign them to
individual members.

Note that wherever you can assign or work with individuals, you can also work with
teams. For example, the procedure "To assign people to roles" can be used to assign
individuals or teams to roles.

N610001

About team alerts
Plan sends alerts for team-related events in the same way it sends alerts to individuals.

Additionally, alerts have the following behavior as applied to teams:

• For tasks assigned to a team, all the team members and managers receive the alert

• After a task is assigned to a team member, only the member and managers receive
the alert

For the following events, only the specific team member affected by the event receives
the alert

• A member is added to the team

• A member is removed from the team

• A team-task is assigned to a member of the team

• A team-task assigned to a user is reassigned back to the team or to another
member

NE30001

Team summary page
When you first navigate to a team, its summary page appears. This page contains the
following items.
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Field Description

Name Displays a name for the team. This name appears on the Teams list page, as well
as selecting project members or reviewers.

This field is required.

Description Displays a short description for the team.

Skill Sets Displays a list of skills associated with the team.

Add terms here that might be useful when describing teams. For example, you
can enter Photoshop as a skill, so that anyone viewing the team knows the team
has this skill.

Suggested Secur- Displays the security policy or policies that apply to the team.
ity Policies

This field is required.

Routing Models Check any combination of the work routing option check boxes.

Members and Displays the managers and members of the team. Use the scroll bar to page
Managers through the list.

From the Team Summary screen, you can perform the following actions.

Action Details

Edit the team
Edit the attributes for the team and members by clicking the Edit icon ( ).

Change alert sub-
scriptions Click the Manage icon ( ) and select Set Alert Rules to change the way

team members and managers are notified of task assignments.

Delete the team
Click the Delete this Item icon ( ) to remove the team.

Copy the team
Click the Manage icon ( ) and select Create a duplicate Team to create a
copy of the team. The system opens the summary page of the new team in edit
mode.

Add a team
Click the Actions icon ( ) and select Add Team to add a new team.
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Action Details

Navigate back to Click All Teams or My Teams in the breadcrumb; either or both of these links are
the Teams list displayed, depending on how you navigated to the current summary page.
page

Or, click the Action icon ( ) and select All Teams or My Teams.

Print team details
Click the Print icon ( ) to print the details of the team.

NE40001

To add or edit teams
If you have the proper security permissions, you can add or edit teams.

1. Select Operations > Teams.

The Teams list page appears.

2. Do one of the following.

• To create a new team, click the Add Team icon ( ).

• To edit an existing team, click a team to display its summary page, then click the

Edit icon ( ).

3. Complete the fields on the Team summary page.

4. Click Save Changes to save your changes to the team.
NE50001

To edit members of a team
If the people you need to add to a team do not appear in Select Team Members and
Roles, you must add them as IBM Unica Marketing Operations users in IBM Unica
Marketing Platform.

You can set team members and managers when you create a team. Additionally, you
can edit the members of a team any time during its existence.

1. Select Operations > Teams.

The Teams list page appears.

2. Click the team to edit from the Teams list page. To edit a team that is not listed,
click All Teams to display all available teams. If it is still not visible, you may not
have the proper security permissions to view it.

The Teams summary page appears.

3. Click the Edit icon ( ).

148 IBM Unica Marketing Operations - User's Guide



Managing project members

4. Click Add/Remove Managers and Members. The Select Team Members and
Roles page appears.

5. Move people into and out of the team as appropriate.
NE60001

About routing work for teams
When you edit a team, you can choose how tasks, approvals, and project requests are
routed for that team.

Related Topics
• Task routing options

• Approval routing options

• Request routing options

• Virtual project participants

ND30001

Task routing options
You can check any of the following options under the Task Routing Model section of the
Team summary.

• Managers can route work to members

Tasks assigned to the team appear on the team manager tasks page. The manager
can then assign these tasks to team members.

• Members can accept team-assigned tasks

Tasks assigned to the team appear on the My Tasks page for each team member.
Team members can then assign a task from the list to themselves.

• Members can return team-assigned tasks back to the team

Members have the ability to return their tasks back to the team.

When you set up a team, you must select one or both of Managers can route work to
members and Members can accept team-assigned tasks.

To view team tasks, you must apply either the All My Team Tasks or All My Teams
Unassigned Tasks filter from the Tasks list page.

The task routing options function independently, and you can choose any combination
for the team. For example, if you need a team where the manager can assign tasks to
members, and members can return assigned tasks back to the unassigned queue
select Managers can route work to members and Members can return team-
assigned tasks back to the team. If you need a team where the manager can assign
tasks to members, but members cannot return assigned tasks back to the unassigned
queue, set only Managers can route work to members.

NEB0001
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Approval routing options
IBM Unica Marketing Operations provides the same routing options for both task
approvals and stand-alone approvals as for standard tasks. Just as for standard tasks,
a team can have any combination of options for routing approval tasks.

You can check any of the following options under the Approval Routing Model section
of the Team summary.

• Managers can route approvals to members

The manager can assign these approval tasks to team members.

• Members can take ownership of team-assigned approvals

Team members can then take ownership of these approval tasks.

• Members can return team-assigned approvals back to the team

Members have the ability to return their approval tasks back to the team.

When you set up a team, you must select one or both of Managers can route
approvals to members and Members can take ownership of team-assigned
approvals.

NEC0001

Request routing options
IBM Unica Marketing Operations provides similar routing options for project requests as
for tasks. You must select at least one of the following options under the Project
Request Routing Model section of the Team summary.

• Managers can route project requests to members

The manager can assign these requests to team members.

• Members can accept team-assigned project requests from the team.

Team members can take ownership of these requests.

• Members can return team-assigned project requests back to the team

Members can return requests they had previously accepted

Related Topics
• Task routing options

NED0001

Virtual project participants
If a user is a member of a team that participates in a project, but the user is not a
participant of the project, the user can see team tasks assigned for the team, and be
assigned such tasks. Additionally, such a user can view the project and all of its tasks.

Consider the following scenario.

• Don is a member of the Major Accounts team.
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• The Major Accounts team has Members can accept team-assigned tasks
enabled.

• The Major Accounts team is assigned in the Members column of the Handouts –
design workflow task for the Fall 2007 Tradeshow project.

• Don is not a project member for the Fall 2007 Tradeshow project.

Even though Don is not a member of the Fall 2007 Tradeshow project, he can view and
update the Handouts – design task, by navigating to his All My Team Tasks page and
selecting the Handouts – design task. In this case, Don is a virtual participant for the
Fall 2007 Tradeshow project, and can view all of its project and task information.

NE70001

Assigning team tasks
Depending on the work routing options, team managers can assign tasks to team
members, or members can pull tasks off the queue themselves.

• If the team has the Managers can route work to members option enabled, team
managers can assign tasks to team members.

• If the team has the Members can accept team-assigned tasks option enabled,
team members can assign themselves any unassigned team tasks.

• If the team has the Members can return team-assigned tasks back to the team
option enabled, team members can return tasks assigned to them back to the pool
of unassigned team tasks.

1. Select Operations > Tasks.

2. Click the Actions icon ( ) to display all saved searches/filters for tasks.

3. Choose one of the following searches.

• To display all tasks assigned to the team, grouped by assignment, click All My
Team Tasks.

• To display all tasks assigned to the team that are not assigned to any team
members, click All My Team Unassigned Tasks.

You cannot reassign tasks from the All Tasks page. To reassign tasks, select
another filter; for example, All My Team Tasks.

4. Check the boxes for all the tasks to assign. Note that you can check the box for the
Name column to select all listed tasks.

The Reassign Selected page appears. If you do not have permission to assign the
selected tasks, the page contains a message to this effect.

5. For each selected task, select a team member for the assignment in the Assign To
field.

Team members can only assign tasks to themselves or back to the team.
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6. Once you have made all the assignments, click Save Assignments to save your
changes and close the page.

NEE0001

Assigning team requests
You must have permissions to assign a team to a project request.

1. Go to the People tab of the project and click the Members/Roles icon ( ).

A dialog box opens listing teams and team members to assign.

2. Select a role in the Selected Members and Roles area, and move a team from the
list of teams and team members to assign that team or team member to the
selected role.

If you assign a team member to a role, the team is not automatically assigned.
NE00001

To change the access level for a project member
While all IBM Unica Marketing Operations objects have access levels, it is useful to
change access levels for projects only.

1. Navigate to the people tab of the project.

2. Click the Change Member Participation Level icon ( ).

This icon is unavailable unless you have the proper security permission. Typically,
project owners and IBM Unica Marketing Operations administrators have this
permission, but it may be assigned differently depending upon the security policy for
the project.

The Change Member Participation Level page appears.

3. In the Selected Team Members list box, select the member who has an access
level to change.

4. Use the Up or Down buttons to move the member to the new access level.

5. Repeat Steps 3–4 as necessary.

6. Click Save Changes.

The Change Member Participation Level dialog box closes, and your changes are
applied. The people tab becomes the active window.

Note the following.

• The list of people in the Folders section of the Change Member Participation Level
page is populated from IBM Unica Marketing Platform, and may be limited based on
your role and permissions. For details, consult your IBM Unica Marketing Operations
administrator or the IBM Unica Marketing Platform Administration Guide.

The list of teams in the dialog box is based on the teams that have been defined in
Marketing Operations. As with the list of people, the teams you can view may be
limited based on your role and permissions.
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• You can also use the Change Member Participation Level link to add users to the
project. They are added with the selected access level and placed by default into
the Unassigned role.

• Access levels are associated with objects, and cannot be created or removed. For
example, approvals always have two access levels: owner and approver.

N840001

Finding and replacing task members or reviewers

Once you click the Find and Replace Task Members icon ( ) or the Find and

Replace Task Reviewers icon ( ), the Find and Replace Task Members or Find and
Replace Task Reviewers dialog appears.

You can replace any member or reviewer with any other current member of the project.
To replace with someone not on the project list, you first need to add that person to the
project. Note that this applies only to owner-assigned task members and reviewers. To
remove a member or reviewer assigned by an administrator when a template was
created, you must go to the approval and remove them, assuming you have
permissions to do so.

When accessing the Find and Replace Task Members/Reviewers page, the project
Workflow is locked; any other user who attempts to access it receives a warning
message, indicating the workflow is currently in use.

The following table describes some uses for the search and replace functionality.

Goal Select Replace with

Accommodate out of office situ- task member/reviewer = Karen Mary Manager
ations: Replace a given person, in

role = Project Managera given role, for a specified date
range (for all tasks occurring dur- tasks between 11/1/2005 and
ing that date range), with another 12/1/2005
user.

Switch specific resources: re- task member/reviewer = Karen Connie Contact
place a given user in a given role,

role = Project Managerwith another user, for all tasks in
the project.

Switch specific users: replace a task member/reviewer = Karen Mary Manager
given user, anywhere on the pro-

role = Any Roleject, regardless of role.

Add a backup to a role: add an task member/reviewer = Karen Connie Contact
additional person to a role, as a

role = Project Managerbackup or additional resource.
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Goal Select Replace with

Assign tasks to a role: newly task member/reviewer = Any User Mary Manager
assign a given user to tasks, by

role = Project Managerrole.

This page contains the following sections.

• Filters: Allow you to filter the search by role, task member, or a date range. Filters
are located at the top of the page.

• Buttons: Allow you to preview and update the search. The buttons are located at
the center of the page.

• Search results: Displays tasks that meet the search criteria. Use it as a preview of
the tasks that will be changed if you click Update All Occurrences.

Filters
Use the top-most fields in the Find and Replace Task Members/Reviewers dialog to
filter the results. You can search by role, task member, or project date ranges.

Field Description

Task member or Enter the name of the member to replace.
reviewer is

This drop-down lists all team members and reviewers on the project. It also
contains a choice for any user; this is the default.

Role is Enter the role of the task member to replace.

This drop-down list contains all roles in the project, and also contains a choice for
any role, which is the default.

Date Constraint Check this box to search using a date range. If selected, you can choose the
following information.

• Type of task: fill in the for tasks box with the type of date to search, either
forecast or target.

• Range: choose dates for the search range.

Status Select the status on which to filter. You can choose Pending/NotStarted, Active/In
progress, or both.

Replace with/ Add Select one of the radio buttons, depending on whether to replace or add
this task member members/reviewers. Then, enter the person you want to fill the selected role on

the tasks in the search results.
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Buttons
Button Description

Find All Occur- Preview search results. You can view the list of tasks that meet your search
rences criteria in the Search Results area of the page.

Update All Occur- Update members, once you have confirmed the list of tasks is correct. We
rences suggest you click Find All Occurrences before doing the update.

Cancel Close the page without making any changes.

NE20001

Select project members/reviewers
The Select Project Members page appears when you are adding or removing project
members, and the Select Reviewers page appears when you are adding or removing
reviewers.

You may see only a subset of the people and teams available in IBM Unica
Marketing Operations, since your organization can limit the view of available
resources.

Field Description

Folders Displays a list of users you can choose from.

• The list of people is set up by an administrator in IBM Unica Marketing
Platform.

• The list of teams is based on the teams that have been defined in IBM Unica
Marketing Operations.

Roles Displays a list of roles in your system. It is set up by an administrator and contains
all the roles defined in IBM Unica Marketing Platform and IBM Unica Marketing
Operations template files.

In the Select Project Members or Select Reviewers page, use the Roles tab to
add roles for the members and reviewers.

Selected Project Displays the current list of members or reviewers for the project. You can move
Members / Re- people and roles to and from the list, as well as reordering them by using the
viewers buttons.

An asterisk (*) next to a role indicates the role is used in the workflow, and therefore
cannot be deleted.

N9D0001
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To manage reviewers
Reviewers are different from project members because they do not have access to the
project. The reviewer roles and users are defined in the people tab to be used in the
workflow, mostly for approval tasks.

Use the Select Reviewers page to perform the following tasks.

• Add a reviewer

• Remove a reviewer from the project

• Change the role for a reviewer

1. Navigate to the project's people tab.

2. Click the Reviewers/Roles icon ( ).

The Select Reviewers dialog box appears.

3. In the Selected Reviewers list box, select a person or team.

4. Do one of the following.

• To add the person or team to the project, select them from the left pane of the
page, and click >>.

• To remove the person or team from the project, click <<.

• To change the role for a person or team, use the Up and Down buttons to move
them to the required role.

5. Click Save Changes.

The Select Team Reviewers dialog box closes and your changes are applied. The
people tab becomes active.

NDC0001

Editing access levels for a member
IBM Unica Marketing Operations is a collaborative tool, and people using the software
may need varying degrees of access to projects. Marketing Operations accomplishes
this, in part, with the ability to assign project members different object access roles,
sometimes called access levels.

Access levels are default roles that exist for different types of objects. For example, a
project has owner, participant, requester, and approver. A request has owner and
recipient. While the names of the object access roles are fixed, the security permissions
granted by them depends on the security policy assigned to the object.

IBM Unica Marketing Operations objects contain the following access levels.
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Access level Description

Owner All object types have owners, usually the person who created the object. Owners
can typically perform any function associated with an object, such as adding
members to the team or editing the properties of the object.

Participant Can typically view the object, but not edit it.

For projects, when a project is created using the wizard, all members added to the
project become participants by default.

Requester (pro- Can typically view the project, but not edit it.
jects only)

If you create a project from a request, the owner of the request becomes the
requester of the project.

Recipient (requests Can accept or return a request. A requester submits a request to the recipient,
only) who then decides what to do with the request.

Approver (approv- Can approve, deny, or suggest changes to an approval assigned to them.
als only)

Sometimes, a project owner needs to change the access levels of a member or
members. For example, after assigning people to roles, there are many people with the
Participant access level. You can grant some of them owner-level access or deny some
of them even participant privileges.

NDD0001

About roles
Ask your IBM Unica Marketing Operations administrator if you need help with
permissions.

• View People tab. Users with this permission can view the People tab.

• Edit Team Members, Roles, and Access Levels. Users with this permission can
edit members, roles and access levels

• Assign Work by Role. Users with this permission could assign tasks to roles and
people, and access the Assign Work by Role and Find/Replace dialog boxes.

N830001

To assign work by role
Typically, at the beginning of a project, the project owner or manager assigns work to
the members of their team. The section describes how to perform this task for owner-
assigned approvers (as opposed to those assigned in the template).

1. Click the Assign Work By Role icon ( ).
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If the project has been started, a warning dialog box appears; click OK to
proceed or Cancel to cancel the assignment process.

The Assign All team members and reviewers to their respective tasks page
appears.

2. Select one of the following.

• Select append the new user to add members to the existing assignments.

• Select replace the existing assignment to replace anyone currently in a role.

3. Click OK.

A confirmation dialog box appears.

4. Click Close.

In the workflow, all users assigned to roles are also assigned to the tasks associated
with their role.

Note the following when you assign work.

• When you access the Assign All team members and reviewers to their
respective tasks dialog, the project Workflow is locked; that is, any other user who
attempts to access it receives a warning message, indicating the workflow is
currently in use.

• Only tasks with a status of pending have people assigned to them when performing
this task; all other tasks remain unchanged.

NE10001

To remove a role
If you are removing a role, note the following.

• If you delete a role that has people or teams assigned to it, they are not removed
from the project; they are reassigned to the Unassigned role.

• The Unassigned role cannot be removed.

• You cannot remove a role that has work assigned to it. You must first either assign
a person or team to that role, or assign the work to a different role.

• You cannot remove a user who is assigned to a workflow task.

1. Navigate to the project's People tab.

2. You can remove a member or reviewer role.

• To remove a member role, click the Members/Roles icon ( ).

• To remove a reviewer role, click the Reviewers/Roles icon ( ).

3. Select a role to remove, and click <<.

If the role selected for removal has people or teams assigned, a warning dialog box
appears. Click OK to remove the role, or Cancel to keep it.
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4. Click Save Changes.

The Select Project Members/Reviewers dialog box closes. The People tab becomes the
active window. The changes you have made are reflected in the list of people and roles.

NB90001

To add a role
Occasionally, a project owner or manager may realize the project needs another project
role. For example, the organization could decide a certain project needs the Legal
department to approve its collateral. If this role is not added when the project is created,
the project owner can add it to the project later.

Note the following.

• The system does allow you to add a role that already exists in the project. Note,
however, that this does not result in a duplicate or copy of the role.

• Permissions based on project roles can be configured at the template level only.
You cannot configure custom security for project roles that are added to a project
after the project was created.

• A project role must exist before you can add it to a project. To create a new project
role, select Administration > List Definitions > Roles (note that you must have the
proper permission in order to access this item). Then you can add the role to your
project using the steps described below.

1. Navigate to the project's People tab.

2. You can add a member or reviewer role.

• To add a member role, click the Members/Roles icon ( ).

• To add a reviewer role, click the Reviewers/Roles icon ( ).

3. Click the Roles tab in the list box on the left side of the page.

4. Select a role to add, and click >>.

5. Click Save Changes.

The Select Project Members/Reviewers dialog box closes. The People tab becomes the
active window. The changes you have made are reflected in the list of people and roles.

NDE0001

To assign people to roles
Before you can complete this task, the workflow must have been set up with the
necessary approval and workflow tasks, and a role assigned to each task that should
have one. This occurs when the project is created from a template that contains this
information. If not, you must first add roles to the project or task.

Note the following.
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• Administrators create roles using the List Definitions section of the Administration
menu item.

• The list of people in the Folders section of the Select Project Members page is
populated from IBM Unica Marketing Platform, and may be limited based on your
role and permissions. For details, consult your IBM Unica Marketing Operations
administrator or the IBM Unica Marketing Platform Administration Guide.

• Administrators may define assignments using the Request tab of the template.
Therefore some roles may be pre-assigned.

• The list of teams in the Select Project Members page is based on the teams that
have been defined in Marketing Operations. As with the list of people, the teams you
can view may be limited based on your role and permissions.

1. Navigate to the People tab of the project.

2. You can assign work to project members or reviewers.

• Click the Members/Roles icon ( ) to add project members.

• Click the Reviewers/Roles icon ( ) to add reviewers.

The Select Project Members or Select Reviewers dialog box appears.

3. The template used to create the project may contain the necessary roles. If so,
skip this step. Click the Roles tab on the left side of the dialog and add all the roles
you might need for the project.

4. In the Selected Team Members/Reviewers list box, select the role you will be
assigning.

5. Click the Folders tab, and navigate to the person or team to assign.

6. Select the person or team and click >>.

The selected person or team is assigned to the selected role.

7. Repeat Steps 4–6 until each member and reviewer role has at least one person or
team assigned to it.

8. Click Save Changes.

The Select Project Members/Reviewers dialog box closes. The People tab becomes the
active window.
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9 Thecalendar

■ About the calendar
■ Configuring display options for the calendar
■ Viewing the timeline
■ Viewing the text or graphical calendar
■ To publish the calendar

NEF0001

About the calendar
Marketing organizations typically organize their work around calendars. For example,
seasonal events drive marketing programs, as well as other external dates, such as
store openings, seasonal product announcements, and so forth.

Historically, organizations have produced paper-based calendars and have updated
them with the latest calendar-driven data. The calendar functionality provides marketing
groups with an electronic means of viewing and updating this data.

You can customize the appearance of the calendar in the following ways.

• You can set your default view of the calendar by using the Calendar/Timeline
Settings screen.

• You can choose the look of the calendar by using the Set View Options dialog box.

• You can filter the items displayed on the calendar by using Advanced Search
functionality of IBM Unica Marketing Operations.

Related Topics
• Setting the appearance of the calendar

• To set your basic options

• To change your view of the calendar

NF00001

Configuring display options for the calendar
Selecting Marketing Operations > Calendar opens a time-centric view of your
business processes. When you view the calendar, its appearance depends on several
options that you (or your administrator) have previously set:

• Set the default calendar view: Use the Calendar/Timeline Settings page in the
Administrative Settings to set the default appearance for the calendar.
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• Set the initial calendar view: After setting the Calendar options, you can change the

initial view by clicking the View icon ( ) on the Calendar page.

• Toggle between calendar views: You can use the View icon ( ) on the Calendar
page to choose from timeline or calendar views, as well as the time range displayed.

The View icon ( ) is also available from the Projects, Programs, Plans, and
Tasks list pages.

Related Topics
• To set your default calendar options

• To change your view of the calendar

• Viewing the text or graphical calendar

NF40001

Setting the appearance of the calendar
You can set the appearance of the calendar in either of two ways.

• You set your initial and default view of the calendar.

• You can change most of the options while viewing the calendar.

Use the Calendar/Timeline Settings page to set these parameters.

Field Description

Include Weekend You choose whether the calendar shows a five-day week or a seven-day week by
Days specifying this option.

Select Yes to display a seven-day week.

Weeks Should Be- You can specify whether the calendar displays Monday as the first day or Sunday
gin On as the first day, even if weekends are shown on the calendar.

Select either Sunday or Monday. Sunday is the default.

Default Content of You can choose which objects to display on the calendar. Select one of the
Calendar Section following.

• Plans (the default)
• Projects
• Programs
• Tasks
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Field Description

Default Search of Allows you to choose the filter for the objects displayed on the calendar.
Calendar Section

Select a saved search to be the default when you click the Calendar menu item.
The list of available items depends on which objects you selected for the Default
Content field. For example, if you selected Projects for the default content, you
could choose Active Projects for the default search.

Default Layout of Allows you to choose from timeline or calendar views, as well as the time range
Calendar Section displayed.

The following parameters are available on both the Calendar/Timeline Settings page
and the Set View Options dialog box.

Field Description

Display as and On the Calendar/Timeline Settings page, you choose the calendar view using the
Time Scale Default Layout of Calendar Section field. On the Set View Options dialog box,

you use the Display as and Time Scale fields to perform the same action.

Enable Color Cod- Allows you to color code the calendar based on an attribute you select. This is a
ing 2-step process:

First, check the Enable Color Coding check box. Then, select the attribute to use
for color coding the objects on the calendar.

When displaying Allows you to limit the amount of information when displaying tasks on the
tasks, only show calendar. Check this box, then choose the milestone types to hide most tasks
milestones when displaying project tasks. Only the selected milestone types will be displayed.

The following option is available only on the Set View Options dialog box.

Field Description

Brief/Detailed Allows you to determine the amount of information displayed for tasks. This is
available for tasks only.

NF70001

To set your default calendar options
You set all available options for the calendar using the Calendar/Timeline Settings
page. The settings you choose remain in effect between your sessions. That is, if you
log out of IBM Unica Marketing, and then log back in later, your calendar appears with
the options you last set on this screen

1. Select Settings > Marketing Operations Settings.

2. Click Calendar/Timeline Settings.

The Calendar/Timeline Settings page appears.
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3. Fill in the details on the Calendar/Timeline Settings page.

4. Do one of the following:

• Click Save Changes to save your changes.

• Click Revert to Saved to discard your changes, and reload the settings from
your previous save.

• Click Cancel to exit the page.

Related Topics
• Setting the appearance of the calendar

NF50001

To change your view of the calendar

You can access the different views of the calendar by clicking the View icon ( ) on
the Calendar page.

1. Select Operations > Calendar.

The calendar appears in the default view. This view depends on settings in the
Calendar/Timeline Settings page.

2. Click the View icon ( ). The Set View Options dialog box appears.

3. Fill in the details on the Set View Options dialog box.

4. Do one of the following:

• Click Apply to view your changes.

• Click Reset to discard changes.

• Click Close to exit the screen and keep your changes.

Your changes are applied. However, unlike the Calendar/Timeline Settings page, the
changes you make here do not persist. Once you leave the Calendar page, your
settings return to the default values.

Related Topics
• Setting the appearance of the calendar

NF10001

Viewing the timeline
If you choose a timeline view, you can choose from several date ranges; the screen can
display a single week’s data all the way up to an entire year’s worth of data.

164 IBM Unica Marketing Operations - User's Guide



Viewing the text or graphical calendar

Related Topics
• About timeline view of the calendar

• About horizontal bars on the calendar

NFA0001

About timeline view of the calendar
This view displays a grid-like view of the objects (Projects, Programs, or Plans) you
selected and filtered (for example, Active Projects) by some unit of time, depending on
which timeline view you selected.

Each object is displayed in a horizontal bar across its date range. The name of the
object displays on the bar.

If you select Enable Color Coding from the calendar view options screen, each
object's bar appears in a color based on an attribute you chose.

Choose a date-range for the timeline.

• Week: displays one week, with each day listed as a column. The starting day is
either Sunday or Monday depending on the option selected in the Calendar/Timeline
Settings screen.

• Month: displays a single calendar month. Each day is listed as a column, and days
are grouped into weeks.

• Quarter: displays three calendar months. Each week is listed as a column, and
those weeks are grouped into months.

• Fiscal Year: displays a fiscal year (starting month depends on a configuration
setting, firstMonthInFiscalYear). Each month is listed as a column, and the
months are grouped into quarters.

• Calendar Year: displays a calendar year (starts in January and ends in December).
Each month is listed as a column, and the months are grouped into quarters.

Any day that has been specified as non-work time has its column grayed out.
Additionally, the name of the non-work time (for example Labor Day) displays when
you mouse over the date. This feature is not available when the time scale is
Quarter, Fiscal Year, or Calendar Year.

NF20001

Viewing the text or graphical calendar
The calendar views display data for a selected month. The page displays a grid
containing a column for each day of the week: either five columns representing the
weekdays, or seven, if you have chosen to display weekend days. You set this option
on the Calendar/Timeline Settings page.The page contains either five or six rows, each
representing a week.
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The view contains a cell for each day of the selected month. The cell for a day contains
either a list of items active on the day (text) or a portion of a horizontal bar for each
active item (graphical).

Related Topics
• About the monthly calendar

• About timeline view of the calendar

• About calendar color coding

• About horizontal bars on the calendar

• Brief and detailed views of tasks

NFC0001

About the monthly calendar
This view displays a calendar of the selected month. It lists the objects (Projects,
Programs, or Plans) you selected and filtered on (for example, Active Projects).

Choose either of two, monthly, calendar views.

• 1-Month Text: Each day contains a list of objects. An object is displayed for all days
in its date range.

• 1-Month Graphical: Each object is displayed in a horizontal bar that begins on its
start date and ends on it end date. If you select Enable Color Coding from the
calendar view options page, each object's bar appears in a different color.

Any day that has been specified as non-work time is indicated by a gray X in the
background. Additionally, the name of the non-work time (for example Labor Day)
displays when you mouse over the date.

NFD0001

About calendar color coding
You can display objects in a color-coded manner on either the graphical calendar or in
the timeline views.

You first select the Enable Color Coding check box in the either the Calendar/Timeline
Settings page or the Set View Options dialog box. After you check the box, the Based
on values for drop-down menu displays. This list contains attributes for your projects,
programs, or plans (depending on which objects you are currently displaying in the
calendar).

From this list, you can choose any attribute that is an enumerated type. For example,
consider the following attribute:

• Name: Product Family

• Valid values: CDs, Credit Card, Home Mortgage

If you choose to group objects by this attribute, your calendar contains four colors: one
for each valid value, plus N/A, corresponding to any objects that do not contain a value
for the Product Family attribute.
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The calendar also displays a legend in the lower-right corner of the screen. The legend
lists all valid values (plus N/A) along with the color corresponding to that value.

You can also color code by the template on which the project or program is based.

NFB0001

About horizontal bars on the calendar
The timeline view and graphical calendar view display horizontal bars.

Note the following.

• The bars represent the date range for objects displayed on the calendar.

• The name of the object displays on the bar.

• The bars may be colored based on an attribute you select.

• The shape of the bars indicate the following:

• Rounded-end “start”: indicates the object starts on the date where the bar has a
rounded end.

• Rounded-end “end”: indicates the object ends on the date where the bar has a
rounded end.

• Flat-end “start”: indicates the object starts prior to the visible date range.

• Flat-end “end”: indicates the object ends after the visible date range.
NFE0001

Brief and detailed views of tasks
Use the Set View Options dialog box or the Calendar/Timeline Settings page to choose
brief or detailed view of tasks on the calendar.

In brief mode (the default), the text displayed contains the following items.

• Task ( ) or approval ( ) symbol

• Task ID

• Name of the task

In detailed mode, the text displayed contains the following items.

• Task ( ) or approval ( ) symbol

• Name for the project that contains the task

• Code for the project that contains the task

• Task ID

• Name of the task
NF30001
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To publish the calendar
To get a snapshot of the current calendar, save it in HTML format (into a ZIP archive
file).

1. Choose the calendar view to publish.

Select the objects, time range, and appearance for the calendar view. You can do
this in either of the following ways:

• From the Operations menu, select Calendar, then select items to view.

• At a list page for plans, programs, projects, or tasks, click the View icon ( )
and choose a calendar view.

If the current calendar view includes projects, Project data is exported as well.
The exact data exported depends on how the project template was set up;
Summary and custom tabs may be exported for some or all projects.

2. Click the Print icon ( ) and select Export.

3. Do one of the following.

• Click Open to open the ZIP file of the calendar.

• Click Save and choose a location, to save the calendar to disk.

• Click Cancel to return to the Calendar page without publishing.

The system publishes the calendar into a ZIP file archive. You can use any application
for working with ZIP files to access the calendar HTML pages. Note that you can
navigate to the next and previous pages of the calendar view in your web browser. If
you exported any project data, you can also navigate to that data from the calendar
HTML pages.

168 IBM Unica Marketing Operations - User's Guide



N10680

10 Grids

■ About grids
■ About editing grid data
■ Grid controls
■ To import grid data
■ To export grid data
■ To post read-only grid data to a URL
■ To group read-only grid data

NFF0001

About grids
A grid is a spreadsheet-like presentation of data. Grids allow IBM Unica Marketing
Operations users to store all campaign- and project-related data within the project.

With grids, users no longer need to search through e-mail, a file folder, or another
computer to find information about a campaign or project. IBM Unica Marketing
Operations serves as the system of record and offers enterprise-wide access to data
stored in grids. Any Marketing Operations user who has access to the project can view
and edit the grid, if he or she has appropriate security permissions.

Users can move the traditional spreadsheet information into a grid within IBM Unica
Marketing Operations. Then, marketing managers can analyze, measure and report on
the project- and campaign-related information within and across multiple projects or
campaigns.

Depending on how your templates are defined, you may find grids on marketing object,
plan, program, and project tabs. Campaign projects include a TCS tab that displays a
special grid called the Target Cell Spreadsheet. You can create campaign projects only
if IBM Unica Marketing Operations–Campaign integration is enabled.

A template creator configures grids, specifying the data source, whether data is
grouped, whether a user can sort the data, and other grid characteristics. Then,
administrators and users can use them when they create marketing object tabs and
project tabs.

A grid can also be read-only, displaying data that you cannot edit.
N1000001
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About editing grid data
When you work with grids in edit mode, you can add rows, delete rows, and edit
existing data. In a single editing session, you can perform all of these tasks if you have
the proper permissions.

Permissions
You must have the following permissions to work with grids. Ask your administrator if
you need help.

• To add a row, you must have the View Tab, Edit Tab, Edit Grid, and Add Grid
Row permissions for the tab with the grid.

• To edit a row, you must have the View Tab, Edit Tab, and Edit Grid permissions
for the tab with the grid.

• To copy and paste a row, you must have the View Tab, Edit Tab, and Edit Grid
permissions for the tab with the grid.

• To delete a row, you must have the View Tab, Edit Tab, Edit Grid Row, and
Delete Grid row permissions for the tab with the grid.

Locked data
The system prevents you from editing a row that is currently being edited by another
user. For a Target Cell Spreadsheet, the entire grid is locked for editing instead of
individual grid rows.

Revision history
Marketing Operations maintains an audit log for grids. The audit log contains the user
details and the time it was saved. This information is available on the Analysis tab.

N1010001

Grid controls
The following tables describe the controls you use when working with grids in the View
and Edit modes.

The following features are available in both modes.

• Data is displayed in pages. To navigate, you can click arrows to go to the next,
previous, first, and last pages, or you can enter a number in the box and press
Enter.

• You can sort by column by pointing to the column heading, clicking the down arrow,
and selecting Sort Ascending or Sort Descending in the drop-down menu. Note
that some columns may have sorting disabled, depending on how the grid was
designed.
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• You can view or hide columns by pointing to any column heading, clicking the down
arrow, pointing to Columns in the drop-down menu, and selecting or clearing the
check box next to the column name.

• You can reorder columns by dragging and dropping the column heading. (This
ability is not available in grids that have column grouping.)

• You can change column width by dragging the edge of the column headings.

View mode
Control Description

Switch to Edit mode.

Copy selected grid rows. Click in the first column to select a row.

Import a CSV file that contains grid rows.

Export all the data in the grid in a comma-separated list.

Use advanced search to filter grid data.

Select the calculation used for each column in the Summary row. The options are:
Sum, Avg (average), Min (lowest value in the column) and Max (highest value in
the column). In a multi-page grid, calculations are performed across all the data,
not just for individual pages. This control is available only in view mode.

Save Preferences Save your customized view of the grid.

Approve All Approve all the rows in the TCS. This control is available only for TCS grids.

Deny All Deny approval to all the rows in the TCS. This control is available only for TCS
grids.

Clear All Delete all the rows in the TCS. This control is available only for TCS grids.

Publish Send the current TCS data to Campaign so the flowchart designer can access it.
This control is available only for TCS grids.

Get cell status Retrieve the latest flowchart and cell count information from Campaign. This
control is available only for TCS grids.

Edit mode
In edit mode, you can click single line text, multi-line text, numeric and money type
column contents and begin typing to overwrite existing data. For any editable column,
you can double click a cell to bring up the content editor for that column type.
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If the row is currently in use by another user, the system displays a message to let you
know you cannot edit that row. Before you save your changes, cells you have edited
contain a small red triangle in the corner; these markers disappear after you save.

Control Description

Add a new row. The row is added below the currently selected row. The first row
is selected by default when you enter edit mode.

Copy selected grid rows. To select a row, click in the first column.

Paste grid cells and rows.

Mark a selected row for deletion. The row is deleted when you save. Within a row,
the same icon indicates the row status.

Un-mark a selected row for deletion. Within a row, the same icon indicates the row
status.

Save your changes and remain in edit mode.

Save your changes and return to view mode.

Revert all changes you have made since your last save and return to view mode.

N1020001

To import grid data
To quickly add data to a grid, use the import functionality. You can import data to a grid
in comma separated values (.csv) format.

1. Navigate to the grid for the import.

2. Click .

3. Browse to the CSV file that contains the data to import.

4. If the first row of the file contains header information, select the First row is header
row box.

The confirmation screen appears.

5. Click Save to import the file or Cancel to quit the import process.

If the CSV data does not match the number and data type of the grid columns, you
receive an error message. The message describes the differences between the grid
and the CSV file.

6. Click Finish to close the dialog and return to the grid tab.
N1030001
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To export grid data
You can export grid data in comma-separated values (.csv) format. Note the following.

• All pages (if the data is paginated) are exported.

• All rows except the Summary row are exported.

• All columns (including hidden columns) are exported.

• Exported rows are in the same order as in the current view. If you are viewing the
grid alphabetized by ID, the exported data is also alphabetized by ID.

1. Navigate to the grid to export.

2. Click .

3. In the File Download dialog box, choose one of the following.

• Click Open to display the file in Microsoft Excel.

• Click Save to save the file to disk.

• Click Cancel to close the dialog box without exporting the data.
N1040001

To post read-only grid data to a URL
If the template creator has enabled a read-only grid for data posting, the screen
contains a Post Data link.

1. Navigate to the read-only grid whose data you want to post.

2. If the grid contains more than one page, click Show All to view the entire grid on the
screen.

3. Check the box for each row you want to post.

As a shortcut, you can check the box in the grid header to select all currently
displayed rows.

4. Click Post Data.

Marketing Operations calls the specified URL with the selected data.
N1050001

To group read-only grid data
If the template creator has enabled data grouping for a read-only grid, you can group
the grid's data by any of its columns.

1. Navigate to the read-only grid you want to view.

2. Click View.

Set View Options appears.
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3. Check Enable Grouping. To turn off grouping, clear this field.

4. In the Group By Column field, select the column for grouping.

5. Click Apply to save your changes and close the dialog box.
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11 Marketingobjects

■ Marketing objects
■ About the offer object type
■ To create a marketing object
■ About the marketing object cross reference report
■ About the modifies and references relationships
■ Selecting marketing objects
■ To delete marketing objects
■ To change the status of marketing objects
■ To add a marketing object reference to a form or a grid row
■ About marketing object references in approvals

N3A0001

Marketing objects
You can create new marketing objects if you have permission to do so. Once you create
a marketing object, you can start it at any time. Starting the marketing object makes it
active.

A marketing object is any work product a team develops and reuses in the course of
its marketing activities. A marketing object can represent either a physical item, such as
a letter, credit card, or banner ad, or a business component, such as a credit card offer,
a target segment definition, or a rewards program definition.

• You define and manage marketing objects that represent all reusable work products.

• You can perform basic operations (create, edit, change state, copy, link, and delete)
on marketing objects.

• You enter and manage all of the attributes that define a particular marketing object,
such as name, owner, state/status, description, etc.

• You can define and manage business processes (such as projects) that produce,
modify, and retire marketing objects.

• You can construct robust projects which define multiple marketing activities by
“assembling” each discrete marketing activity from existing marketing objects.

IBM Unica Marketing Operations marketing objects are defined in stages, and how they
are defined influences how they are organized and presented to users. The following
terms are important in understanding the definition and organization of marketing
objects.
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Marketing object type
A Marketing object type is the highest-level division for marketing objects. An
administrator creates marketing object types. Each marketing object type has a menu
item, but the menu on which it appears depends on how the administrator configured
the marketing object type.

Marketing object template
A marketing object type is broken down into one or more marketing object templates.
Typically, an administrator creates a marketing object template for each significant
characteristic for the marketing object type.

Marketing object instance
A Marketing object instance is a single marketing object. Users with the proper
security permissions create marketing object instances from marketing object templates.
Throughout the documentation, we refer to marketing object instances simply as
“marketing objects.”

N1060002

About the offer object type
If your system includes the IBM Unica Marketing Operations application only, your
system administrators may have configured a custom marketing object type that
represents offers or promotions.

If your Marketing Operations environment is integrated with IBM Unica Campaign, it
includes a system-provided marketing object named "offer." However, there are two
options for offer management:

• If your system is configured so that offers are managed through the Marketing
Operations version of the feature, then you use the Offers option from the
Operations menu. For information about creating offers in this way, see the IBM
Unica Marketing Operations and IBM Unica Campaign Integration Guide.

• If your system is configured so that offers are managed through the Campaign
version of the feature, then you use the Offers option from the Campaign menu.
For information about creating offers in this way, see the "Offers" chapter in the IBM
Unica Campaign User Guide.

Ask your system administrator which offer management option is configured on your
system.

N1070001

To create a marketing object
You must have the proper permission to add a marketing object. When you add a
marketing object, you become an owner of that marketing object.
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Marketing object types are specific to each organization. The marketing object types
that are available to you and how they are organized on the menus depend upon your
template creator.

1. From the menus, select the marketing object type that you want to create.

The list page for that marketing object type appears.

2. Click the Creation icon.

The Select a Template dialog box appears, containing all the templates available
for this marketing object type.

3. Select a template and click Continue.

The first step of the wizard for the selected marketing object template appears.

Each marketing object can contain any number of custom pages and fields. All
marketing object templates contain at least one page, with a name, membership
list, and security policy field, as a minimum.

4. Follow the wizard by filling in the information on each page.

5. When you have finished configuring your object, do one of the following.

• Click Finish to save the object. The system displays the list page for the
marketing object type, with the new marketing object included in the list.

• If you need to create another object that is similar to the one you have just
created, click Save and Duplicate. The current object is saved, and you then
see the Summary page of a new object, with data already populated. You should
change the default name, and then you can edit the new object as needed.

N1080001

About the marketing object cross reference
report

All projects and marketing objects contain a report describing cross references to and
from other marketing objects. This report appears on the Analysis tab, and is titled
Marketing Object Cross-Reference.

For projects, the report contains the following sections.

• Marketing objects referenced by this project

• Marketing objects modified by this project

For marketing objects, the report contains the following sections.

• Marketing Objects that Reference This Item: other marketing objects containing a
link to this marketing object.

• Marketing Objects that This Item References: other marketing objects to which this
marketing object links.

Version 8.5.0 177



11 - Marketing objects

• Projects that Modify This item: projects that can make changes to this marketing
object.

• Projects that Refer to This Item: projects containing a link to this marketing object

• Approvals that Refer to This Item: approvals containing a link to this marketing
object.

N1090001

About the modifies and references
relationships

Whether a project references or modifies a marketing object is determined by how the
template creator configured the marketing object reference field.

• Modifies: The project or marketing object that contains this marketing object is
intended to change or update the contents of a marketing object (a Change Order or
Work Request project, for example).

• References: The project or marketing object that contains this marketing object
does not modify it, but only references it.

N10A0002

Selecting marketing objects
When you select checkboxes on the Marketing Objects list page, IBM Unica Marketing
Operations retains your selections during a session, as follows.

• In View mode, your checkbox selections are retained until you navigate to a list
page for a different object. For example, if you make a selection on page 1 of a
multi-page project list, go to page 2, and then return to page 1, either by clicking the
page number at the bottom of the page or using the Recent menu, your selections
are retrained. However, they are discarded if you navigate to the Tasks page.

• If you edit a marketing object by clicking the Edit a Tab icon on the list page, your
selections are retained if you click Save and Return to List.

N10B0001

To delete marketing objects
You cannot delete a marketing object if a project or another marketing object is linked to
it. You must first remove the link before deleting the marketing object.

1. From the menu, select the marketing object type of the marketing object that you
want to delete.

2. Select the checkbox next to each marketing object that you want to delete.

3. Click the Delete this Item icon ( ) in the left-hand toolbar.
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4. When Marketing Operations prompts you to verify that you want to delete the
marketing objects, click OK.

You can also delete a marketing object from its Summary tab. To do so, click the Delete

this Item icon ( ) in the Marketing Operations toolbar.
N10C0001

To change the status of marketing objects
Each marketing object type is assigned a status. The status of a marketing object
changes during its life cycle. You can change the status of a marketing object, thereby
controlling its life cycle.

1. From the menu, select the marketing object type of the marketing object whose
status you want to change.

2. On the Marketing Objects List page, select the checkbox next to each item whose
status you want to change.

3. Click the Status icon and select one of the available statuses. A dialog box appears
in which you can add comments. If you select a status that cannot be changed later,
the system warns you that your change cannot be undone.

4. Enter any comments, and click Continue to close the dialog box and apply the new
status.

N10D0001

To add a marketing object reference to a
form or a grid row

Forms and grids can contain columns that hold references to marketing objects. IBM
Unica Marketing Operations makes it easy to find the specific marketing object to
reference in such a column.

1. Navigate to a form or a grid that contains a field or column to hold a marketing
object reference.

2. If the marketing object reference field is on a form, switch to the Edit tab.

In the Marketing Object reference field, click Select.

3. For a grid, perform one of the following actions:

• To add a new row: switch to Edit mode and click the Add Row icon. Then double
click the Marketing Object column cell.

• To edit an existing row: switch to Edit mode, then double click the Marketing
Object column cell.

A dialog box appears for the Marketing Object search.

4. Choose one of the tabs.
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• To perform a simple search for a marketing object: In the Search tab, enter
search criteria. The system searches all of the marketing object attributes to
match your criteria. Note that all attributes are searched except for attributes of
linked marketing objects.

• To use a predefined search for a marketing object: In the Browse tab, select a
predefined saved search.

The system returns the results of your search.

5. Select a marketing object and click one of the available buttons.

• To accept the selected object and close the dialog box, click Accept and Close.

• To accept the selected object and continue selecting objects, click Accept.

• To close the dialog without choosing the selected object, click Close.

The marketing object you selected appears in the marketing object reference field. If
you selected more than one object, and the field accepts multiple marketing objects,
then all the objects you selected are listed.

Note the following.

• For simple searches, attributes of linked marketing objects are not searched.

• Fields that hold marketing object references can be set up so they are limited to
holding one particular type of marketing object, such as Offer Letters. In this case,
the Browse tab contains only those saved searches that apply to that particular
marketing object type.

Related Topics
• To perform an advanced search (except for assets)

N10E0001

About marketing object references in
approvals

You add marketing object references to approvals in the same way you add them to
forms and grid fields. However, the search process is slightly different.

Simple search (Search tab)
The simple search screen in the marketing object selection box for approvals contains
one extra drop-down list box. Use this box to filter the search to a particular marketing
object type. You must select an entry in this box, or your search cannot proceed.

Saved search (Browse tab)
The drop-down list of saved searches contains all the saved searches for all enabled
marketing object types in your system. For example, if you have Creatives and
Envelopes, saved searches that apply to either Creatives or Envelopes appear in the
list.

180 IBM Unica Marketing Operations - User's Guide



About marketing object references in approvals

Related Topics
• To add a marketing object reference to a form or a grid row
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12 Assets and asset
libraries

■ Assets and asset libraries
■ About asset libraries
■ To change from the asset list view to the thumbnail view
■ To add an asset
■ New asset page
■ To edit an asset
■ About asset versions
■ To add a new version of an asset
■ Asset statuses
■ To change the status of an asset
■ To view an asset
■ To view history of an asset
■ To add an asset folder
■ Deleting assets
■ To move assets and folders from the asset list page
■ To move an asset from within the asset

N110001

Assets and asset libraries
IBM Unica Marketing Operations provides centralized management, secure storage,
and web-based access for digital assets.

About Assets
In IBM Unica Marketing Operations, you store your assets in libraries.

• An asset library is the highest level organizational structure in the digital asset
repository.

• You can access libraries and add assets to the libraries if your Marketing Operations
administrator granted you permission in the security policy assigned to the asset).

• You can organize assets using folders.

• You can view all the assets that you own.

182 IBM Unica Marketing Operations - User's Guide



About asset libraries

• If you do not own an asset, you can view it when it has a status of finalized.

• You must have administrative access to Marketing Operations to create a library.

You can view assets in a library in either a list view or thumbnail view. By default, IBM
Unica Marketing Operations displays assets in a list view when you select an asset
library.

View Description

Asset List Displays all the assets in the current library, listed alphabetically in ascending
order. Change the order by clicking once on the Name column.

To sort by any of the other columns, click that column. Click the column a second
time to change the order of the column from ascending to descending.

Asset Thumbnails Displays a thumbnail image for each asset in the library. Note that you can upload
a thumbnail image for an asset when you add the asset to a library.

Related Topics
• To view an asset

• To change the status of an asset

• To change from the asset list view to the thumbnail view

N10F0001

About asset libraries
Digital assets are stored in libraries, which are the top-level organizational structure in
the digital asset repository. You can access libraries and add assets to the libraries. You
can only access a library if your IBM Unica Marketing Operations administrator granted
you permission in the security policy assigned to the asset.

After you click the library that contains assets or folders you want to view, the Asset List
page appears.

You must have administrative access to IBM Unica Marketing Operations to create a
library.

N1100001

To change from the asset list view to the
thumbnail view

By default, IBM Unica Marketing Operations displays assets in a list view when you
select an asset library. To change to a thumbnail view, perform the following steps.

1. Open IBM Unica Marketing and select Operations > Assets.

A list of all available asset libraries displays.

2. Select an asset library from the list.
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A list of assets in the current library displays.

3. Click the List View Mode icon ( ) and select Asset Thumbnails.

The thumbnails view appears. For all assets that have an associated thumbnail image,
the thumbnail is displayed next to the asset.

N1110001

To add an asset
1. Log into IBM Unica Marketing.

2. Select Operations > Assets.

A list of libraries appears. An administrator created these libraries to organize the
assets.

3. Click the library that you want to contain the new asset. The library opens. If it
contains folders, they appear at the top of the screen.

4. If the library contains folders, navigate to the folder that you want to contain the
asset.

5. Click the Add Asset icon ( ).

The New Asset screen appears.

6. Complete the New Asset screen.

7. Click Save Changes to create the asset.

The asset appears with a status of Draft.

Related Topics
• New asset page

N1120001

New asset page
When you add a new asset, the system displays the New Asset page.

Field Description

Asset Name Enter a descriptive name for the asset.

Description Enter a short, text description for the asset.

Owner(s) Click Add/Remove Members to use the Select Owners dialog to designate
additional asset owners.
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Field Description

Asset Code To manually enter a code for an asset, clear the Auto-generate on save box.
Then, type a code for the asset. The code can be any alpha-numeric string.

To have Marketing Operations automatically create an asset code, leave the
Auto-generate on save box checked.

You can configure Marketing Operations to generate a code according to an
algorithm your administrator specifies.

Keywords Enter any keywords for the asset, separated by commas. When users search on
these keywords IBM Unica Marketing Operations retrieves this asset.

Usage guidelines Enter any guidelines for how you want people to use this asset. For example, if it
is a logo, you can let users know where this type of logo should appear.

Expiration date Enter an expiration for the asset or select the arrow in the drop down list to
choose a date from the calendar.

After you enter a date you can use the arrow button to incrementally move the
forward or back.

Marketing Operations sends a notification to the owners upon expiration, but
the status of the asset does not automatically change to expired. At the
expiration date you should archive the asset or change the expiration date.

Version name Enter the version number of the asset. Note the following.

• This field defaults to version 1.0.
• Each version you add after this, by default, increments the version number.
• To override the default value, enter your own version number.

Files Click Upload to open the Add Asset Files dialog. Check one or more of the
checkboxes.

• File: specify the file for your asset. This field is required.
• Preview File: You may want users to access the preview file for reasons of

security, speed, or convenience. For example, if the source file is a Photoshop
file, you may want to provide a PDF file as your preview file so that users who
do not have Photoshop can still see it. Unica recommends you use a PDF,
GIF or JPEG file as a preview of the asset. This field is optional.

• Thumbnail File: You can upload a smaller version of the file that users see
when they open the asset or when they view their library using the Asset
Thumbnails view. This field is optional.

For each box you check, browse to the appropriate file and add it to the Add Asset
Files dialog box.
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Security considerations
For more information on setting up security to allow some users to only view the
preview of an asset, see the IBM Unica Marketing Operations Administrator’s Guide. If
you have security concerns, consider watermarking the preview file, using a low-
resolution version, or using some other method that protects the file and does not allow
copying and saving of the file.

N1130001

To edit an asset
If you upload a new file while editing, it replaces the previous file but does not create a
new version of the asset. It is the same version as before you edited it, even if you
change the Version Name field to a higher number. This allows you to correct the file if
you accidentally added the wrong one previously.

You can only edit assets in draft state.

1. Select Operations > Assets.

2. Select the library that contains the asset you wish to edit.

3. Click the asset you want to edit.

4. Click the Edit icon ( ) and change any of the fields on the page.

5. Click Save Changes when you finish editing.

The asset is saved, with the same version number it had before the editing session.

Related Topics
• To add an asset

• To add a new version of an asset

N1140001

About asset versions
Rather than replace an existing asset, you can add a new version of the asset. Note the
following.

• You can download, preview, or delete older versions of an asset in the Version
History section.

• If you delete the current version of an asset, the previous version becomes the
current version.

• The current version of an asset displays when users navigate the library and try to
attach assets.

• You cannot delete an asset version if it is the only version of the asset.
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Related Topics
• To add a new version of an asset

• To edit an asset

N1150001

To add a new version of an asset
Rather than replace an existing asset, you can add a new version of the asset.

1. Select Operations > Assets.

2. Select the library that contains the asset you wish to edit.

3. Click the asset for which you want to add a new version.

4. Click the New Version icon ( ) and change any of the fields on the page.

The Version Name field automatically increments to the next version number.

5. Click Upload under File to upload the new version of the asset.

6. Upload files for the asset. You must at least upload a source file.

7. Click Save Changes to create the asset.

Optional result of the task.

The asset is saved, and the version number is incremented.

Related Topics
• To add an asset

• To edit an asset

• About asset versions

N1160001

Asset statuses
You must own an asset to change its status, or have the proper security permissions.
An asset can have any of the following statuses.

Status Description

Draft Indicates the asset is in a draft state. All owners can edit the asset, but other
users cannot view it nor select it as an attachment.

When you first add an asset, it has a status of Draft.

Locked Indicates the asset is in a locked state. No one can edit the asset until it is
unlocked.

You may want to lock an asset if for some period of time, you do not want anyone
to edit the asset.
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Status Description

Finalized Indicates the asset is finalized. Everyone with permission to do so can access the
asset (and attach it to a business process), but no one can edit it.

Archived Indicates the asset is no longer available. No one can access the asset nor
retrieve it.

If this asset has been attached to an object (such as a project or plan), it is still
available from that object.

Related Topics
• To change the status of an asset

N1170001

To change the status of an asset
1. Select Operations > Assets.

2. Select the library that contains the asset you wish to edit.

3. Click the asset whose status you wish to change.

4. Click the Status icon ( ) and select one of the available statuses.

Related Topics
• Asset statuses

N1180001

To view an asset
Once an asset has a status of Finalized, all authorized users can view and use the
asset.

1. Select Operations > Assets.

2. Select the library that contains the asset you wish to view.

3. Click the asset you wish to view.

4. Perform one of the following actions.

• To view the asset, click Download next to the asset file.

• To preview the the asset, click Preview. Use this option if you do not have
permission to download assets or you are not sure if this is the asset you need.

• To save the asset file or the preview file and download it to your computer, right-
click the Download or Preview link and select Save Target As to save the
corresponding file. Browse to the location where you want to save the file and
click Save.
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5. Close the window that contains either the downloaded file or the preview when you
finish viewing the asset.

Related Topics
• About asset versions

• Assets and asset libraries

N1190001

To view history of an asset
When an asset has a status of Finalized, all users who have permission to do so can
view the asset’s revision history and download history. Owners can view the revision
history when the asset has any status.

1. Select Operations > Assets.

2. Select the library that contains the asset you wish to view.

3. Click the asset you wish to view.

4. Click the Analysis tab.

The revision history for the asset appears.

The revision history displays status changes for the asset, version changes, updates
to fields in the asset, and any comments entered during the changes.

5. Select Download History in the View field to view the download history for the
asset.

The download history displays the date, time, file name, user who downloaded it, and
the version of each asset that the user downloaded by clicking the Download link.

N11A0001

To add an asset folder
Use folders as a way to organize assets in a library. You must have permission to
create folders before you can add them.

1. Select Operations > Assets.

2. Select the library to which you want to add a folder.

3. Click the Add Folder icon ( ).

The New Folder page appears.

4. Enter a name and a description for the new folder.

5. Click Save Changes.

The folder opens. You can now add or move assets into this folder.
N11B0001
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Deleting assets
Asset folders have the following characteristics.

• From within any library, you can delete assets and folders, if you have the proper
security permissions.

• You can delete only empty folders.

• If you have permission to delete assets as an owner of the asset, but some other
security role that you are in only allows you to delete assets if you inherit that delete
permission from another role, you cannot delete an asset from the list of assets: you
can only delete the asset from within the asset itself.

• Asset folders do not have owners. Different owners can own different assets in a
folder, therefore the permission to delete an asset folder is not based on ownership.

Related Topics
• To delete assets and folders from the asset list page

• To delete an asset from within the asset

N11E0001

To delete assets and folders from the asset list
page
From the asset list page, you can delete multiple assets and empty asset folders.

1. Select Operations > Assets.

2. Select the library that contains the assets and folders you wish to delete.

3. Select the checkboxes next to all the folders and assets you want to delete.

You cannot delete asset folders unless they are empty.

4. Click the Delete Selected Items icon ( ).

5. Click OK when IBM Unica Marketing Operations prompts you to confirm the
deletion.

The selected assets or folders are removed.

Related Topics
• Deleting assets

• To delete an asset from within the asset

N11F0001

To delete an asset from within the asset
1. Select Operations > Assets.

2. Select the library that contains the asset you wish to delete.
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3. Click the asset you wish to delete.

4. Click the Delete Selected Items icon ( ).

5. Click OK when IBM Unica Marketing Operations prompts you to confirm the
deletion.

Related Topics
• Deleting assets

• To delete assets and folders from the asset list page

N11C0001

To move assets and folders from the asset
list page

From within any library, you can move assets and folders, if you have the proper
security permissions.

1. Select Operations > Assets.

2. Select the library that contains the assets and folders you wish to move.

3. Select the check boxes next to all the folders and assets you want to move to a
particular destination.

To move assets to a different location, repeat this procedure for each different
destination.

4. Click the Move this Item icon ( ).

5. Select the destination directory and click Save Changes or double-click the
destination directory.

The destination directory opens with the folder or asset displayed in it.

Related Topics
• To move an asset from within the asset

N11D0001

To move an asset from within the asset
If you have permission to move assets as an owner of the asset, but some other
security role that you are in only allows you to move assets if you inherit that move
permission from another role, you cannot move an asset from the list of assets: you can
only move the asset from within the asset itself.

1. Select Operations > Assets.

2. Select the library that contains the asset to move.
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3. Click the asset to move.

4. Click the Move this Item icon ( ).

5. Select the destination directory and click Save Changes or double-click the
destination directory.

The destination directory opens with the folder or asset displayed in it.

Related Topics
• To move assets and folders from the asset list page
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13 Budgets

■ Budgets
■ Budget funding
■ Effects of deleting links between plans, programs, and projects
■ Budgets and accounts
■ Budget views
■ The Plan Budget tab
■ The Program Budget tab
■ The Project Budget tab
■ Budget allocation versions
■ To allocate funds
■ To allocate funds for standalone programs and projects
■ To add or edit line items
■ Budget line item approvals

N330001

Budgets
In IBM Unica Marketing Operations, a budget allows you to plan expenses that will
occur as you execute your plan, program, or project. After setting the plan budget, you
can fund linked programs, and ultimately projects, from it. Marketing Operations tracks
budgets of child programs and projects in the form of allocations, forecasted or
committed spending, and actual expenses.

IBM Unica Marketing Operations tracks budgets of child programs and projects,
although these objects may have different owners. For example, a program linked to a
plan may have a different owner than the plan itself. As such, the person who allocates
a budget from a plan down to a program may be different from the person forecasting
expenses from a program up to a plan. Marketing Operations allows a plan owner—a
marketing manager for example—to track of expected expenses from child programs
and projects as well as the plan budget itself, and remain responsive to budgetary
needs.

Budgets are available only when the Marketing Operations financial module is
enabled.
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Fiscal year
You can view the total budget for all years, or see a detailed view for a particular year
broken down into weeks, months, or quarters.

IBM Unica Marketing Operations keeps budget information for the current fiscal year,
the next two fiscal years, and any past fiscal years dating back to when you first
installed Marketing Operations.

On the plan level, to view or edit a different fiscal year, change the Fiscal Year field
value on the Plan Summary tab. Linked programs and projects take the financial year
from the parent plan; standalone programs and projects use the system's current fiscal
year.

Granularity
IBM Unica Marketing Operations allows you break fiscal years into weeks, months, or
quarters. When creating a new plan, program, or project, choose the desired increment
from the drop-down Budget Granularity on the Summary tab.

Users is not allowed to edit budget granularity. Plans, programs and projects with
different budget granularities are not allowed to be linked together.

For example, if a plan’s fiscal year is broken into months, you can link it only with
programs and projects with months as the budget granularity; in this scenario, programs
and projects with weeks or quarters as their granularity are unavailable for linking.

For more information about linking plans, programs, and projects, see To link and
program to a plan, To link an existing project to a program, and To link a child project or
request to a project.

N1200001

Budget funding
Although you can plan your budget using either top-down or bottom-up methods, the
flow of actual money travels down the linked plan, program, project hierarchy.
Regardless of how you plan your expenses, plans fund programs, which fund projects,
which in turn fund any child or sub-projects.
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For more information about budget planning, see Top-down budget planning and
Bottom-up budget planning.

Since standalone programs and projects are not linked to plans, they have their own
budgets which you enter directly on their respective budget tabs.

N12A0001

Top-down budget planning
"Top-down" planning is particularly useful if a plan has predictable expenses from year
to year.

For example, if every year you create a plan called New Product Launch which includes
tradeshows, you can create programs such as Tradeshow 1, Tradeshow 2, and so on,
and assign funds to each program.

The Tradeshow 1 program may include a project called New Customer Acquisitions,
and as such, you can allocate funds from Tradeshow 1 to make New Customer
Acquisitions successful. Since the flow of funds is from the plan down to associated
programs and projects, top-down planning is highly useful and very easy.

In summary, you manage budgeting from plans down to programs and projects in the
following way.

1. Allocate funds to the plan budget.

2. Allocate funds from the plan budget its child programs.
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3. Allocate funds from the programs to it child projects, which are grandchildren of the
plan.

4. Allocate funds from the projects to it child sub-projects, which are great-
grandchildren of the plan.

N12B0002

Bottom-up budget planning
In contrast to top-down budget funding, "bottom-up" budget funding is particularly useful
if you are not sure how much funding to allocate down from the plan to child objects, but
can forecast line items for the programs and projects. After predicting all project
expenses, you can roll them up to parent programs, and ultimately, to plans.

Using the previous example, if you can predict the line item expenses of the New
Customer Aquisition project in your Tradeshow 1 program, you can finilize those line
items to roll them up into Tradeshow 1's expenses. Then, add additional line item
expenses to Tradeshow 1 if necessary and finalize them to roll expenses for Tradeshow
1 up to the parent plan, New Product Launch. Starting from the bottom-most level,
continue to add expenses to projects, programs, and plans until the parent plan
accounts for all necessary allocations.

In summary, you manage budgeting from projects up to programs and plans in the
following way.

1. Create projects and forecast their line item expenses.

2. Link the projects a parent program and plan.

3. Finalize the line items on each of the plan's child objects to roll the expenses up.
You can now see how much funding the programs and projects need for successful
completion.

N1210001

Effects of deleting links between plans,
programs, and projects

In general, removing the link between a parent object and a child object affects the
budgets of both objects in the following ways.

• The parent object no longer allocates money to the child object.

• The expenses for the child no longer count against the parent.

• Funds allocated from the parent remain with the child, but have no source. In other
words, the child object still accounts for having the money, but the parent object no
longer accounts for giving it.

For example, removing the link between a program and a plan affects the budgets of
both objects in the following ways.

• The plan no longer allocates money to the program, so the budget for the
corresponding program area is decreased accordingly.
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• The expenses for the program no longer count against the plan.

• The program still accounts for funds formerly allocated from the plan, so these funds
either need to be removed from the program or funded from another source.

N1220001

Budgets and accounts
In IBM Unica Marketing Operations budgets and accounts have no predetermined
relationship. Accounts represent the financial element of an organization, while budgets
represent the marketing side. Typically the financial element is not granular enough to
capture marketing needs in detail. Budgets make up for this lack. A plan, program, or
project may be funded from one or more accounts.

For more information on accounts in IBM Unica Marketing Operations, see About
accounts.

N1230001

Budget views
IBM Unica Marketing Operations offers two budget views on all budget tabs.

• Total view ( ) is the default. It displays the total amount budgeted and remaining
for forecasted, committed, and actual spending, across all fiscal years of a plan,
program, or project’s existence.

• Detailed view ( ) displays budget information for a specified fiscal year broken
down by week, month, or quarter.

Across all of the budget tabs for a plan, its child programs, and their child projects, the
totals displayed reflect the total amounts for the life of the plan, program, or project.
Therefore, the individual rows and columns in edit screens or the detailed view often do
not add up to match the values displayed in the total view; this is not an error, but
reflects the fact that the data, other than the total, corresponds to values for the
currently selected fiscal year.

The views on the budget tab depends on the in-use budget allocation version. By
default, you navigate to the budget tab of an object for the first time after login, the
in-use version of the current fiscal year displays. The total view shows totals for the
in-use version for all previous fiscal years and the current in-use budget allocation
version. Detailed view also shows information based on the in-use budget version.
For more information, see Budget Versions.

N1240002

The Plan Budget tab
From top to bottom, the Plan Budget tab contains the following tables.
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• The Plan Budget Summary table provides an overview of the entire budget.

• The Program Cost Summary table shows allocations to child programs.
N12D0002

Plan Budget Summary table
The Plan Budget Summary table is the topmost table on the budget tab of a plan and
summarizes funds that you expect to spend in the plan and the programs it contains.
The Plan Budget Summary table monitors finances for the entire plan.

• Plan Budget is the total budgeted amount.

In total view, the Plan Budget Summary table displays the total budget for the plan’s
entire life; detailed view separates it into increments of the currently-selected fiscal
year. Change the fiscal year on the Summary tab if necessary.

• Program Allocations shows the total budget of all the plan's programs.

• The Forecast Total is all predicted spending across the plan.

• The Committed Total is all the money spoken for in the plan up to this point. Even
though the money is not yet spent, the committed total represents costs that will
occur even if the plan is terminated.

• The Actual Total is all funds spent so far on the plan. IBM Unica Marketing
Operations calculates the actual amount spent through the invoice functions. This
total is likely to be much lower than the others due to time lags between planning
expenses and actually paying bills.

The Remaing column
In each row, the Remaining column is the difference between the Plan Budget and the
entry in the Amount column. For example, IBM Unica Marketing Operations calculates
the forecast remainder by subtracting the forecast total from the Plan Budget.

Although calculated by a simple subtraction, the Remaining column provides high-level
information and potential warnings about the financial state of the plan's budget. The
remaining column summarizes how much money has already been allocated or planned
for use, how much remains for additional spending, and how much you could recover if
you cancelled unfinished efforts.

• In the Program Allocations row, the Remaining column represents additional
money the plan owner has left to distribute to existing or not-yet-created programs. If
the total allocation of funds to child programs exceeds the total budget of the plan,
the remainder is negative and the plan will need more funding to successfully
complete the programs.

• In the Forecast Total row, the Remaining column indicates the amount of money
the plan owner will have left if current forecasts are accurate. If the figure is
negative, the plan will need more funding to succeed at expected costs.
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• In the Committed Total row, the Remaining column indicates how much money
the plan owner will have left if the plan and all its programs and projects are
cancelled. The plan owner needs to understand how much money can be returned if
associated programs do not continue to execute, in the event that budgets are
tightened.

• In the Actual Total row, the Remaining column represents the real balance that the
plan owner has at the current time. This figure may be useful for monitoring cash
flows, though it is likely lower than the forecast total or committed total remainder,
simply due to the time lags between planning expenses and paying bills.

This topic specifically references the Plan Budget summary table. Programs and
projects also have a Budget Summary table with the same layout and information on
their respective Budget tabs.

N12E0002

Program Costs table
The Program Costs table is underneath the Plan Budget Summary table on the plan's
Budget tab. The table rows list programs by area; the columns provide figures for
Actual, Committed, Forecast, and Allocated spending.

On the Plan Budget tab, the program costs table only shows programs without breaking
them down into their respective projects. However, even though you do not see the
project expenses directly, IBM Unica Marketing Operations accounts for them through
their parent programs.

The program name in each row of the Program Costs table provides a direct link to that
program's budget. This link is particularly helpful because the Program Budget tab
provides a breakdown of its child-project expenses in the corresponding Project Costs
table.

This topic specifically references the Program Costs table on the plan Budget tab.
Program and project Budget tabs also have a Costs table detailing expenses for
their respective child-objects with the same layout and information.

N1250002

The Program Budget tab
The Program Budget tab is very similar to the Plan Budget tab, but one level down the
plan, program, project hierarchy. While the Plan Budget tab breaks down into
information about linked programs, the Program Budget tab breaks down to information
about linked projects. The Program Budget tab also contains an additional table about
the program's line items.

After budget ancestors, from top to bottom, the program Budget tab contains the
following tables.

• The Program Budget Summary table provides an overview of the entire budget.

• The Project Cost Summary table shows allocations to child projects.
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• The Line Item Details table organizes line items for the program.
N12F0001

Navigating with budget ancestors
At the top of the Budget tab for projects and programs, Parent Budget(s) shows a
hierarchical view of the current object, its parent, and all ancestors back to its root plan.
The name and ID code displays for each object as well as direct links to each of the
ancestor objects.

Use these links for easy navigation through the plan, program, project budget hierarchy.
N1300002

Program Budget Summary table
The Program Budget Summary table is the topmost table on the Budget tab of a
program, and summarizes funds that you expect to spend in the program and the
projects it contains. The Program Budget Summary table monitors finances for the
entire program.

In total view, the Program Budget Summary table displays the total budget for the
program's entire life; detailed view separates budget information into increments for the
currently-selected fiscal year and up to two previous fiscal years.

The Program Budget Summary table contains the same data as the Plan Budget
Summary table, except on the program level. For more information about the table's
fields and their meanings, see Plan Budget Summary table.

N1310002

Project Costs table
The Project Costs table, found on the Program Budget tab, lists total costs associated
with all of the projects that this program contains. It has the same layout and information
as the Program Costs table on the Plan Budget tab.

For more information, see The Program Costs table.
N1320002

Program Line Item Details table
The Program Line Item Details table is the third table found on the Program Budget tab.
It summarizes line item information entered for individual expenses on the program
level; these expenses belong to the program itself, not the projects linked to it. This
table works with invoices to track spending. For more information about line items and
invoices, see About rolling up line items.

If the program requires approvals for line items, the Line Item Details table shows the
approval status for each line item in the second column.

• = In Progress

• = On Hold
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• = Cancelled

• = Completed

This topic specifically refers to the Program Line Item Details table on the Program
Budget tab. Projects also have a Line Item Details table with the same information
and layout on their Budget tabs.

N1260002

The Project Budget tab
The Project Budget tab has exactly the same tables, layout, and information as the
Program Budget tab, except down one level in the plan, program, project, sub-project
hierarchy. While the Program Budget tab breaks down into information about linked
projects, the Project Budget tab breaks down to information about sub-projects if the
project has any.

After budget ancestors, from top to bottom, the Project Budget tab contains the
following tables.

• The Project Budget Summary table provides an overview of the entire budget.

• The Sub-project Cost Summary table shows allocations to child projects.

• The Project Line Item Details table organizes line items for the project.

For more information, see Plan Budget Summary Table for the Project Budget
Summary table, Program Costs table for the Sub-project Cost Summary table, and
Program Line Item Details table for the Project Line Item Details table.

N1270002

Budget allocation versions
Budget allocations versions are a powerful tool for financial planning. Budget allocation
versions allow you to explore different financial possibilities without overwriting the
previous budget. You can create multiple budget versions with different allocations for
expenses, compare versions, and then chose the most appropriate one for the plan,
program, or project.

Use the options on the budget version drop-down list( ) to create, delete, and
compare potential budgets until you find the best fit for your plan, program, or project.
Then activate or finalize that version to mark it "in-use;" IBM Unica Marketing
Operations rolls the allocations from the in-use version up to linked parent objects and
down to linked child objects.

The budget version drop-down ( ) also lists all budget versions. The name of the
budget version you are currently looking at is shown in red. The name of the in-use
version is marked with a "^."
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Budget versions account for different allocations, not different line items. Adding a
line item to one budget version adds the item to all versions. However, you can use
budget versions to determine how much to allocate to the line items. Budget
versions allow you to explore the effects of spending different amounts of money on
the same expenses. For more information, see Program Line Item Details table and
To add or edit line items.

To view and comapare budget versions, you must have the security permission
"view budget tab." To create, edit, delete, update, and mark in-use, you must have
the security permissions "edit budget tab."

N1340002

To create budget versions
Create different budget versions for financial forecasting of different scenarios. Then
you can chose the most appropriate budget by comparing them.

1. Navigate to the budget tab of the plan, program, or project.

2. Click the versions icon ( ). Chose the new version option most helpful to you
from the drop-down list.

• Create a new version creates a blank allocation version and opens it in edit
mode.

• Copy Current Version copies allocation data from the version currently being
viewed and opens it in edit mode. This method is particularly helpful for making
subtle changes between versions.

• Copy Version From Different FY opens a popup on which you can chose to
copy any version from any fiscal year and opens the copy in edit mode. This tool
is particularly useful if the budget you're working with will closely resemble the
one for a prior fiscal year; for instance, if the budget decreased significantly from
year A to years B and C, but year D's budget will resemble year A, you can copy
that budget and use it as a starting point.

3. Give the new version a unique, descriptive name.

IBM Unica Marketing Operations's default names are of the form "version #x," where
x is one greater than the number of versions currently existing in that fiscal year.
Version names must be unique within each financial year, but you can have the
same name in different fiscal years.

4. Enter or edit allocations for the new budget version.

5. Click Save and Finish to return to the Budget tab. You can now access the new
version from the versions drop-down list.

N1350002
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To delete versions
You cannot delete the currently selected version or in-use version. If you wish to delete
the in-use version, you must first mark a different version as in-use.

To create, edit, delete, update, and mark in-use, you must have the security
permissions "edit budget tab."

1. Navigate to a version other than the one you wish to delete by clicking on its name

in the version ( ) drop-down list. The name of the currently selected version
appears in red on the drop-down list.

2. Select the checkbox next to the names of one or more versions to delete.

3. Without leaving the drop-down list, click Delete Selected Version(s).

4. When prompted, click OK to confirm the deletion.
N1360002

To compare versions
This tool allows you to view the allocations for up to six budget versions on the same
screen and is very useful when selecting the most appropriate one.

1. Navigate to the version to which you want to compare others by clicking on its name

in the versions ( ) drop-down list. The name of the currently selected version
appears in red on the drop-down list.

2. Select the checkbox next to the names of up to five other versions in the drop-down
list.

3. Without leaving the drop-down, click Compare Current with Selected.

The comparison screen appears. Colors differentiate each budget version. Red
arrows indicate whether the allocations for each area are higher or lower than the
current budget. While comparing, you can show and hide versions using + and -to
isolate specifc versions in the comparison.

4. Once you finish comparing, click End Comparison in the yellow box at the top of
the screen.

N1370002

To mark a version in-use
IBM Unica Marketing Operations considers the active or finalized budget version of a
plan, program, or project "in-use" and rolls this version down to linked child objects and
up to linked parent objects. When working with budget versions, please note the
following.

• Only one version can be active or finalized at a time.

• The default budget version is active and in-use for new plans, programs, and
projects.
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• After you finalize a version, you can no longer activate versions.

• After you finalize a version, you can finalize a different version, but you cannot
remove the finalized status from all versions. After you finalize one version, one
version from that fiscal year will always have finalized state.

If upgrading to IBM Unica Marketing Operations 8.5.0, the previously existing budget
will automatically be finalized.

1. Navigate to the version you want to activate or finalize by clicking on its name in the

versions ( ) drop-down list. The name of the currently selected version appears
in red on the drop-down list.

2. Click Make Current Version Active or Finalize Current Version from the versions
drop-down list.

The version is marked active or finalized and is in-use. On the drop-down list, the in-use
version is marked with "^" before the name.

To create, edit, delete, update, and mark in-use, you must have the security
permissions "edit budget tab."

N9E0001

To allocate funds
A parent plan, program, or project allocates funds down to individual child programs and
projects contained within it. Plans fund programs, programs fund projects, and projects
fund sub-projects.

Add and edit allocations on the parent’s Budget tab. Begin by allocating money to a
plan, then allocate down the program, project, sub-project hierarchy using the same
procedure.

In this task, parent object refers to the plan, program, or project from which you are
allocating funds. Child object indicates the next level down in the plan, program,
project, sub-project hierarchy. For instance, if allocating from a program to a project,
the program is the parent object and the project is the child object.

1. Navigate to the Budget tab for the parent object from which you want to allocate
funds.

2. Select the allocation version you want to edit or create a new allocation version.

3. Click the Allocations icon ( ) to modify allocations to the child project.

The Cost Summary table appears opens in edit mode.

• If you are working below the plan level, the first row of data is bold and controls
allocations for the objects line items. See To add a program, project, or sub-
project budget line item.
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• The table lists the child objects in normal font below the parent’s line items.

4. Add or edit allocations by clicking cells in the table and entering the appropriate
value by week, month, or quarter.

• For reference, the topmost row shows total funding for the parent object from
which you are allocating funds for each week, month, or quarter.

• The Remaining column shows how much money will be left in the parent object’s
budget with the current allocations.

5. Click Save and Finish to save your work and return to the Budget tab.

To continue funding, click on a child object in the Total Costs table to navigate to its
Budget tab. Repeat the process by allocating funds from the new object to its child
objects.

If you need to link additional parent and child objects, do so on the Summary tab
and then return to the Budget tab to allocate funds to the new child objects.

N1280001

To allocate funds for standalone programs
and projects

A standalone program or project is not linked to a parent plan. When you create a
budget for a standalone program, the budget reflects costs associated with the program
itself and any costs associated with any projects linked to the program.

For standalone programs, the fiscal year is assumed to be the current year defined
by the system clock.

1. Navigate to the Budget tab for the standalone program or project.

2. Allocate money directly in the total budget row at the top of the table.

This row is only editable for standalone programs and projects; linked programs
and projects have a read-only total budget row because they receive funding
from parent objects.

3. Click line items ( ) and add line items as needed. For more information, see To
add or edit line items.

4. Enter a budget amount for each week, month, or quarter.

5. Click Save and Finish to return to the Budget tab.

The system populates total budget row at the top of table with the information you
entered.

N9F0001
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To add or edit line items
Line items outline the forecasted and committed costs for a program, project, or sub-
project so a manager knows if the budget they have been allocated or plan to ask for is
sufficient. Additionally, forecasted and committed amounts, once finalized, roll up to the
accounts affected, providing visibility into budget and cash flow needs for higher level
objects.

1. Navigate to the program, project, or sub-project Budget tab.

2. Click the Line Items icon ( ). The Edit Program/Project/Sub-Project Line Items
page appears.

3. To add a new line item, double click an empty cell in the Item Description column.
Enter an item name or description.

The # field populates automatically once you have begun to enter an item in the
Item Description field.

To edit a line item, double click on it in the Item Description column and make
changes as necessary.

4. If the line items table contains custom text fields, enter appropriate values.

5. In the Expenditure Date field, enter the anticipated date that funds will be spent.
Click the arrow to launch a pop-up menu from which you can select a date. You
must enter an expenditure date for the budget to be finalized.

To track a certain expense on different dates, you should use separate line
items. For example, to track the expense for Printing in May, June, and July,
enter three separate line items, one for each month.

6. Select a source account from the Source Account drop-down menu. The funds for
this program, project, or sub-project are posted against the account you choose
when the line items are finalized.

7. Select a cost category from the Cost Category drop-down menu.

8. In the Committed Amount field, enter any committed funds related to the line item.
Leave this field blank if no portion of the line item is committed.

9. In the Forecast Amount field, enter the amount that you predict or forecast the line
item will cost.

10. Click Save and Finish to save your changes and go to the object’s Summary tab.

IBM Unica Marketing Operations totals the line items, but they are not rolled into the
parent object's budget until you finalize them. Finalizing line items may require approval.
For more information, see To finalize budget line items.

Adding line items to one budget version adds them to all budget versions. For more
information, see Budget versions.
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N1380001

To finalize budget line items
When you finalize budget line items for projects or programs that are linked to a parent
program or plan, the forecasted and committed line item amounts roll up to the parent
program or plan.

If the project or program requires line item approval, finalizing the line items triggers the
approval process. When a line item requires approval, it only rolls up to the parent
program or plan after completeing the approval process. The first column of the Line
Item Details table shows the approval status; for more information, see Program Line
Item Details table.

In order to finalize line items, they must have an assigned expenditure date.

Finalizing line items and finalizing budget allocation versions are unrelated. Finalize
line items to roll them up to all budget versions, then activate or finalize the most
appropriate budget version to use for your plan, program, or project. For more
information, see Budget versions.

1. Add budget line items. For more information, see To add or edit line items.

Finalize and Discard Changes links appear on the budget tab.

2. Navigate to the object's Budget tab and click the Finalize link.

• If the program or project does not require line item approval or if the line item is
automatically approved because of rules your administrator established in the
object's template, IBM Unica Marketing Operations prompts you to confirm that
you want to finalize your changes.

• If any or all line items require approval, IBM Unica Marketing Operations
prompts you to send the approval; for more information on the approval process,
see Approvals. Line items that require approval are only roll up to the parent
object after the approval process is completed.

3. Click OK to finalize your changes or send the approval. Click Cancel if you do not
want to finalize changes or send approvals.

Once the budget line item changes are finalized, and approved if required, they roll up
to their parent objects.

Related Topics
• To add or edit line items

• To discard budget line items

N13A0001

To discard budget line items
Instead of finalizing budget line item edits, you can discard all changes made since the
last time you finalized budget line items.

1. Add budget line items. For more information, see To add or edit line items.
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Finalize and Discard Changes links appear on the Budget tab.

2. Click Discard Changes.

IBM Unica Marketing Operations prompts you to confirm that you want to discard
your changes.

3. Click OK.

IBM Unica Marketing Operations discards the changes that you made to budget line
items since the last time you finalized them and restores the previous finalized version
of the budget line items. Marketing Operations does not trigger the approval process.

Related Topics
• To add or edit line items

N1290002

Budget line item approvals
Depending on rule criteria your administrator establishes in project and program
templates, budget line items may be automatically approved or sent through IBM Unica
Marketing Operations's approval process. For example, your administrator might define
rules based on the line item's expenditure date, source account, or cost category. Your
administrator can also select default approvers for each rule, such as object or account
owners. If your administrator has written these rules in your organization's project and
program templates, then budget line items must be approved, either automatically via
rules or by the assigned approvers, before they are finalized and roll up to the parent
program or plan. However, if your projects and programs use templates that do not
contain budget line item approval rules, the functionality works as it did before IBM
Unica Marketing Operations 8.5.0 and line items can be finalized directly on the object's
budget tab without going through an approval process in Marketing Operations.

Approval status for line items can be seen on the object's budget tab in the second
column of the Line Item Details table.

• = In Progress

• = On Hold

• = Cancelled

• = Completed

Once an approval is sent, you may or may not be able to edit the line item.

• If the approval status is cancelled or completed, the approval can be edited.
Finalizing any changes to the updated line item may trigger a new approval process.

• When the approval status is in progress, the approval cannot be edited. You must
cancel the approval first; see To cancel an approval process.
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14 Invoices

■ About invoices
■ To add an invoice
■ New Invoice page
■ To edit an invoice
■ About rolling up line items
■ To add or edit invoice line items
■ Field descriptions for the Edit Invoice Line Items page
■ Invoice status types
■ To change the status of an invoice
■ To delete an invoice
■ To print the invoice summary

N130001

About invoices
IBM Unica Marketing Operations allows you to view all changes made to an invoice,
and records the time and date, as well as the type of changes made to the invoice.

An invoice typically bills for multiple items or services, and itemizes them. It is important
to be able to capture each item or service separately, as you can attribute different line
items to different projects or programs and to different accounts.

For example, one invoice may contain two line items, the first associated with a project
called Tradeshow, and the other associated with a program called Database Marketing
Campaign. One line item may be associated with Account1, and the other, with
Account2.

After you create an invoice, you can do any of the following actions from its Summary
tab.

• Edit the summary information of the invoice.

• Add or edit line items for the invoice.

• Delete the invoice.

• Change the status of the invoice.

• Print the Invoice summary page.
N13B0001
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To add an invoice
1. Select Financials > Invoices. The My Active Invoices page appears by default.

2. Click the Add Invoice icon ( ).

3. Fill in the fields on the New Invoice page. For more information, see New invoice
page.

4. To add line items, click Save and Edit Line Items. For more information, see To
add or edit invoice line items.

You must add line items to move the invoice out of Draft state, mark it as Paid,
and roll up the expenses.

5. Save the invoice.
N13C0001

New Invoice page
This table describes the fields available on the New Invoice page.

Field Description

Invoice # An invoice number could be one of the following.

• A number provided to you by an external vendor or supplier in a paper invoice
• An original number based on your company’s code schema for internal

invoices or expense reports.

Invoice numbers are not required to be unique across all the invoices in IBM
Unica Marketing Operations, but they must be unique among all invoices for a
particular vendor.

Vendor Name Select a vendor from the drop-down list.

IBM Unica Marketing Operations administrators populate this list. If you cannot
find a vendor on the list, ask your administrator.

Click Add/Remove Members to add or remove owners. By default, this fieldOwner(s)
contains the name of the invoice creator.

Security Policy Select the invoice security policy from the drop-down list.

The default value is Global.

Purchase Order # Enter the purchase order number associated with the work now being invoiced.
Typically, this is an internal company number. In some cases, the purchase order
number is used to track preapproved invoices.
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Field Description

Invoice Date Enter the billing date of the invoice or select it on the calendar.

Due Date Enter the date by which the vendor expects payment or select it on the calendar.

Other Notes Enter any helpful notes or comments related to the invoice.

Payment Terms Enter any notes regarding payment.

N13D0002

To edit an invoice
1. Select Financials > Invoices.

2. Select the invoice you want to edit. Depending on the status and owner of the
invoice, it may be on the My Active Invoices page or the All Invoices page.

3. If your invoice is not in Draft state, click the status drop-down ( ) and select Re-
draft.

4. Edit the fields on the Invoice page as needed. For more information, see New
invoice page.

5. Add or edit line items. For more information, see To add or edit invoice line items.

You must add line items to move the invoice out of Draft state, mark it as Paid,
and roll up the expenses.

6. Save the invoice.
N1330001

About rolling up line items
When you change an invoice’s status to Paid, the invoice line item amount rolls up to
the program or project budget as well as to the account with which you associated it.
Remember that you can attribute the different line items of one invoice to different
projects or programs and to different accounts. Line items from multiple invoices can roll
up to the same program or project.

There are two types of rollups.

• Scheduled rollups occur on a scheduled basis.

• Immediate rollups occur when you change an invoice’s status to Paid.

Version 8.5.0 211



14 - Invoices

Depending on line item approval rules set by your IBM Unica Marketing Operations
administrator, line items may need to go through an approval process before the
whole invoice can be marked Payable, a pre-requisite to changing the invoice’s
status to Paid and rolling up line items. For more information, see Invoice line item
approvals.

N1440002

Invoice Line Item Approvals
Depending on rule criteria your administrator establishes in invoice templates, line items
may be automatically approved or sent through IBM Unica Marketing Operations's
approval process. For example, your administrator might define rules based on the line
item's cost per unit, total quantity, or total cost. If your administrator has written rules in
your organization's invoice templates, then all invoice line items must be approved,
either automatically via rules or by the assigned approvers, before the invoice is marked
as Payable. Once the invoice is moved from Payable to Paid, the invoice rolls up to
assinged accounts and the parent program or project's budget. However, if your invoice
templates do not contain line item approval rules, the functionality works as it did before
IBM Unica Marketing Operations 8.5.0 and the invoice can be marked as Payable
without going through an approval process in Marketing Operations.

Approval status for line items can be seen on the invoice summary page.

• = In Progress

• = On Hold

• = Cancelled

• = Completed
N1450001

Rollups to the source program or project
When you add an invoice line item, you link it to a program or project through the
Source Project or Program field. Once the invoice is paid, IBM Unica Marketing
Operations figures the invoice line item amount into the program or project budget.
Depending on whether the invoice line item is a negative or positive number, IBM Unica
Marketing Operations adds or subtracts the amount on the Actual Total field on the
source project or program Budget tab.

For example, if an invoice contains a line item of $75 that you associate with Project1,
the Actual Total field on the Project1 Budget tab increases by $75 once the invoice is
paid, signifying the amount of funds used in the budget.

If an invoice contains a line item of -$75 (indicating a credit) associated with Project1,
the Actual Total field on the Project1 Budget tab decreases by $75 once the invoice is
paid. If the Actual Total previously showed $200 (the total from all Paid invoices
containing line items linked to Project1), the Actual Total column, once the credit is rolls
up to Project1, show $125, signifying the funds used so far for Project1.
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Depending on how your administrator configures your invoice templates, marking
the invoice Payable may trigger an approval process.

N1460001

Rollups to the source account
When you add an invoice line item, you can also designate an account to which you
linked the invoice line item. Once the invoice is paid, the invoice line item amount rolls
up to, or figures into, the account. The invoice line item amount displays on the Actual
row on the account Summary tab. IBM Unica Marketing Operations places the amount
in a date column that corresponds to the invoice paid date.

Depending on how your administrator configures your invoice templates, marking
the invoice Payable may trigger an approval process.

N13E0001

To add or edit invoice line items
You must add line items to eventually mark the invoice Payable and roll expenses up to
accounts and budgets.

1. Navigate to the invoice by selecting Financials > Invoices.

2. Click the invoice number of the invoice to which you want to add line items.

3. Click the Line Items icon ( ).

4. Fill in the fields on the Edit Invoice Line Items page. Use the following tools to help
you add, edit, move, or delete line items.

• Click the Add Row icon ( ) to insert a new line item.

• Use the Move Selected Row Up icon or Move Selected Row Down icon

to change the order in which the line items appear.

• Click a line item and use the Delete the Selected Row icon to delete a
line item.

5. Save your changes.

Once line items are saved, the system calculates the Invoice Total of all line items.
N13F0001
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Field descriptions for the Edit Invoice Line
Items page

This table lists the fields available on the the Edit Invoice Line Items page.

Field Description

Item Description Click in the field to enter a description for the line item.

The # field populates automatically when you create a new line item.

Source Project or Click the drop-down arrow to search for a project or program with which the
Program invoice line item is associated.

In the Select Item window, do the following.

1. Click either the Project or Program radio button under the find by name or
code field according to which item you want to find.

2. Enter a search string to search for a specific project or program in the Find by
name or code field. Or, leave blank and click Find to search for all projects or
programs.

3. Select a project or program from the Search Results list.

4. Click Select to close the dialog box and add the selected project or program
to the line item.

This field is required in order to be able to move an invoice into the
Payable state. Once in the Paid state, the invoice amount rolls up to the
Actual Total field on the source project or program Budget tab.

Source Account Click the drop-down list to select from all enabled accounts. The funds for this
item come from the account you choose.

Once in the Paid state, the invoice amount rolls up to the source account's
summary information.

Cost Category Click the drop-down list to select an enabled cost category.

Cost per Unit Enter the amount of the line item.

Qty Enter the line item quantity.

Cost Displays the total cost for the line item. The system calculates this field after you
enter values in both the Cost per Unit and Qty fields.

N1400001
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Invoice status types
IBM Unica Marketing Operations invoices can be in the Draft, Cancelled, Payable,
Under Review, or Paid state.

Status Description

Draft Indicates the invoice is still being worked on; an invoice is in Draft state when it is
first created. To move an invoice out of Draft state, you must add line items.

If necessary, you can place an invoice in Draft state by choosing Re-draft
Invoice from the Status drop-down menu.

Cancelled Canceling an invoice is not the same as deleting an invoice. When you cancel an
invoice, it is inactive, yet you retain the ability to view it in IBM Unica Marketing
Operations. Deleting an invoice removes it from the system. When you move an
invoice to this state, Marketing Operations sends an alert to the invoice owner(s).

Under Review Approvers are in the process of examining the invoice's line items.

This is an internal status that occurs after marking an invoice Payable.

Payable Items on the invoice have been reviewed, and the invoice is ready to be sent to
Accounts Payable. When you move an invoice to this state, the owner of the
account to which the invoice belongs receives a notification.

Changing an invoice's state to Payable triggers the IBM Unica Marketing
Operations approval process if your organization is using this functionality. The
invoice may enter the Under Review status while waiting for approvals. For more
information, see invoice line item approvals.

Paid The invoice has been paid. When you move an invoice to this status, the system
triggers invoice rollup. This status is not available until the approval process is
complete.

When changing an invoice from one state to another, a dialog box appears in which you
are able to enter comments regarding the status change. IBM Unica Marketing
Operations records these comments in the invoice revision history. When changing an
invoice to the Paid status, you are able to enter the date on which the invoice was
marked Paid.

N1410001

To change the status of an invoice
1. Navigate to the Summary tab for the invoice of which you want to change the status.

2. Click the Status icon ( ) and select a status. A dialog box appears in which you
can add comments.
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If you select Cancelled or Paid, you cannot change the status of the invoice at a
later time.

3. Click Continue to close the dialog box and apply the new status.
N1420001

To delete an invoice
Owners and users with the proper security privileges can delete an invoice that is in the
Draft state. You cannot delete invoices in the Cancelled, Payable, or Paid state.

1. Navigate to the invoice by selecting Financials > Invoices.

2. Click the invoice number of the invoice you want to delete.

3. Click the Delete this Item icon ( ).

IBM Unica Marketing Operations asks whether you would like to delete the invoice.

4. Click OK.
N1430001

To print the invoice summary
You can print all information found on your invoice summary page, or select certain
columns of information to print. See the procedure below for instructions.

1. Navigate to the summary page of the invoice you want to print.

2. Click the Print icon . A window appears with a list of columns from which you
can choose to print. By default, all columns are selected.

3. Clear any columns you do not want to print.

4. By default, the Shrink to Fit Landscape Page Width box is checked. Clear to print
the columns at a size of 100%.

Selecting this option shrinks the page to fit all selected columns onto a single page.
If you use this feature, you should change your printing preference (for this print job)
to landscape.

5. Click Print Selected Columns. A preview window appears, showing you what the
printed information will look like.

6. Click Print. The Print dialog appears.

7. Select your printer and printer options (choose landscape mode for best results),
and click Print to print the selected columns.

8. In the preview window, click Close to close the print preview.
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15 Accounts

■ About accounts
■ About the accounts summary page
■ Account summary table
■ About selecting the fiscal year to view

N12C0001

About accounts
A top-level IBM Unica Marketing Operations account represents a specific corporate
general ledger account established by a finance department for the purpose of tracking
and controlling expenditures and cash flows for a certain area of the business. Accounts
may have subaccounts.

Key capabilities related to accounts include the following.

• Defining a hierarchy of accounts and subaccounts.

• Funding or allocating money to the account, at the beginning of a fiscal period,
typically a year, revisited weekly, monthly, or quarterly.

• Tracking estimated and actual withdrawals from those accounts, by time period.

You must have administrative privileges to add new accounts to IBM Unica Marketing
Operations.

N1470001

About the accounts summary page
When you select Financials > Accounts, the account Summary tab appears. Use the
account Summary tab to perform the following tasks.

• View Basic account information.

• Review the Account summary table. This is a view-only table which reflects the
budgeted, forecasted, committed, and actual amounts for that account, as well as
remainder amounts.

• Select the fiscal year to view.

Related Topics
• Account summary table

N1480001
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Account summary table
The Account Summary table contains the following information.

Field Description

Budget Amounts that the account administrator entered to fund the account. For more
information on creating and editing accounts, refer to the IBM Unica Marketing
Operations Administrator's Guide.

forecast The sum of all forecasted values entered into the Forecast Amount field of
finalized project and program budget line items for which this account is the
source account (as specified in the budget line item Source Account field). These
sums appear for a particular month on the table according to when you finalized
the line items. For example, if you finalize a forecasted line item amount in May,
that amount appears in the May column of the Forecast row.

Available The difference between values in the Budget and Forecast rows.

Committed The sum of all committed values entered into the Committed Amount field of
finalized project and program budget line items for which this account is the
source account (as specified in the budget line item Source Account field). These
sums appear for a particular month on the table according to when you finalized
the line items. For example, if you finalize a committed line item amount in May,
that amount appears in the May column of the Committed row.

Uncommitted The difference between values in the Budget and Committed rows

Actual The sum of all invoice line items for which this account is the source account (as
specified in the invoice line item Source Account field). These invoice line items
roll up to this field only when the invoice to which they belong is in the Paid state.
These sums appear for a particular month in the table according to when you
marked the invoice line items Paid.

For example, if you mark an invoice line item amount Paid in May, that amount
appears in the May column of the Actual row.

Remaining The difference between values in the Budget and Actual rows.

N1490001

About selecting the fiscal year to view
Because accounts can span multiple fiscal years, you can select a year in which to view
the account information.

From the Account Summary drop-down list, you can choose from the current year, and
the following two years. Additionally, if budget or invoice line items draw from the
account in other years, those years also appear in the list.
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About selecting the fiscal year to view

A Marketing Operations administrator configures your fiscal year by setting a parameter
in the plan_config.xml file to the month that you would like your account fiscal year
to begin. For more information, see the IBM Unica Marketing Operations Administrator's
Guide.
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16 Metrics

■ Metrics
■ To set up program or project metrics
■ To edit program or project metrics
■ Entering planned values for rollup metrics
■ Views for rollup metrics
■ To import metrics from a campaign
■ Finalizing and rolling up metrics

N2D0001

Metrics
Metrics are used for management reports and analysis. You view them on the Tracking
tab for plans, programs and projects.

Use IBM Unica Marketing Operations metrics for the following calculations.

• Automatically calculate internal measures (such as budgets and resource
consumption).

• Automatically tabulate program results, such as the following.

• measure consistently across activities.

• aggregate results across programs.

• Automatically link key metrics (such as number of contacts and responses) from
campaigns back to project metrics.

• Build a marketing memory.

The metrics that are available in a plan, program, or project depend on the template you
used to create it.

N14B0001

To set up program or project metrics
This procedure describes setting up metrics for a program; setting up metrics for a
project is similar.

1. Add a program, using the wizard.

220 IBM Unica Marketing Operations - User's Guide



To edit program or project metrics

While using the wizard, the tracking page displays the template tracking information
for your program. You cannot change the type of information that is captured on this
page. You can enter target values for the categories that exist on the Tracking page.
Depending on how your administrator set up your program templates, the number of
columns on this page can vary.

2. Enter the target value you want to achieve by executing this program in the Target
column. For example, if the program is a product launch, you may want to achieve
100 contacts, or get 1 hour of media coverage.

3. If other columns such as Optimistic or Pessimistic appear, you can enter
corresponding values. For example, if your target value for a Total Contacts
category was 100, a Pessimistic value for Total Contacts might be 50.

4. Click Next to continue the program wizard.

When you are finished creating the program, the metrics you entered appear on the
Tracking tab for that program.

Related Topics
• To add a program

N14C0001

To edit program or project metrics
When you created your program or project using the wizard, you entered various
metrics on the Tracking page. To edit the values you entered, follow the procedure
below.

If the program is linked to a plan, or the project is linked to a program, you must finalize
the edits you made before they will roll up to the parent object.

This procedure describes editing metrics for a program; editing metrics for a project is
similar.

1. Navigate to the Tracking tab of the program whose metrics you would like to edit.

2. Click the Program Metrics icon ( ).

The Edit Program Tracking page appears.

3. Edit the values you would like to change.

4. Click Save and Finish.

The Tracking tab for the program displays. The updated metrics appear in the Program
Metrics table.

N14D0001
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Entering planned values for rollup metrics
You can incorporate your goals and performance expectations for your marketing
campaign into IBM Unica Marketing Operations by entering planned values for metrics
that roll up. The planned values display side-by-side with the actual values at the end of
the campaign.

When entering planned values for metrics, you work top-down. That is, you open a plan
and specify planned values for the metrics for each of its child programs. You then open
a program and add planned values for the metrics for each of its child projects.

N1520001

To enter planned values for metrics that roll up
1. Open a plan or program that has child programs or projects with rollup metrics.

2. Click the Tracking tab.

3. Click the Planned Rollups icon ( ).

The Edit Planned Rollup Values page displays.

4. Enter the planned values for the metrics.

5. Click Save and Finish.

The values you entered display in the Planned column of the Program Metrics or Project
Metrics table on the Tracking tab.

N14E0001

Views for rollup metrics
The following views are available for rollup metrics.

View mode Description

High-Level Sum- Displays a summarized view of all rolled up metric dimensions. This is the default
mary view.

Breakout of Displays details of planned values for rollup metrics.
Planned

Breakout of Displays details of planned and target values for rollup metrics
Planned and Roll-
up Target(s)

Breakout of Displays details of planned, target, and actual values for rollup metrics.
Planned, Rollup
Target(s), and
Rollup Actual(s)
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View mode Description

Breakout of All Displays details of target, actual, and any other custom values for rollup metrics
Rollups used in the plan or program.

To change the view for rollup metrics, click the View icon ( ) and select a view from
the drop-down menu.

N14F0001

To import metrics from a campaign
1. Navigate to the Tracking tab of the campaign project whose metrics you want to

import.

2. Click Import Values.

The IBM Unica Campaign metrics are displayed on the Import Values page. The
information imported depends on the metrics the template creator defined. IBM
Unica Marketing Operations captures and displays the last date of import, shown as
External Sources Last Refreshed Date Time at the bottom of the table.

3. Click Save and Finish to update the metrics on the Tracking tab and close the
Import Values page.

If necessary, manually update metrics that you imported.

Related Topics
• To edit program or project metrics

N1500001

Finalizing and rolling up metrics
When a project is linked to a program or a program is linked to a plan, you can roll up
metric values from the child object to the parent object. Template creators define how
metrics roll up to the parent object. For more information on defining rollup behavior,
see the IBM Unica Marketing Operations Administrator's Guide.

Planned values for metrics do not roll up. Those values are for top-down planning.

Metric values do not roll up automatically. IBM Unica Marketing Operations rolls up the
values when you indicate they are final. Each time you import new metric values or edit
metric values, you must indicate the values are final in order for them to roll up.

Whenever there are metric values that have not been rolled up, a Finalize link displays
on the Tracking tab of the object containing the values.

N1540001
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To finalize and roll up metrics
The Finalize link only displays if there are new or changed metric values that have not
yet been rolled up.

1. Navigate to the Tracking tab of the project or program whose metrics you want to
roll up to their parent program or plan.

2. Click the Finalize link. (The Finalize link appears after metrics are edited or
imported.)

3. The metrics that are defined for rollup are rolled up to the parent program or plan
and are available on the parent object's Tracking tab.

Related Topics
• To enter planned values for metrics that roll up
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17 Reports

■ About reports
■ Filtering report criteria
■ Multi-object reports
■ Single-object reports
■ Marketing Operations list portlets
■ Marketing Operations IBM Cognos report portlets

N1550001

About reports
By default, IBM Unica Marketing Operations provides four reports and six dashboard
components. The Marketing Operations reports package provides additional example
reports and dashboard report components created in Cognos 8 BI, a third-party
business intelligence application.

You access reports from IBM Unica Marketing Operations in the following ways.

• Click the Analysis tabs of individual items like projects and marketing objects to see
reports that apply to the current item.

• Select the Analytics > Operational Analytics to see example Cognos reports that
present data from more than one object.

The reports administrator can modify the reports, create new ones, add custom
attributes, set up criteria filters, and so on.

Report appearance and output
Each Cognos report has a header, a body section, a page footer, and navigation
buttons. When you run a report, it appears in your browser window in HTML format. For
many of the reports, you can select a different format (for example, PDF or XML) to
view.

Because the following reports have multiple queries, you cannot export them as CSV or
XML files.

• Analytics page report: Project Crosstab Summary Report

• Analysis Tab reports: Project Detailed Expense Breakout, Project Approval and
Response, and Budget Summary reports (plan, program, project)

For further details on report output appearance and formats, see the Cognos
documentation.
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Sending reports in e-mail
Click the e-mail icon ( ) to bring up a form where you enter e-mail addresses for
recipients of the report. After you complete the form and choose OK, the report is sent
in the current format chosen for display.

For example, if you choose PDF then e-mail, the report is sent as a PDF attachment to
the message.

Enter the following information in the e-mail dialog:

• E-mail addresses: type the address for each recipient, separated by semicolons.

• Subject: type subject for the message. Defaults to the name of the report.

• Body: type in the message.

• Attachments: ensure the Include the report box is checked.

Do not select Include a link to the report; this option is not currently supported.

N1560001

Filtering report criteria
The data in reports can be filtered in various ways, depending on the report. You use
filters to specify report criteria and parameters for your report.

This section describes how to use the filters and prompts that appear when you run
reports.

N15B0001

Search and Select Prompt boxes
This type of filter allows you to perform a search and then choose which results to use
for the report. Various reports use these filters for the following types of data:

• Owners

• Users

• Vendors

• Projects; you can search by project name or project code.

1. Type keyword(s) to search, then optionally choose the search option:

• Starts with any of these keywords (default setting)

• Starts with the first keyword, and contains all of the remaining keywords

• Contains any of these keywords

• Contains all of these keywords

For example, if you are searching for project code PRO1001, you could type PRO or
1001, and choose the Contains any of these keywords option.
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2. Click Search.

System returns data matching the search criteria.

3. Use the Insert, Remove, Select all, and Deselect all buttons to create a list of
items for your report. Move the items to appear in your report into the Choices list
box, as shown here:

The report will contain data for the owners, users, vendors or projects appearing in
the Choices list box.

N15C0001

Dates
To narrow the date range for your report, use the Date filter:

• The Earliest date button puts no limitation on the begin dates for the search.
Similarly, the Latest date button does not limit by end date. The default setting is to
have both of these buttons selected, which means the system does not filter on
dates at all.

• Entering actual dates in the From and/or To fields limits the report to tasks
containing dates active within the selected range.

N15D0001

Active dates
Date prompts use active dates. All projects (or plans or programs) that are active any
time within the date range specified meet the report criteria.

For example, if you specify a date range from January 1, 2005 to March 15, 2005, the
following projects will meet the criteria:

• Projects starting on or after January 1, 2005, no matter when they end.

• Projects ending on or before March 15, 2005, no matter when they began.

Projects that do not meet the criteria:

• Projects ending before January 1, 2005

• Projects starting after March 15, 2005
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N15E0001

Status and Type
These filters limit the report to contain only tasks with selected status or type
(determined based upon the template used to create the project). For these filters,
select as many choices as you like.

Making no selection is equivalent to selecting all choices.

N1570001

Multi-object reports
This section describes the default reports that are listed on the Analytics Home page
when the IBM Unica Marketing Operations reports package is installed. It also presents
procedures for running them.

The following table lists the default reports.

Report Description

Overdue Milestone Displays all overdue milestones with task end dates that fall between the selected
start and end dates.

Program Tasks Displays all milestones for the program selected in the parameter field.
and Milestones

Project On Time Displays completed projects within the time period specified along with the
Analysis number of days early or late. These dates are calculated by pulling the greatest

date in the workflow for the project for both the target and forecast/actual columns.

Project Perfor- Displays project performance metrics, including: leads passed, revenue, and ROI.
mance Crosstab The data is aggregated over initiative and project type vs. business units. This

report requires the Financial Management Module.

Project Perfor- Displays projects and their budget data. This report requires the Financial
mance Summary Management Module.

Project Perfor- Displays projects grouped by initiative, with their budget, cost, revenue, response
mance Summary rate, and lead generation performance data. This report demonstrates how a
(Custom) sample report can be customized using custom attributes. This report does not

work unless your template administrator has implemented the example custom
attributes. This report requires the Financial Management Module.

Project Tasks Displays all tasks and their status for the specified project.

Resource Task Displays tasks assigned to selected users. The report returns tasks for each
Load project that falls into the specified date range.
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Report Description

Resource Utiliza- Displays a summarized view of resource utilization percentages by user. Select
tion Summary start and end dates to specify a date range for the report.

System Programs Displays a breakdown of programs by status and template type.

System Projects Displays projects broken down by status and template type.

System Users Displays details for each IBM Unica Marketing Operations user.

Task On Time Displays all tasks that have been either early or late, where the task end date falls
Analysis between the Start Date and End Date parameters chosen for this report. The

report is grouped by task name.

If a task ended early, the number of days it finished ahead of schedule is
displayed on a green background. If it ended late, the number of days late is
displayed as a negative number on a red background.

Vendor Spend Displays total invoiced expenses for specified vendors in the specified date range,
Summary including breakouts for paid, approved, and received expenses. This report

requires the Financial Management Module.

N15F0001

To run the Overdue Milestone report
The Overdue Milestone report shows all overdue milestones with task end dates that fall
between the selected start and end dates. You can filter the report by using the Report
Start Date and Report End Date parameters as well as the Task Status and Project
Status parameters.

1. Select Analytics > Operational Analytics.

2. In the list of reports, click Overdue Milestone Report.

A screen appears allowing you to set filter criteria.

3. Choose start and end dates for the report.

4. Optionally, set filters for Task and Project status.

5. Click Finish to create the report.

The report displays a list of milestones, grouped by the milestone owner, sorted by
project code, and containing the following columns: Milestone Owner, Project Code,
Milestone, Task Number, Status, Task Name, End Date, Forecast/Actual End, Days
Late, and Notes.

Related Topics
• To set your basic options

N1600001
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To run the Program Tasks and Milestone report
The Program Tasks and Milestones report shows all milestones for projects that are
part of the program selected in the parameter field. You can filter the report on
milestone type. If you chose not to filter on milestone type, all tasks are displayed.

1. Select Analytics > Operational Analytics.

2. In the list of reports, click Program Tasks and Milestones.

A screen appears allowing you to set filter criteria.

3. Select a program in the Program drop-down menu.

4. Optionally, select Milestone types for the report. Note that if you do not choose any
Milestone types, the report will contain all tasks in all projects that belong to the
selected program.

5. Click Finish to create the report.

The report displays a list of milestones (or tasks), grouped by project and sorted by
date, and containing the following columns: Project Name , Milestone type, Task
Number , Forecast/Actual dates and effort, Target dates and effort, Variance, and
Notes.

The Variance column contains the number of days early or late the milestone occurred.
If a milestone is reached early, it is displayed on a green background. If it is reached
late, it is displayed as a negative number on a red background.

N1610001

To run the Project Performance Crosstab report
The Project Performance Crosstab report shows high-level project metrics in a cross tab
along multiple dimensions of custom attributes.

The example included is a cross tab of project performance metrics including leads
passed, revenue, and ROI (Return on Investment), aggregated over initiative and
project type vs. business units.

This report requires the Financial Management Module.

1. Select Analytics > Operational Analytics.

2. In the list of reports, click Project Performance Crosstab. A screen appears
allowing you to set filter criteria.

3. On the first filter page, choose the projects to include in the report. To specify other
filters, click Additional Prompts and proceed to step 4. Otherwise, skip to step 5.

4. On the second filter page, specify filters for any or all of the following:

• Project owner

• Project date range

• Project status

• Project type: these are determined based upon the template used to create the
project
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All sections on the filter pages are optional. If you do not fill in any information in any
of the sections, the resulting report contains the resource task load for all users and
all projects in the system.

5. Click Finish to create the report.

The sample report provided contains the following information:

• Row Dimensions: (1) Initiative, (2) Project Type

Data in the rows is grouped by Initiative; you can use this field to categorize your
programs and plans. Each Initiative section contains rows for each Project Type
included in the report.

Project type is determined from the template used for creating the project. Sample
project types are Database Marketing Campaign, Tradeshow Template,
Marketing Collateral, and Campaign Project Template.

• Column Dimension: Business Unit

A business unit is a field on the project and plan creation page. It is one way to
categorize projects and plans.

• Metrics to show: number of leads passed, revenue, and ROI (Return on Investment)

Example of a Project Performance Crosstab report:

N1620001

To run the Project Performance Summary report
The standard Project Performance Summary report lists projects alphabetically, along
with status, date, and budget information. The custom version lists projects grouped by
initiative, with budget, cost, revenue, response rate and lead generation performance
data. Both versions require the Financial Management Module.

The custom version of this report also contains additional prompts and custom fields. It
demonstrates how a standard report can be customized using custom attributes and
works only if your template administrator has implemented the custom attributes.

1. Select Analytics > Operational Analytics.
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2. In the list of reports, click Project Performance Summary.

A screen appears allowing you to set filter criteria.

3. On the first filter screen, you can choose the projects to include in the report. If this
is your only filter criteria, click Finish to run the report. To specify other filters, click
Additional Prompts and proceed to step 4.

4. On the second filter page, specify filters for any or all of the following:

• Project owner

• Project date range

• Project status

• Project type: these are determined based upon the template used to create the
project

All sections on the filter pages are optional. If you do not fill in any information in any
of the sections, the report contains project performance for all projects in the
system.

5. Click Finish to create the report.

The report displays a list of projects sorted by project name. The custom version is
grouped by Initiative. The reports contain the following columns:

Column Description

Project Displays the project name and its ID.
Name/Code

Status Displays the status of each project.

Target dates Displays the target start and end dates.

Business Unit, Displays the business unit, segment, and product family for each project. These
Segment, and are fields included with the sample templates, used to categorize projects. Not all
Product Family types of projects contain all of these fields. If your report uses a project that does

not contain one or more of these fields, the column is ignored (it is blank for that
project).

(These fields are only in the custom version of the report.)

Total Budgeted To- Displays a variety of budgeting information. These fields are filled in from the
tal Forecasted Ac- budget tab for each project.
tual Cost

Total Revenue Displays revenue metrics (if defined) for the project.

Response rates Displays response rate and leads generation data. Response rates and leads data
and leads columns are taken from the metrics for each project (found in the Tracking tab).

(These fields are only in the custom version of the report.)
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Column Description

ROI Displays ROI (Return On Investment) metrics (if defined) for the project.

(This field is only in the custom version of the report.)

N1630001

To run the Resource Task Load report
1. Select Analytics > Operational Analytics.

2. In the list of reports, click Resource Task Load.

The Filter Resource Workload screen appears.

3. Specify filters for any or all of the following:

• User

• Projects

• Project date range

• Project status

• Project type: these are determined based upon the template used to create the
project

All sections on this page are optional. If you do not fill in any information in any of
the sections, your report will contain the resource task load for all users and all
projects in the system.

4. Click Finish to create the report.

The report results are written to the screen, unless another format is selected. The
report displays tasks meeting the filter criteria, grouped by user, and containing the
following columns from the workflow tab of the project:

Column Description

Task Name Displays the project name and its ID.

Project Name Displays the project name and code; clicking on the link opens the summary page
of the project (if your report administrator has configured the drill-back URL).

Dates Displays the forecast/actual and target start and end dates.

Status Displays the status of each task.

% Complete Displays the current progress of each task.

Notes Displays the notes for a task.
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Column Description

Condition Displays a condition, based on the dates for a task.

If the end date for a task is later than its target end date, this column contains one
of two values:

• Late: if status is In Progress or Completed, and Forecast Start Date is later
than Target Start Date.

• Overdue: if status is In Progress or Completed, and Forecast End Date is
later than Target End Date.

For all other tasks, this field is blank.

N1640001

To run the Vendor Spend Summary report
The Vendor Spend Summary report displays total invoiced expenses for specified
vendors in a specified date range, including breakouts for paid, approved and received
expenses. This report requires the Financial Management Module.

1. Select Analytics > Operational Analytics.

2. In the list of reports, click Vendor Spend Summary.

A screen appears where you can set filter criteria.

3. Specify filters for:

• Vendor

• Invoice date range (defaults to today’s date)

Note that both filters are required.

4. Click Finish to create the report.

The report is a summary of invoices by vendor, with three columns. The columns
categorize the invoice totals by their status, as follows:

• The Outstanding column totals all invoices with a status of Draft.

• The Payable column sums all invoices with a status of Payable.

• The Actual Spent column sums all invoices with a status of Paid.

An example of the Vendor Spend Summary report:
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Single-object reports
The single-object reports are available from the Analysis tab of projects, programs, and
plans. For these reports, you are reporting on that single object.

The following table describes both the standard single-object reports and the example
Cognos 8 reports made available when the IBM Unica Marketing Operations reports
package is installed.

Report Description

Revision History A report that lists the revisions made to the current object. This is the report
you see by default when you click the Analysis tab of accounts, approvals,
assets, plans, programs, projects, marketing objects, requests, teams, and
invoices.

Approval Responses A report for projects that displays information about approval tasks.

Invoice Summary List A report for projects and programs that lists invoice summary information.
This report requires the Financial Management Module.

Marketing Object Cross- A report for projects and marketing objects that lists the marketing objects
Reference referenced or modified by the current object.

Approval and Compli- An example Cognos report for projects that displays additional information
ance Listing about approval tasks.

Budget Summary An example Cognos report for projects, programs, and plans that displays a
summary of the budget by week, month, or quarter. This report requires the
Financial Management Module.

Detailed Expense An example Cognos report for projects that displays a breakout of the project
Breakout expenses. This report requires the Financial Management Module.

Work Assigned A report for teams that displays work assignments by team and by team
member.

Related Topics
• To view the revision history of an object

• About the marketing object cross reference report

• To run the Approval and Compliance Listing report

• To run the Budget Summary by Quarter report

• To run the Detailed Expense Breakout report

N1650001
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To view the revision history of an object
After you work in an object for a period of time, you can view its revision history to see
who created and modified the object, which fields were modified, and when the
modification took place.

You can review the revision history for the following objects: accounts, approvals,
assets, plans, programs, projects, requests, teams, and invoices.

1. Navigate to the Summary tab of an object to view its revision history.

2. Click the Analysis tab.

By default, the page displays the revision history of the object, listing all
modifications to the object since it was created.

You can click Revision History in the Report Type pull-down menu to display the
revision history if another report is displayed.

Note the following:

• For projects, click Approval Responses in the Report Type pull-down menu to
display the revision history for any approvals linked to tasks within the project.

• For approvals, an entry is created whenever the approval round number
changes (when the approval owner requests re-approval for whatever reason).

For example, if Connie Contact (approval owner) changes an approval and
requests re-approval, an entry like the following is added to the revision history
of the approval:

Connie Contact on 12/15/2005 01:47:50 PM Approval Round #2: Approval
was re-requested and the round number has increased.

N1670001

To run the Approval and Compliance Listing
report
The Approval and Compliance Listing report lists the approval processes for the
workflow approval tasks of a project. It is separated into sections for current approval
processes, completed approval processes, and approval processes scheduled to begin
in the future.

1. Select Operations > Projects.

2. From the list of projects, select the one to report on.

3. Navigate to the Analysis tab of the project.

4. From the Report Type pull-down menu, choose Approval and Compliance
Listing.

The report displays on screen.

This report contains the following information:
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Column Description

Approval Pro- Displays the task number, name, and progress for each approval process listed.
cess/Progress Progress is described as how many approvals have been received out of the total

number expected.

Items Being Ap- Displays a list of the items being approved.
proved

Approvers Displays a list of the approvers. For a required approver, displays (Required) next
to the name of the approver.

Linked Task Displays the task number and name of the workflow task linked to the approval.

Status Displays the status of the approval:

• In Progress: indicates an active approval process.
• On Hold: indicates a temporarily halted approval process
• Completed: indicates an approval process that is finished.
• Not Started: indicates an approval process that has not yet been submitted

for review.

N1680001

To run the Budget Summary by Quarter report
The Budget Summary by Quarter report displays budget information by quarter for the
selected project, program, or plan, and fiscal year. For programs and plans, data rolls
up from contributing projects and programs. This report requires the Financial
Management Module.

1. From the Operations menu, select:

• Projects to run the report for a project.

• Programs to run the report for a program.

• Plans to run the report for a plan.

2. From the list, select the project, program or plan to report on.

3. Click the Analysis tab.

4. From the Report Type pull-down menu, choose Budget Summary by Quarter.

The report for the current fiscal year displays. If there is data for more than one
year, you can choose a different fiscal year for the report from the Fiscal Year pull-
down menu.

Data is organized for the selected fiscal year, as follows:
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Section Description

Summary table This table displays summary budget information:

• Rows: different breakdowns of the budget; actual/remaining, commit-
ted/uncommitted, and forecast/available

• Columns: Fiscal year total, then one column for each quarter.

For projects, the report consists of only this table.

Details table For programs and plans, this table shows budget information rolled up from
subordinate objects.

• Rows: for a program report, each individual project that is part of the program
has its own row. Similarly for a plan report, each program has its own row.

• Columns: Each quarter has columns for rollup budget, rollup forecast, rollup
committed, and rollup actual.

N1690001

To run the Detailed Expense Breakout report
This report requires the Financial Management Module.

1. Select Operations > Projects.

2. From the list of projects, select the one to report on.

3. Click the Analysis tab of the project.

4. From the Report Type pull-down menu, choose Detailed Expense Breakout.

The report for the current quarter displays. If there is data for more than one quarter,
you can choose a different quarter for the report from the Fiscal Quarter pull-down
menu.

Data is organized for the selected quarter, as follows:

Section Description

Accounts Displays three columns (actual, committed, and forecast) of the budget informa-
tion for the account. The data for each account is displayed on its own row. The
first row contains summary data for all accounts.

Cost categories Displays three columns (actual, committed, and forecast) of budget information.
The data for each category is displayed on its own row. The first row contains
summary data for all cost categories.

Vendors Displays actual money spent per vendor. There is one row per vendor, and the
first row presents summary data.

N16A0001
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To run the Work Assigned to Team or Team
Member Reports
You can view the approvals, projects, project requests, and tasks associated with a
team as a whole or with a specific team member.

1. Navigate to the Analysis tab of a team.

2. Select the report type and work assignment (approvals, projects, project requests, or
tasks). If you select the Work Assigned to Team Member report, also select the
team member.

The report is displayed.

The following information is available.

Section Description

Name Displays the name for approvals, project requests, and tasks; clicking on the
link opens the summary page of the work assignment (if your Report
Administrator has configured the drill-back URL).

Project Name Displays the project name for projects; clicking on the link opens the
summary page of the project (if your Report Administrator has configured the
drill-back URL).

Project Code Displays the project code for approvals, projects, and tasks.

Project Owner Displays the project owner for approvals and tasks.

Requester Displays the requester for approvals and project requests.

Task Owner Displays the task owner for tasks.

Request ID Displays the ID for project requests.

Approver Displays the approver for approvals.

Status Displays the status for approvals, projects, and tasks.

N1590001

Marketing Operations list portlets
This section describes the standard Marketing Operations portlets that are available for
use on dashboards even if the Marketing Operations reports package is not installed.

Report Description

My Active Projects A list of active projects for the user viewing the report.
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Report Description

My Alerts A list of the Marketing Operations alerts for the user viewing the report.

Approvals Await- A list of approvals awaiting action by the user viewing the report.
ing Action

My Tasks A list of tasks owned by the user viewing the report.

My Requests A list of requests owned by the user viewing the report.

Projects over Bud- A list of all projects that are over budget for the calendar year. This report
get requires the Financial Management module.

N15A0001

Marketing Operations IBM Cognos report
portlets

This section describes the Marketing Operations dashboard portlets that are available in
the Marketing Operations reports package.

Report Description

My Task Sum- An example IBM Cognos report showing data about all active and
mary completed tasks for the user viewing the report in all In Progress projects.

My Approval Sum- An example IBM Cognos report showing data about active and completed
mary approvals for the user viewing the report.

Manager Approval An example IBM Cognos report showing data for active and completed
Summary approvals for all In Progress projects in the system.

Projects by Pro- An example IBM Cognos report showing a 3-D pie diagram that shows all
ject Type In Progress projects in the system by template type.

Projects by Status An example IBM Cognos report showing a 3-D bar chart that shows all
projects in the system by status: draft, in progress, on hold, cancelled, and
finished.

Manager Task An example IBM Cognos report showing data for active and completed
Summary tasks for all In Progress projects.

Marketing Finan- An example IBM Cognos report showing a timeline with Budget, Fore-
cials Position casted, Committed, and Actual amounts for all plans in all states in the

current calendar year. This report requires the Financial Management
module.
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Report Description

Spend by Project An example IBM Cognos report showing a 3-D pie chart of the actual
Type amount spent per project type in the current calendar year. This report

requires the Financial Management module.

Completed Pro- An example IBM Cognos report showing a 3-D bar chart of the number of
jects by Quarter early, on-time, and late projects completed this quarter.

Projects Re- An example IBM Cognos report showing a timeline graph of the number of
quested and Com- project requests and number of completed projects per month. This report
pleted only counts project requests with the following states: Submitted, Ac-

cepted, or Returned.

Forecast by Pro- An example IBM Cognos report showing a 3-D pie chart of the forecasted
ject Type spending per project type for the current calendar year.

Budget by Project An example IBM Cognos report showing a 3-D pie chart of the budget per
Type project type for the current calendar year. This report requires the Financial

Management module.
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18 Searches

■ About searches
■ About searching within grids
■ About searching for marketing object attributes
■ To perform an advanced search of a digital asset library
■ To perform an advanced search (except for assets)
■ To regroup and reorder search criteria
■ About the Not In operator
■ Assets advanced search page
■ Advanced search page for objects other than assets
■ About saved searches

N16B0001

About searches
You can perform two kinds of search in IBM Unica Marketing Operations: simple and
advanced.

You can perform a simple or advanced search for plans, programs, projects, tasks,
assets, approvals, marketing objects, and invoices from any view in the corresponding
section of IBM Unica Marketing Operations. Searching in the Programs section retrieves
only programs; searching in the Projects section retrieves only projects, and so on.

Simple searches
IBM Unica Marketing provides a simple search function that enables you to search for
most objects, including plans, programs, projects, assets, approvals, tasks, and
invoices. You can perform these searches using the Search field in the menu bar at the
top of the IBM Unica Marketing window. For details on this search function, see the IBM
Unica Marketing Platform Administrator's Guide. You can use this seach to search for
most objects, including plans, programs, projects, assets, approvals, tasks, and
invoices.

Advanced searches
IBM Unica Marketing Operations also provides an advanced search function that
enables you to specify more complex searches based on several different criteria that
apply the type of items for which you are searching. You can save commonly used
advanced searches to save time.
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Advanced searching works the same for all objects except assets. Marketing Operations
provides one type of advanced search page for assets, and a different type for all other
objects that contain advanced search functionality.

Permissions considerations
When you search for an object, IBM Unica Marketing Operations always conducts the
search against all the objects the user has security rights to view (for example all
projects). This occurs even if you initiate the search from within a filtered view, such as
the Active Projects view, or from within a saved search.

For example, if you do not have access to the Workflow tab of a project template, tasks
from the project created from that template do not appear in the results of an All Tasks
search even if you are a member (Owner/Participant/Requester) of the project.
However, if one or more tasks from that project are assigned to you, then those are
displayed irrespective of your access rights.

Related Topics
• To perform an advanced search of a digital asset library

• To perform an advanced search (except for assets)

N16C0001

About searching within grids
In advanced search, grid attributes appear in the list of available attributes to add to a
search for all project templates that are enabled, whether or not any projects or
marketing objects exist that have been created from that template.

For example, assume your system contains the following:

• A project template named Tradeshow, and this template is enabled.

• A tab named Vendors is available for Tradeshow templates.

• The Vendors tab contains a grid, and one of the grid columns is named Vendor
URL.

On the advanced search screen for projects, you can select Vendor URL when you
choose a condition for the search. Note that the Vendor URL attribute appears in the
list, even if your system does not contain any Tradeshow projects.

When a template is deleted, its grid attributes are no longer available as search criteria.
You can search for attributes in a disabled template; choose a disabled template (or All
Disabled) from the advanced search screen.

Related Topics
• About the Not In operator

N16D0001
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About searching for marketing object
attributes

You can search for attributes contained in a linked-to marketing object, from marketing
objects or projects. For example, suppose you have projects that link to marketing
objects that in turn contain an attribute for which you want to search:

• You have projects of type Marketing Collateral, which can link to

• Marketing objects of type Creatives, which contain an attribute

• Cost, representing the cost of the creative.

From the project page, you can perform an advanced search which returns projects
based on criteria you specify about the Cost attribute.

N16E0001

To perform an advanced search of a digital
asset library

The advanced search for assets allows you to search for information in specific fields
that the owner filled out when creating or modifying the assets.

1. Select Operations > Assets.

2. Select a digital asset library to search

3. Click the Search/Filter icon ( ).

The Assets Search screen appears.

4. Fill in one or several of the fields, depending on what you want to search for.

5. Click the Search button.

The items meeting the search criteria are displayed on the Assets list page.
N750001

To perform an advanced search (except for
assets)

1. Open the list page of the object type for which you want to search (for example,
projects, tasks, and so on).

2. Click the Search icon ( ).

The Advanced Search page appears:
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To regroup and reorder search criteria

3. In the first field, choose a template or templates on which to base the search. In
addition to each template, the list contains groups of templates: All Templates, All
Enabled, and All Disabled.

4. In the second field, choose an attribute on which to base the search. Attributes are
grouped by object type. For example, if you are searching for projects, project
attributes are listed first, then the attributes for each type of marketing object are
listed, grouped by marketing object type.

5. In the third field, choose an operator for the search. The available operators depend
upon the type of attribute selected for the search.

6. In the fourth field, enter a value.

7. Repeat steps 3 to 6 as necessary to construct your advanced search.

8. Optionally, click Save as to save the search. Administrators can also publish the
search by selecting the Publish checkbox on the Save As dialog box. Published
searches are available to all Marketing Operations users.

9. Click Apply to perform the search based on your criteria.

Related Topics
• Disabled attribute values in searches

N16F0001

To regroup and reorder search criteria
As you construct search criteria, you can rearrange the grouping and order of any
individual search condition:

1. For the condition you want to move, position the cursor over the condition’s number
box.

Note that the cursor changes to a double vertical arrow, and the tool tip displays
"Drag to move this condition to another place in the query."

2. Drag the condition to where you want to insert it. Note the red guide line, showing
where the condition will be inserted.
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3. Once the condition is positioned correctly, release the mouse to drop it into its new
location.

You can drag and drop search criteria at any level.

N1700001

About the Not In operator
Background
IBM Unica Marketing Operations objects (plans, programs and projects) are created
from templates.

Templates have definitions of attributes, for example, brochure_type. Project instances
created from the same template could have different values for their attributes. For
example, TS001 might have Tri-fold as its brochure type, and TS002 could have Bi-
fold.

In a typical IBM Unica Marketing Operations installation, there are multiple project
templates, and a particular attribute might be present in some templates and absent in
others.

The behavior of the Not In operator
The operator, Not In, returns all instances of objects (for example, projects) that do not
have the value of the attribute as given in the search, or if the object does not have the
attribute itself. To illustrate, if you search for all Fruits that do not have black colored
seeds, this search returns fruits that do not have black colored seeds AND fruits that
are seedless, since seedless fruits do not have black colored seeds.

Consider the following example:

• Template1 has a custom tab, Business, that contains the attribute BusinessUnit.

• Template2 does not have the Business custom tab (hence it does not contain the
BusinessUnit attribute).

• Two projects are created from Template1:

• Project1 is created with "Insurance" as the value for BusinessUnit.

• Project2 is created with "Banking" as the value for BusinessUnit.

• Two projects are created from Template2: Project3 and Project4.

Assume you create a search with the following criteria:

[All Templates] -> [BusinessUnit] -> [Not In] -> [Insurance]
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This search returns Project2, Project3, and Project4, since none of these projects has
BusinessUnit = Insurance.

N1710001
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Assets advanced search page
When you click Advanced Search on a digital asset list page, the system displays a
page with the following fields.

Field Description

Asset Name Allows you to search in the Asset Name field of all existing assets. IBM Unica
Marketing Operations searches for all asset names that contain the text string you
enter. You can use the following standard wildcards.

• * - to search for any string
• ? - to search for any character.

Allows you to choose a Boolean operator.AND
• AND: to return items containing all the words in the Asset Name field.OR
• OR: to return items containing any of the words in the Asset Name field.

Asset Code Allows you to search in the Asset Code field of all existing assets. IBM Unica
Marketing Operations searches for all codes that contain the string you enter.

Description Allows you to search for text in the Description field of all the existing assets. IBM
Unica Marketing Operations searches all the description fields for the characters
you enter.

Status Allows you to select any or all of the statuses to search; Draft, Finalized, or
Locked.

Expires Before Allows you to specify a date. IBM Unica Marketing Operations searches for all
assets with expiration dates on or before the specified date.

Folder Name Allows you to enter part or all of a folder name to search. IBM Unica Marketing
Operations searches for all folder names that contain the text string entered and
searches for assets in that folder.

Keywords Allows you to search in the Keywords field of all existing assets. IBM Unica
Marketing Operations searches for any of the keywords that contain the text string
you enter.

Owners Allows you to select one or more owners to search for assets belonging to the
selected owner(s).

Version Name Allows you to search in the Version Name field of all existing assets. IBM Unica
Marketing Operations searches for all versions that contain the text string you
enter.

Usage Guidelines Allows you to search in the Usage Guidelines field of all existing assets. IBM
Unica Marketing Operations searches for all usage guidelines that contain the text
string you enter.

N1720001
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Advanced search page for objects other
than assets

When you click Search on the list page for most IBM Unica Marketing Operations
objects, the system displays a page with the following information.

Control Description

Search for Displays text indicating the objects for which you are searching. For example, if
you are searching for programs, the dialog displays Search for: Programs.

Select items Determines whether the search needs to match all or any of the search criteria.
Options are: all, to specify that the search must meet all search criteria, or any, to
specify that the search can match any of the search criteria. The default is all.

Condition Allows you to construct a search condition by specifying the following.

• From the first pull-down list, select the template on which to base the
condition.

• From the second pull-down list, select the attribute for which you want to
search. Possible values are: Project Name, Owner, Description, etc.

• From the third pull-down list, select the search operator.
• In the fourth field, enter the value for the criteria.

For example, if you are searching for projects, and want to find project names that
include the word Marketing.

• Select All Enabled to search on all enabled project templates
• Select Project Name in the second pull-down,
• Select Contains in the third pull-down, and
• Type Marketing in the fourth field.

Grouping Allows you to construct a grouping for the search results by specifying the
following.

• From the all/any pull-down, select all or any, to determine whether to use all
or any of the grouping criteria.

• Fill in the remainder of the grouping criteria as described for constructing the
Condition.

Insert a new condi- Click to insert a new line for entering a condition.
tion

Insert a new Click to insert a new line for grouping the search criteria.
grouping

Remove selected Click to remove any selected conditions or groupings.

Save as Click to save your criteria as a named search. You are prompted to enter a name
for the search. Additionally, IBM Unica Marketing Operations administrators can
publish a search by selecting the Publish checkbox.
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Control Description

Apply Click to perform the search based on the criteria specified.

Reset Click to reset the dialog box, clearing any criteria already specified.

Close Click to close the dialog box without performing a search.

N1730001

About saved searches
You can save any advanced search by clicking the Save As button on the Advanced
Search page. Saved searches are available only for plans, programs, projects, and
marketing objects.

There are two types of saved searches: unpublished and published. Unpublished saved
searches are available only to the user who saved it. Published saved searches are
available to all users. Only a Unica administrator can publish saved searches.

Accessing saved searches
After you save a search, you can access the search and rerun it with the same criteria,
or delete it. You can access saved searches in two ways:

• On the Action icon's menu on the object’s list page

• On the list page itself when you view all objects of that type by selecting All [item]
in the Action menu

For example, saved searches for projects are available on the Projects List page when
viewing all projects and requests. If your system contains any published saved
searches, they are listed along with your unpublished saved searches.

Setting the sort order in saved searches
When you save a search, the sort column and sort order that exist on the page from
which you are searching becomes the default sort order in the saved search.

Note that, if you create a saved search from another saved search that has optional
columns, the optional columns are not included. Thus, if the sort column in the original
search was an optional column, in the second saved search, the sort column reverts to
the default, as the sort column does not exist in the new saved search.

You can change the sort column and sort order of an unpublished search by changing
the sort column and sort order of the list page, accessing the saved search, and clicking
Save, which updates the search. This applies only to unpublished searches. To change
the sort column and/or sort order of a published search, a Unica administrator must first
unpublish the search, change the sort as described above, and then re-publish the
search.

N1770001
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To view a saved search
1. Open the list page for an object type.

2. Click All <objects> (where objects are projects/requests, programs, or plans.)

Your saved searches and all published searches appear as folders at the top of the
screen.

3. Click on the folder that contains the search results you want to view.

Saved searches are also available from the Actions icon menu.

N1780001

To delete a saved search
Note that you cannot delete a saved search that is any of the following.

• Created by another user

• A default calendar, project, or task search

• A system search

• Published

• The search the user is currently using

1. Open the list page for an object type.

2. Click the Actions icon ( ) and click the checkbox next to the search or
searches you want to delete.

You can delete only your own saved searches; you cannot check boxes for any
other searches.

3. Click Delete Selected to remove your selected saved searches.
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19 Alerts and the message
board

■ About alerts and the message board
■ Alerts
■ Message board
■ Viewing alerts
■ Receiving alerts when outside the organization's domain
■ About adding comments for alerts
■ To subscribe to alerts for an object
■ Brief and detailed task alerts
■ To post a message on the message board
■ To read a message on the message board

ND20001

About alerts and the message board
Alerts and the message board both allow you to communicate information to other users
of IBM Unica Marketing Operations.

Alerts and the message board are available for the following objects: plans, programs,
projects, requests, assets, accounts, approvals, invoices, tasks, teams, and marketing
objects.

Related Topics
• To subscribe to alerts for an object

• Brief and detailed task alerts

N150001

Alerts
You can use alerts to communicate information to specific people about the state of an
object or about an action that the user needs to take. Default alert subscriptions are set
by administrators, but can be overridden on a per-object basis by owners and
participants of the specific objects.

For workflow tasks, alerts are either brief or detailed.
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Related Topics
• Brief and detailed task alerts

• To subscribe to alerts for an object

• About adding comments for alerts

N160001

Message board
The message board allows you to communicate information to the other members of the
team or to an object owner.

N1790001

Viewing alerts
When you receive an alert, go to the Alerts page to view it. Alerts are also sent to
affected users' e-mail addresses (for each user that has a valid e-mail address set up).
For a detailed list of events that could trigger an alert and for more information on
setting up alerts, see the IBM Unica Marketing Operations Administrator’s Guide.

To view alerts, log in and click the Alerts icon ( ). Clicking on, or scrolling over the
alerts icon shows a drop down menu seperating the alerts for your installed
applications. The number of alerts appears to the left of each application name. Once
you choose which application's alerts to view, the page displays the following
information:

Column Description

Page heading Contains the number of unread alerts (which appears in parentheses) and the
total number of alerts

Check box Each alert contains a check box; use check boxes to select alerts for a specific
action (for example to mark a group of alerts for deletion).

Check the box in the first line (next to the Message Text label) to select all the
alerts.

Message text Displays the text of the alert.

Date/Time Displays the time of the event that triggered the alert.

You can perform the following actions from the page.

Link/Button Description

Select the yellow envelope icon next to an alert to mark the alert as read.

After you click the icon, the alert is grayed out. Reselect the icon to mark the alert
as unread.
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Link/Button Description

Alert title Click the link in the alert to go to the object that is the subject of the alert.

The Alerts page remains open while you view the information in a separate
window.

Pages Click a page number to list the corresponding page of alerts.

Delete Selected Click to delete the selected alerts.

Delete All Click to delete all of your alerts.

Mark All as Read Click to mark all your alerts as read, graying out each alert. A confirmation screen
appears to ensure you wish to mark all alerts as read.

Mark All as Unread If you have no unread alerts, click this link to mark all your alerts as unread.

Close Click to close the Alerts page.

N17A0001

Receiving alerts when outside the
organization's domain

If your email address is outside the domain of the organization that has IBM Unica
Marketing Operations installed, you need to modify your SMTP server in order to
receive alerts. Add the IP address of the Marketing Operations server to the relay
allowed IP address list.

N17B0001

About adding comments for alerts
For many events, the system sends out alerts based on actions users perform. For
example, when a project owner starts a project, the system sends out alerts to project
members.

In this example, before the system sends the alert, the project owner can add
comments to the alert. The system provides a dialog box containing the text of the alert.
The user can enter any additional comments to the alert. When the user closes the
dialog box, the system sends the alert, including the comments.

For the following events, users can add comments to the alert before the system sends
the alert.
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Object Events

• A project request is submitted.Project request
• A project request is accepted.
• A project request is returned.
• A project request is cancelled.

• A project is started.Project
• A project is put on-hold.
• A project is restarted.
• A project is completed.
• A project is cancelled.
• A project is put in not started state.

• A program is started.Program
• A program is put on-hold.
• A program is restarted.
• A program is completed.
• A program is cancelled.

• A plan is started.Plan
• A plan is put on-hold.
• A plan is restarted.
• A plan is completed.
• A plan is cancelled.

• An approval process is started.Approval
• An approval process is put on-hold.
• An approval process is restarted.
• An approval process is complete.
• An approval process is cancelled

• An asset is drafted.Asset
• An asset is locked.
• An asset is finalized.
• An asset is archived.

• An invoice is marked as payable.Invoice
• An invoice is marked as paid.
• An invoice is re-drafted.
• An invoice is cancelled.

Marketing object The status of a marketing object has changed.

N17C0001
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To subscribe to alerts for an object
You can override default settings within a plan, program, project, or project request
even if you are not an administrator, which allows you to control the alerts that each
object owner and participant receives. However, if there are permissions configured for
any of the tabs of a project or request, the system filters alerts appropriately. For
example, alerts about attachments are not sent to users who do not have access to a
project's Attachments tab.

1. Open the object for which you want to change alert subscriptions.

2. Click the Communicate icon ( ) and select Subscribe to Alerts from the drop
down list.

3. From the list of alerts, select the checkboxes that correspond to the alert that you
want to change. You can set or clear alert subscriptions for each type of user,
Owner, Participant, and so on. The possible entries are as follows:

• Checkmark: indicates the user will receive the alert or alarm

• Blank: indicates the user will not receive the alert or alarm

• n/a: indicates you did not specify team members for this access level (for
example Program Participant) when you created the object. Once you add a
team members with the corresponding access level, you can set alerts for that
access level.

4. Click Accept to save your changes or Cancel to leave the alert settings as they
were.

N17D0001

Brief and detailed task alerts
When someone makes edits to a workflow, they may make numerous edits that affect
several tasks, members, dates, and so on. IBM Unica Marketing Operations allows you
to determine whether users should receive detailed or brief alerts (via notification by e-
mail and within Marketing Operations) about the workflow changes:

• Brief mode: The notification informs users that changes have been made to the
workflow. In certain cases, the field changed and new value are shown.

• Detailed mode: The notification contains a section for each task that has been
changed. For each change, both the previous and current values are listed in the
alert.

Determine the correct level of information, and set the Detailed workflow change
notification alert accordingly.

Note the following:
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• If a project is set up to deliver detailed alerts to owners and participants, any
changes to workflow tasks leads to a detailed alert being sent to project owners and
affected task members (that is, specific participants who are task members). In this
case, brief alerts related to workflow tasks (such as Task Assigned or Task Started)
are not sent.

• If a project is set up to deliver detailed alerts to owners only, then changes to
workflow task rows lead to a detailed alert being sent to project owners only.
Affected task members (project participants) receive brief alerts.

Related Topics
• Examples of brief and detailed alerts

N17F0001

Group events that contribute to detailed alerts
In addition to edits made to the workflow itself, a few other actions can lead to task
alerts being sent, if a project is set for detailed alerts.

Tab Actions

• If a user uses the find and replace functionality to make changes to aPeople
workflow, IBM Unica Marketing Operations sends an alert to both the previous
and new task owners.

• If a user clicks Assign work by role, Marketing Operations sends an alert to
each user assigned (or un-assigned) tasks.

• If a user clicks Complete Selected, Skip Selected, or Reassign Selected,Tasks
IBM Unica Marketing Operations sends an alert that indicates the affected
tasks.

• If a user edits a task from the screen, Marketing Operations sends an alert
indicating the changes to the task.

Teams If a team manager or member reassigns tasks, IBM Unica Marketing Operations
sends an alert to both the previous and new task owners.

Approvals If a user edits an approval task that is part of a workflow, IBM Unica Marketing
Operations sends an alert indicating changes to the task.

N17E0001

Examples of brief and detailed alerts
The following example depicts an email a user might receive if the project is set up to
deliver detailed alerts.

Subject: Project workflow updated: "Project 0004 (TRS1022)"

Project workflow updated: "Project 0004 (TRS1022)"

By: asm admin

When: Monday, October 15, 2007 at 1:38:24 PM EST

Task : 1.1 Determine objectives and theme (Task Code : <empty>)
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Target Start changed to 11/01/2007 09:00:00 AM from 10/17/2007

09:00:00 AM

Notes changed to My Added new notes...... from Added new notes

% Complete changed to 6 from 3

Target End changed to 11/05/2007 05:00:00 PM from 10/19/2007

05:00:00 PM

Members changed to rm_user3, rm_user2, from asm admin

Task : 1.2 Estimate costs (1.1,1.1) (Task Code : <empty>)

Target Start changed to 11/06/2007 09:00:00 AM from 10/22/2007

09:00:00 AM

Notes changed to My Added new notes...... from Added new notes

% Complete changed to 25 from 10

Target End changed to 11/07/2007 05:00:00 PM from 10/23/2007

05:00:00 PM

Members changed to rm_user3, rm_user2, from asm admin

:

:

Click

http://svr01:7001/plan/affiniumplan.jsp?cat=projectworkflow&projectid

=103 to go to project.
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The following example depicts an email a user might receive if the project is set up to
deliver brief alerts:

Subject: Project workflow updated: "Project 0004 (TRS1022)"

Project updated: "Project 0004 (TRS1022)"

By: asm admin

When: Monday, October 15, 2007 at 1:38:24 PM EST

Comment: "Workflow" tab updated.

Description: Tradeshow for 1st Mutual Bank of Fred

Click

http://svr01:7001/plan/affiniumplan.jsp?cat=projecttabs&projectid

=103 to go to project.

N1800001

Configuring task alert level
Your administrator may have selected the Detailed workflow change notification
alert. If so, by default, all projects send detailed alerts. Project owners and members
can override the default setting on a per-project basis, by changing the setting for the
Detailed workflow change notification, located in the alert subscription window for
each project.

Related Topics
• To subscribe to alerts for an object

N9B0001
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To post a message on the message board
The message board allows you to post or read messages about a particular plan,
program, project, asset, account, approval, or invoice. You can use this as a method of
communicating information about the object. When you post a message to the message
board, any user who has permission to access that object can view the posted
message.

1. Open the list page for the object type of the object for which you would like to post a
message. For example, click Operations > Accounts. (You can post messages for
plans, programs, projects, assets, accounts, approvals, or invoices.)

2. Click the plan, program, project, account, approval, or invoice for which you want to
post a message.

3. Click the Communicate icon ( ) in the IBM Unica Marketing Operations toolbar
and select Post a Message.

The Messages window appears.

4. Enter your message in the text box.

5. Click one of the radio buttons.

Note that by default, you also receive an e-mail alert when you post a message.

6. Click Post Comment.

The Messages window displays all the posted comments for this object. Your new
comment appears at the top of the list.

If you chose an e-mail option, your message includes a line listing the e-mail
recipients, similar to the following:

(cc’d to Mary Manager, Connie Contact, aartiste@unica.com)

The system displays names for users whose names are stored in IBM Unica
Marketing Platform. If this information is not in the platform, the system uses the e-
mail address.

7. Click Close if this is the only comment you want to post now or click Post a
Comment to post an additional comment.

IBM Unica Marketing Operations posts the message to the message board and
sends any e-mail messages you instructed it to send. The messages contain the
text of the message posted on the message board as well as a link to the object
(plan, program, project, and so on) where the message was posted.

N9A0001

To read a message on the message board
You can read messages that were previously posted to the message board, if you have
permission to view that object. Messages can be posted for plans, programs, projects,
assets, accounts, approvals, or invoices.
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1. Open the list page for the object type of the object for which you would like to read a
message. For example, click Operations > Accounts. (You can post or read
messages for plans, programs, projects, assets, accounts, approvals, or invoices.)

2. Click the plan, program, project, asset, account, approval, or invoice whose
messages you want to read.

3. Click the Communicate icon ( ) and select Read Messages.

The Messages window appears, displaying all the messages on the message board
for that object.

4. Click Close to exit the message board or click Post a Comment if you want to
respond to a posted message.
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